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INTRODUCTIONINTRODUCTIONINTRODUCTIONINTRODUCTIONINTRODUCTION

New Webmaster’s Guide to Dreamweaver® 4 focuses on the process of creating a Web
site by breaking down the work into seven distinct steps. Using this approach, we

pick a single construction method for building a Web site and then follow that method
from start to finish. Such an approach means we give you the information you need
to prepare a Web site for your business or organization, but we don’t provide encyclo-
pedic coverage of the Macromedia Dreamweaver program.

We think breaking the process of creating a Web site into steps works better for the
typical Dreamweaver user—and especially for the person who never aspires to become
a Dreamweaver expert or professional Web site developer. Breaking the process into steps
forces us (the authors and the reader) to focus on the final product—a polished pro-
fessional Web site. And breaking the process into steps also lets us create a book that
filters everything we could say about Dreamweaver into just what the new webmaster
should know.

What This Book Assumes About YWhat This Book Assumes About YWhat This Book Assumes About YWhat This Book Assumes About YWhat This Book Assumes About Yououououou
This book makes two assumptions about you. First, the book assumes that you’re not
and don’t want to become a Dreamweaver expert. Rather, we assume you’re a profes-
sional working in business, for a nonprofit organization, or perhaps in public service.
We assume that you want to use Dreamweaver to build and enhance the Web sites you
make.
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The book also assumes that you’re familiar working with the Microsoft Windows
operating system. In the pages that follow, as a result, you won’t get detailed informa-
tion about how to choose menu commands or select dialog box buttons and boxes. If
you don’t already possess this knowledge, you’ll need to acquire it either by using the
online help available in Windows, by getting a quick tutorial from a friend or co-worker,
or by reading a good introductory book.

NOTENOTENOTENOTENOTE Dreamweaver is available for the Macintosh, but this book covers the Win-
dows version. If you have the Macintosh version, you can still use this book;
however, Dreamweaver will look and act slightly differently than shown here.
The difference is slight though—in almost every aspect, the two versions are
identical.

Why Use Dreamweaver?Why Use Dreamweaver?Why Use Dreamweaver?Why Use Dreamweaver?Why Use Dreamweaver?
Dreamweaver is an extremely powerful Web-site-creation tool. You can use it to make
all your Web pages, modify existing pages, and manage your entire Web site.

Creating basic pages with Dreamweaver is easy, but this program really excels when it
comes to developing complex pages and streamlining the entire process. Dreamweaver
is arguably the best program available for creating complex page layouts, using either
tables or layers. You can use Dreamweaver’s Library, Templates, and CSS Styles fea-
tures to give your Web site a consistent look and vastly reduce the amount of work
involved in making changes to your Web site. Dreamweaver also provides a powerful
History feature so that you can record and replay Web-page-creation tasks. These
features are largely unparalleled in other Web page editing programs.

With this said, if you’re a user of Microsoft Office programs, you might be a little lost
when you first open Dreamweaver. However, if you’re willing to accept a slightly steeper
learning curve, you’ll find that Dreamweaver is a great program to grow into. In most
aspects, it is more powerful and more efficient than any other Web-page-creation
program.

TIPTIPTIPTIPTIP If you need to collect information from visitors using forms on your Web site,
you might want to use FrontPage to supplement the work you do with
Dreamweaver. FrontPage, when paired with FrontPage Server Extensions
support from your ISP, can easily make forms work—something that is a bit
tricky with Dreamweaver.
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How This Book Is OrganizedHow This Book Is OrganizedHow This Book Is OrganizedHow This Book Is OrganizedHow This Book Is Organized
This book breaks the process of building a Dreamweaver Web site into the following
seven steps:

Step 1: Determine YStep 1: Determine YStep 1: Determine YStep 1: Determine YStep 1: Determine Your Wour Wour Wour Wour Web Site’eb Site’eb Site’eb Site’eb Site’s Goalss Goalss Goalss Goalss Goals
You can most effectively create a Web site if you have a clear sense of the site’s purpose
and goals first. Step 1 introduces some common Web site goals, and then helps you
identify goals that are appropriate for your site. It also discusses how to deal with goal
changes.

Step 2: Lay YStep 2: Lay YStep 2: Lay YStep 2: Lay YStep 2: Lay Your Foundationour Foundationour Foundationour Foundationour Foundation
Once you have your goals established, your next step is to prepare the foundation of
your Web site by getting a domain name and locating a company to host your site. Step
2 shows you how.

Step 3: Collect and Organize YStep 3: Collect and Organize YStep 3: Collect and Organize YStep 3: Collect and Organize YStep 3: Collect and Organize Your Contentour Contentour Contentour Contentour Content
After laying your foundation, it’s time to gather content together and organize it for
use on your Web site. Besides simply collecting existing content, this step also involves
creating or digitizing new content, creating a central location to store content, estab-
lishing a file naming convention to use on your site, organizing your content, and
drawing up a plan for your site.

Step 4: Create YStep 4: Create YStep 4: Create YStep 4: Create YStep 4: Create Your Siteour Siteour Siteour Siteour Site
The actual process of creating a Web site page by page begins with Step 4. We walk
you through setting up your Web site in Dreamweaver, introduce the Dreamweaver Site
window interface, and show you how to manage files in Dreamweaver and coordinate
the work of multiple users.

Step 5: Create YStep 5: Create YStep 5: Create YStep 5: Create YStep 5: Create Your Pagesour Pagesour Pagesour Pagesour Pages
After setting up your Web site, you need to create pages for your site. In Step 5 we
introduce you to Dreamweaver’s Document window, where all page editing is done, and
show you how to create basic Web pages, including working with text, hyperlinks, and
images.
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Step 6: Polish YStep 6: Polish YStep 6: Polish YStep 6: Polish YStep 6: Polish Your Pagesour Pagesour Pagesour Pagesour Pages
Once you’ve created your Web site, you can then refine your Web pages to make them
more effective and professional. In Step 6, we cover a number of special tasks to help
you polish your home page, along with ways of making all your pages more consistent
and effective. You also learn how to create advanced layouts using layers and tables.

Step 7: Deploy YStep 7: Deploy YStep 7: Deploy YStep 7: Deploy YStep 7: Deploy Your Wour Wour Wour Wour Web Siteeb Siteeb Siteeb Siteeb Site
The last step in the Web-site-creation process is the actual deployment of your site.
This includes testing your site for errors, publishing it to the Internet, submitting your
site to search engines, and publicizing your site elsewhere—both on and off the Internet.
These tasks are all covered in Step 7, along with monitoring your site for errors after
it is posted and tracking the amount and kinds of visitors that your site receives.

Appendix A: Internet and WAppendix A: Internet and WAppendix A: Internet and WAppendix A: Internet and WAppendix A: Internet and Web Basicseb Basicseb Basicseb Basicseb Basics
Appendix A presents background information on the Internet and its many methods
of communication. If you’re unfamiliar with the way the Internet works, or would like
a refresher, start here.

Appendix B: An Introduction to HTMLAppendix B: An Introduction to HTMLAppendix B: An Introduction to HTMLAppendix B: An Introduction to HTMLAppendix B: An Introduction to HTML
Appendix B provides a brief introduction to the way Web pages actually work—
through HTML code. It also provides a useful quick-reference guide to some of the
most common HTML tags, which can be invaluable when using Dreamweaver’s Tag
selector feature.

Appendix C: Hyperlinks in DreamweaverAppendix C: Hyperlinks in DreamweaverAppendix C: Hyperlinks in DreamweaverAppendix C: Hyperlinks in DreamweaverAppendix C: Hyperlinks in Dreamweaver
Appendix C presents information on the three types of hyperlink addressing methods:
absolute, document relative, and site-root relative.

Appendix D: Creating WAppendix D: Creating WAppendix D: Creating WAppendix D: Creating WAppendix D: Creating Web Storeseb Storeseb Storeseb Storeseb Stores
Web stores aren’t as easily created using Dreamweaver; however, in Appendix D, we
discuss the various methods you can use to create a Web store and how to choose a
method that’s suitable for your company.
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Appendix E: Using FramesAppendix E: Using FramesAppendix E: Using FramesAppendix E: Using FramesAppendix E: Using Frames
Frames can be tricky to implement properly, and they are a disaster when implemented
poorly. Fortunately, Dreamweaver makes it easy to create frames and modify them to
suit your needs. Appendix E teaches you the essentials you need to know in order to
properly create a Web site with frames.

NOTENOTENOTENOTENOTE New Webmaster’s Guide to Dreamweaver 4 also includes a glossary of
Dreamweaver and Web site terms.

Conventions Used in This BookConventions Used in This BookConventions Used in This BookConventions Used in This BookConventions Used in This Book
This book uses three conventions worth mentioning here. The first is this. We view this
book as a conversation among professionals.  That means the pronoun we refers to us,
the authors. And that means the pronoun you refers to you, the reader. In this case, this
conversation style means you will frequently see the pronoun we, because two of us,
Gerend and Nelson, wrote the book. Although we has sometimes been used as a stilted
self-reference by writers, please don’t take it that way. Think of us as workshop presenters
or discussion group facilitators, with jackets off and ties loosened. Think of us, in other
words, as colleagues. Think of this book as a conversation.

Another convention is that we call the main chapters of the book steps. The benefit of
doing this is that it lets us focus on and emphasize the process of creating a Web site.
But, unfortunately, there’s a slight problem with this convention. We also want to provide
numbered step-by-step instructions in the chapters, or steps, of the book. Whenever
some task can’t be described in a sentence or two, in fact, we’ll use numbered steps to
make sure you can follow the discussion. So this “chapters-called-steps” convention may
confuse matters. If we say that “in the preceding step, we described how to do such-
and-such,” are we referring to the preceding chapter? Or are we referring to a preced-
ing numbered step? You see the difficulty.

Here’s what we’ve come up with. Whenever we use the term step to refer to a chapter,
we’ll just give you the entire step name. For example, if we say that in “Step 2: Lay Your
Foundation” we describe how to do such-and-such, you’ll know what we mean. If we
don’t give you the step name, you’ll know we’re talking about the preceding numbered
step.
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A third convention concerns references to the buttons and boxes in Dreamweaver
windows and dialog boxes. Even though they don’t appear that way onscreen, this book
capitalizes the initial letter of the words that label buttons and boxes. For example, the
box that is actually labeled “Save as type” gets referenced in these pages as the Save As
Type box. The initial caps, then, will be a signal to you that we’re referring to a label.
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Step 1

DETERMINE YOUR WEB SITE’S GOALSDETERMINE YOUR WEB SITE’S GOALSDETERMINE YOUR WEB SITE’S GOALSDETERMINE YOUR WEB SITE’S GOALSDETERMINE YOUR WEB SITE’S GOALS

Featuring:Featuring:Featuring:Featuring:Featuring:

• Reviewing Common Web Site Goals

• Identifying Your Web Site’s Goals

• Revising Your Goals

The Web is a land of opportunity for many companies and organizations—a whole
new way of reaching customers and providing information, products, and services

to your clientele. To take advantage of this vast new resource, you need a Web site. Al-
though it’s easy to create one, you get the best results if, before you start, you determine
why you want to create a site and what you want it to accomplish. Identifying your Web
site’s goals makes it simpler to create your site and helps to ensure that you meet these
goals.

This step helps you decide upon your site’s goals and also briefly discusses how to revise
your goals as the needs of your Web site change.

Reviewing Common WReviewing Common WReviewing Common WReviewing Common WReviewing Common Web Site Goalseb Site Goalseb Site Goalseb Site Goalseb Site Goals
Businesses and organizations share a number of common goals for their Web sites. As
you begin planning what you want your own Web site to accomplish, take a moment
to review the following goals. Our aim is to help you clarify what your own site should
accomplish.
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AdvertisingAdvertisingAdvertisingAdvertisingAdvertising
Advertising is perhaps the most common goal for a Web site. The Web lets you ad-
vertise and publicize for a very modest cost. The Web lets you use any medium in your
advertising (text, pictures, video, and so on), allowing for unparalleled richness of ex-
pression. In addition, you can easily change and update your information.

If you want to create a Web site to advertise your company, its products, or services, here
are some general types of information you might want to include:

• General information, for example, what your company does and what makes it
noteworthy.

• A listing of products and services, including detailed information about them as well
as ordering information.

• Current activities information, including upcoming events and coverage of past events.

• Location information, including your address, a map, and directions.

• Contact information, such as e-mail addresses and phone numbers for visitors who
might have questions or want to contact someone for more information.

• Financial information, such as any required financial disclosures or voluntarily shared
financial reports. Figure 1-1 shows a Web site devoted to this purpose.
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Figure 1-1 The Investor Relations page at Microsoft’s Web site.

NOTENOTENOTENOTENOTE Although a Web site is one of the best ways to advertise, usually you need to
put a little effort into advertising the site before it can be truly effective. This
is because Web sites often act as second-stage advertising. Once people re-
alize that they want more information (either because they’re looking for
something or because you’ve attracted their attention through some other
form of advertising), they can go to your Web site and find all the informa-
tion they want. That’s powerful. But before your site can be effective, you need
visitors. “Step 7: Deploy Your Web Site” describes tactics to employ for per-
forming this first-stage advertising for your firm’s Web site.
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Selling a Product or ServiceSelling a Product or ServiceSelling a Product or ServiceSelling a Product or ServiceSelling a Product or Service
Creating a Web store makes purchasing products and services more convenient for
everyone. Ordering from a Web site can save customers the hassle of going to your brick-
and-mortar business location or the inconvenience of ordering over the phone. Process-
ing orders over the Internet also reduces the amount of resources you expend on
telephone and personnel costs.

NOTENOTENOTENOTENOTE For more information on Web stores, see “Appendix D: Creating Web Stores.”

If you want to create a Web site to sell products or services, here are some recommen-
dations:

• Don’t make a big investment in a Web store unless you’re sure it’s going to be prof-
itable. A glorified order form can make a good proof-of-concept and is much easier
to create than shopping cart systems with online payment processing.

• Create an online catalog with detailed information about your products or services.

• Link each product or service to your ordering system, if possible.

• Make it easy for people to order via traditional means—i.e., the phone. Prominently
display your ordering phone number by products and in your online ordering sys-
tem. Have “online-only” specials if you want to reduce phone costs.

NOTENOTENOTENOTENOTE Regardless of what you think about www.amazon.com, you should visit their
Web site—even if you compete with them (perhaps especially if you compete
with them). They’ve done an impressive job of providing numerous paths to
find their products and different ways to search through their inventory. For
example, they have several different bestseller lists for Microsoft Excel books,
each listing books in a different order for a different group of Excel readers.
We strongly suspect their several bestseller lists of Excel books, each really an
alternative path to the same products, boost their sales of Excel books because
they make it more likely someone will find them.
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Distributing Digital ContentDistributing Digital ContentDistributing Digital ContentDistributing Digital ContentDistributing Digital Content
If your company or organization provides unusually valuable content, consider charg-
ing for access to the information. Online content distribution provides a virtually cost-
free means of distributing your content. It also provides “instant gratification” to
customers who can immediately view content without having to wait for CDs or disks
to arrive.

Only attempt to sell content that is worth paying for. Examples of types of content that
can be sold over the Internet include the following:

• Data your company or organization has collected that is unique and valuable. A fairly
sky-high example of valuable content is found at the site www.spaceimaging.com, as
shown in Figure 1-2, which sells spy satellite photos.

Figure 1-2 A Web site selling spy satellite photos.

NOTENOTENOTENOTENOTE Even more than selling “real” products and services via a Web store, distrib-
uting content digitally requires additional development effort,  so you’ll
probably need to hire outside help to set this up.
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• High-quality information that your company or organization used to charge for. An
example site is www.worldbookonline.com, as shown in Figure 1-3, which sells ac-
cess to its World Book Encyclopedia.

Figure 1-3 The World Book Online Web site.

• Professionally created content of interest to visitors, such as high-resolution photos,
artwork, sounds, or music. Instead of treating your content as products to sell, you
can instead treat it as a service to which visitors can subscribe. An example of this
kind of site is www.arttoday.com, as shown in Figure 1-4, which sells access to its
images and clip art.
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Figure 1-4 The ArtToday Web site.

Disseminating InformationDisseminating InformationDisseminating InformationDisseminating InformationDisseminating Information
Perhaps the greatest strength of the Web is how well it’s suited to passing on information.
No printing costs are involved; information can be changed as frequently as necessary;
pictures, audio, and even video can be included with text; and there are no real limits
on how much information can be posted on a Web site. You can leverage this ease of
information transfer by creating an information-sharing Web site, which can benefit
a company or organization in a number of ways.

Some other ways you can disseminate information via a Web site and use it to benefit
your company or organization are as follows:
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• Distribute all information and forms your customers might need to interact with your
company or organization. The Web site of the U.S. Internal Revenue Service (IRS)
is an excellent example, as shown in Figure 1-5. By making just about every bit of
tax information available online, the IRS reduces the burden on its phone staff,
reduces the number of taxpayer errors on the tax returns it reviews, and presumably
builds goodwill toward the organization. UPS and Federal Express are two other
examples of companies that streamline their businesses by providing valuable infor-
mation to their visitors (they post sending and tracking information).

Figure 1-5 The Small Business Corner page of the IRS Web site.

• A nonprofit organization can take advantage of the Web to educate the public about
issues in which the organization is involved, helping to make progress on the issues
while at the same time increasing public awareness of the organization.

• Draw upon your company or organization’s unique knowledge or perspective to make
your Web site a comprehensive information source. This offers visitors something
of value that they can’t get elsewhere.
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• If your company manufactures or sells a product, create some tutorials or product
tips on your site to help customers make better use of the product.

• Create a newsletter related to your business’s occupation containing industry news,
opinion articles, case studies, and product reviews.

• Provide information on activities or tasks that are slightly outside the scope of your
company’s products. This can help to make your site a central information hub, which
visitors can use to find related information of interest to them.

Generating Online Advertising RevenueGenerating Online Advertising RevenueGenerating Online Advertising RevenueGenerating Online Advertising RevenueGenerating Online Advertising Revenue
Some firms and organizations can help support the cost of a Web site (or even make
it a profit source) by allowing other companies to advertise on their site or by earning
commissions from referring visitors to online stores. Just as most magazines are largely
advertiser-supported, it’s possible to run a profitable online magazine or newsletter
supported largely or exclusively by banner ads and affiliation programs on your site.
Yahoo! (www.yahoo.com) is an example of a Web site that generates a large amount of
income from ads, as shown in Figure 1-6.

Figure 1-6 Yahoo!’s Web site.
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If you want to create a Web site that generates advertising revenue, here are some
recommendations:

• Make sure that your site can sustain a high number of hits (visits to your site) and
will generate a large number of click-throughs (instances where a visitor clicks on an
ad). To do this, you’ll probably need some enticing content—possibly an online
newsletter, tutorials, or free downloads relating to your products or industry.

• Hold off on placing ads on your Web site until your site is established and gener-
ating a significant amount of traffic, and then choose ads that are most appropriate
to your visitors.

TIPTIPTIPTIPTIP If your Web site presents reviews or recommendations on products that can
be purchased over the Web, consider becoming an affiliate with an online
store that sells these products. You can then place special hyperlinks on your
site that link to the products at the online store you’re affiliated with. This way,
your organization earns referral commissions for each visitor who uses your
links to make a purchase at the online store.

Supporting a ProductSupporting a ProductSupporting a ProductSupporting a ProductSupporting a Product
Customer and technical support are two business activities that can significantly eat into
profits. It’s expensive to maintain a staff to handle customer and technical support (or
divert resources from employees with other job functions), pay for a toll-free number,
and deal with unhappy customers.

Creating a Web site or a portion of a site dedicated to customer or technical support
won’t eliminate the need for offline support. However, it can help reduce the need for
traditional phone-based support by empowering customers to solve the most common
problems themselves.

Some common items on customer support Web sites include the following:

• A list of frequently asked questions (FAQ), which customers can use to get instant
answers to their questions, often eliminating the need to call customer support.

• A knowledge base of support articles, so customers can access trouble-shooting
information on their own. The articles can then be placed on the site along with a
form that allows users to search for a specific article, as shown in Figure 1-7.
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Figure 1-7 The Knowledge Base Search section of Microsoft’s Product Support Ser-
vices Web site.

• Contact information, so customers can get in touch with traditional customer sup-
port in case they can’t find what they need online. Although this usually means a
telephone number, you may want to encourage visitors to preferentially e-mail the
support staff.

• Online discussion groups, where visitors and company personnel can post and reply
to messages, much like a Web-based newsgroup, as shown in Figure 1-8. Online
discussion groups can help reduce support costs by permitting users to help each
other.
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Figure 1-8 A discussion group Web site dedicated to Ulead’s MediaStudio Pro.

• Chat-based online support, where users can contact support personnel in a real-time,
text-based chat session across the Internet. Although this is cheaper than phone-based
support, it isn’t natively supported by Dreamweaver, so you would need to use third-
party software such as HumanClick at http://www.humanclick.com, as shown in
Figure 1-9.
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Figure 1-9 An online support chat window as provided by HumanClick’s software.

• Product manuals, so users can find the information they need without contacting
customer support.

• Product updates, so users can download or order updated versions of your products.

NOTENOTENOTENOTENOTE Microsoft’s Product Support Services Web site at http://support.microsoft.com

is perhaps the best product support Web site in existence. It provides FAQs for
each of the company’s products, along with information on how to get phone
support as well as online support. It also provides users with the ability to
search the same database of articles the product support staff uses, enabling
users to essentially be their own support technicians. Take a look at this site
if your company needs more product support.

Complementing a CurriculumComplementing a CurriculumComplementing a CurriculumComplementing a CurriculumComplementing a Curriculum
The Web can help out parents, teachers, and students by serving as a sort of online
publication location where just about anything that normally would appear in print
can be found, as shown in Figure 1-10. This reduces the amount of paper used for
handouts, makes it easier for students to get assignments done, and generally helps
students and parents more easily find the information they need.
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Figure 1-10 An example of a simple Web page designed to accompany a class.

Ideally, a Web site designed to complement a curriculum or school should contain
anything that would ordinarily exist in hard copy. Here are some suggestions:

• Make current assignments available for convenient access.

• Post the due dates for assignments, test dates, and information on special lectures.

• Make copies of lectures available online, if this is appropriate. Making lecture slides
available can also increase the perceived value of the class.

• Include information on how grades are calculated and other background informa-
tion, such as attendance policy and office hours.

• Post current course descriptions, class times, and dates for easy reference.

• List registration information and instructions. Not all schools will want to make
online registration available because of the complexity and cost involved (it gener-
ally requires hiring an outside contractor to set up online registration systems), but
most will want to post information on the proper way to register.

• Post cafeteria menus and prices.
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• List the faculty, their credentials, and contact information.

• Post specific information about the school, its history, and its future. (See the earlier
“Advertising” section for more ideas.)

Identifying YIdentifying YIdentifying YIdentifying YIdentifying Your Wour Wour Wour Wour Web Site’eb Site’eb Site’eb Site’eb Site’s Goalss Goalss Goalss Goalss Goals
As you review the common Web site goals, you will probably find your own initial
objectives come into focus. You will find yourself seriously considering the pursuit of
certain Web site goals (such as advertising) and abandoning other goals (those not relevant
to your organization’s activities.)

As you do this, we suggest you keep a close eye on both what your competitors are doing
and on what the large successful Web sites are doing. Both types of Web sites should
help you further refine the list of goals you select for your Web site.

You might also find it helpful to write out answers to the following three questions:

1. What should the site accomplish?

Are you advertising your company, selling a product or service, acting as an online
newsletter, providing customer support, or complementing a teaching curriculum
with your Web site? Although more than one purpose for a Web site is generally the
norm, clearly defining what your site should accomplish is a vital step in creating an
effective site.

2.  How is this going to benefit my company or organization?

Web sites benefit companies in many ways, including increased sales, decreased
customer support costs, improved public image, or a better understanding of the
company or organization (especially beneficial to nonprofit organizations). By for-
mally identifying and recording the benefits you want to achieve, you increase your
chances of success.

3. What content should the site contain in order to accomplish the Web site’s purpose?

After determining what you want your Web site to accomplish, identify the con-
tent that will help your site live up to your company or organization’s expectations.
If the site exists to inform the public about a specific issue, it’s important to have
lots of information regarding that issue and not as important to have pictures of your
company picnic. Your content needs to attract users to your site, keep them there,
and entice them to return. Keep asking whether any potential content will help
further the purpose of the site—if it doesn’t, think twice before spending time and
resources on it.
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TIPTIPTIPTIPTIP Research your target audience. Identify the types of people who are most
likely to view your site. You might even find it useful to create personas that
embody the different demographics you are trying to appeal to. By posing
questions—Will our customer like the site? Will our vendor find the needed
information?—the hypothetical users help you keep your focus when design-
ing your site.

Revising YRevising YRevising YRevising YRevising Your Goalsour Goalsour Goalsour Goalsour Goals
We want to close this short chapter with a general comment about reviewing your Web
site goals. Thinking about what you should do with your site and investigating what
other firms are doing with theirs is time and effort well spent. We suggest that you view
your list of goals as a document to be revised, updated, and expanded as your exper-
tise grows and the conditions of your industry or your organization’s role in society
change.

Most Web sites—even some created by large organizations—can be viewed as the elec-
tronic equivalent of a bulletin board. As you find or create some appropriate Web
content, you simply pin the content to the bulletin board—or post the content to your
Web site. When content needs to change, you update the content or replace it. If
content needs to be removed, you remove, or unpin, it from the bulletin board. Such
a bulletin-board approach lets your Web site grow organically. And such an approach
means you can (and probably should) continue to refine and adapt your Web site goals.

SummarySummarySummarySummarySummary
When planning your Web site, it’s helpful to examine goals that Web sites have in
common and then look at the types of content appropriate to accomplish those goals.
After seeing what other companies have done, it’s easier to determine the goals for your
organization’s site. Once you establish your goals, we believe that you’ll be able to rapidly
create your site and make it available to visitors by taking a sort of bulletin-board
approach to its development—placing whatever information you have up rather quickly
and then slowly refining your site.
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Step 2

LALALALALAY YOUR FOUNDAY YOUR FOUNDAY YOUR FOUNDAY YOUR FOUNDAY YOUR FOUNDATIONTIONTIONTIONTION

Featuring:Featuring:Featuring:Featuring:Featuring:

• Acquiring a Domain Name

• Why You Need Your Own Domain Name

• Choosing a Registrar

• Choosing a Web Hosting Service

• Signing Up for Service

Before you can begin constructing a Web site, you need to lay a foundation by
acquiring a domain name and choosing a company to host your site.

TIPTIPTIPTIPTIP This is a good time to assess who will work on your Web site and to assemble
everyone involved. If you have any information technology professionals in
your company or organization, they could be a big help in laying your Web
site’s foundation, as well as smoothing out the creation process. Artistic
employees can often help determine what works visually for the Web site, or
create unique graphics for your site as necessary. Others can prove invaluable
for their knowledge of what content is available for use on the Web site or
for their ideas on what would be appropriate content to add to the site.
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Acquiring a Domain NameAcquiring a Domain NameAcquiring a Domain NameAcquiring a Domain NameAcquiring a Domain Name
Because of how quickly domain names are being registered (and thus eliminated as
potential names for your company or organization), it’s important to get a domain name
as soon as you’ve determined the purpose of your Web site.

The next sections give you a background on domain names, explain why you should get
one, and help you choose and secure a domain name for your company or organization.

Domain Name BackgroundDomain Name BackgroundDomain Name BackgroundDomain Name BackgroundDomain Name Background
Understanding what domain names are and how they work makes choosing a good
name easier and more logical. Fortunately, as a business user, there are only three essential
pieces of information you’ll need to understand: IP addresses, DNS, and domain hi-
erarchy.

NOTENOTENOTENOTENOTE To follow this discussion, you’ll find it helpful to first understand the techni-
cal details of how the Internet works. If you don’t already possess this infor-
mation, you may want to review “Appendix A: Internet and Web Basics.”

IP AddressesIP AddressesIP AddressesIP AddressesIP Addresses
Computers on the Internet use an Internet protocol (IP) address to identify the pre-
cise location of the computer. An IP address makes it possible for people and programs
to find the computer on the Internet. Without an IP address, a computer can’t com-
municate on the Internet.

An IP address consists of four sets of three numbers, for example, 169.254.255.254.

DNSDNSDNSDNSDNS
Because of the user-unfriendly nature of IP addresses, a service was created to allow
people to access Internet computers using names instead of long strings of numbers.
This service is called the Domain Name Service (DNS).

What the DNS service does, essentially, is translate the name you use to identify an
Internet resource, such as a Web site, to the IP address that the network actually uses
to locate the Internet resource. A computer called a DNS server performs the DNS
service.
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If you type www.microsoft.com in the Address box of a Web browser, for example, your
computer asks your Internet service provider’s (ISP) DNS server for Microsoft’s IP
address. The DNS server looks up the IP address and sends it back. Your computer then
directly queries the IP address that it received to retrieve the Web page. This process
is illustrated in Figure 2-1.

Figure 2-1 What happens when you request a Web page from www.microsoft.com.

Domain HierarchyDomain HierarchyDomain HierarchyDomain HierarchyDomain Hierarchy
Domain names themselves are hierarchical and are read in blocks from right to left, with each
dot indicating the next layer of hierarchy. Thus, the three letters at the end (right side) of
the domain name make up the top-level domain—in the case of most businesses, .com.

NOTENOTENOTENOTENOTE The seven original top-level domains are used as follows: .com is for commercial
organizations; .edu is for educational institutions; .gov is for entities that are
part of the U.S. government; .int is for international organizations; .mil is for
branches of the U.S. military; .net is for network organizations; and .org is for
nonprofit organizations.
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Past the top-level domain (.com) is the domain name itself, for example, microsoft. To the
left of the domain name is the host name, or subdomain. This is the name of a specific
computer or a child domain. Usually this is the www host name, the traditional host name
of a Web server. Figure 2-2 shows this hierarchy for Microsoft’s domain name.

NOTENOTENOTENOTENOTE A company can also have multiple subdomains within its domain. For example,
besides www.microsoft.com, Microsoft also has support.microsoft.com (for
product support) and search.microsoft.com (for searching Microsoft’s Web
site) subdomain.

Figure 2-2 The hierarchy of Microsoft’s domain name.

NOTENOTENOTENOTENOTE In reality, a single Web server may host multiple domains (as is typical with Web
hosting companies), or multiple Web servers may host the same domain and
appear as the same host (as is typical with very high volume Web sites that
would overload a single server—for example, www.microsoft.com). While
these two exceptions are common on the Internet itself, on corporate
intranets (private networks using Web servers and the TCP/IP protocol), each
computer almost always has just one host name.

Why YWhy YWhy YWhy YWhy You Need You Need You Need You Need You Need Your Own Domain Nameour Own Domain Nameour Own Domain Nameour Own Domain Nameour Own Domain Name
You don’t have to acquire your own domain name for your Web site. You can use the
domain name of your Web hosting company to save money, since most ISPs provide
free Web hosting under their domain name. If you did this, your Web site’s address
would be something like www.yourisp.com/~yourcompany, where yourisp is the name of
your ISP and yourcompany is the name of your company.
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You probably don’t want to do this, however. This approach confuses Web visitors about
your firm’s identity. It also typically creates awkward Uniform Resource Locators
(URLs), or Web site addresses. And this approach makes it more difficult to move from
one ISP to another.

Getting your own domain name—such as www.yourcompany.com—requires only a bit
more work, and the extra cost is usually modest. You might pay $15 to $35 a year for
the name and perhaps an extra $10 a month for Web hosting.

TIPTIPTIPTIPTIP Some registrars will redirect a domain name to another Web site at no charge.
This permits you to use the Web site hosting that your ISP provides with your
Internet access. Assuming the hosting is suitable for your company or orga-
nization, this can eliminate any extra monthly fees.

Your own domain name gives you insurance in case you need or want to switch Web
hosting companies. If you don’t have your own domain name, your Web site address
(and most likely your e-mail addresses, too) will change if you change Web hosts. When
you have your own domain name, the only thing you need to change are some hidden
settings maintained by the registrar from whom you purchased the domain name. Your
Web site address and e-mail address continue to work as before.

Picking a Domain NamePicking a Domain NamePicking a Domain NamePicking a Domain NamePicking a Domain Name
Picking a domain name is a small step in the creation of a company or organization’s
Web site, but in many cases your domain name is at least as important as the name of
your organization. Your domain name identifies your Web site, and by extension, your
business or organization.

Picking a Host NamePicking a Host NamePicking a Host NamePicking a Host NamePicking a Host Name
There are several points to consider when picking a domain name. First of all, you want
your domain name to be descriptive of your company or organization. Your first choice
is your business’s name, but in some instances you might choose a domain name that’s
based on your business’s purpose instead. For example, it might be much better for a
business named Vladimir Berkowitz Faucets, Inc. to select the www.greatfaucets.com
domain name instead of www.vladamirberkowitzfaucets.com.

Second, your domain name should be easy to remember and spell. While a name like
www.rhythm.com may be short and easy to remember, some people will have trouble
spelling rhythm, potentially eliminating a large number of visitors. Perhaps something
like www.beat.com would be a better choice.
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Third, short domain names are far preferable to long ones, although only if the short
name is easy to remember. This is a particularly important point since most of the
desirable short domain names have already been taken. It may be tempting to abbre-
viate your domain name to shorten it, but do this only if the abbreviation doesn’t make
the name harder to remember.

NOTENOTENOTENOTENOTE Barnes and Noble provides a good example of abbreviating a domain name.
Its abbreviation is only two letters, www.bn.com, which for many people is
easier to remember than www.barnesandnoble.com. However, visitors can
use either domain name—www.bn.com or www.barnesandnoble.com—to
access the site.

Multiple domain names may be something you want to consider, too. They increase the
likelihood that people will find you, and cost only $15 to $35 per year more per do-
main name (although your Web host will probably charge a one-time setup fee of $30
or so). Multiple domain names also prevent others from skimming visitors from your
Web site by choosing a similar domain name. If you decide to acquire multiple domain
names, here are some suggested names:

• Your company or organization name, if you picked a more descriptive domain name
to use as your primary domain name.

• Former names of the company or organization.

• Common misspellings of your domain name.

• Longer versions of your domain name, or an abbreviated version of your domain name.

• The same domain name using a different top-level domain. For example, if you reg-
istered the www.mycompany.com domain name, you might want to also register
www.mycompany.org or .net if you want to prevent others from taking those names.

Picking a TPicking a TPicking a TPicking a TPicking a Top-Level Domainop-Level Domainop-Level Domainop-Level Domainop-Level Domain
Besides the domain name itself, your company or organization also needs to choose
which top-level domain to use, such as .com or .net or .org.

By far the most popular top-level domain to use is .com. Since this is the top-level domain
most people will look under first, we recommend that businesses look for a .com domain
name.

The .net domain is more appropriate for ISPs, Web hosting companies, and other
Internet technology companies.
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Nonprofit organizations should probably use the .org top-level domain, although
depending on the nature of the organization you might also consider registering your
domain name with a .com top-level domain.

Once your organization has come up with some ideas for domain names, it’s time to
check for their availability. Because a large number of domain names are registered every
day, make a list of alternate domain names in case the domain name you want is already
taken. Then either go to any registrar’s Web site (Network Solutions is the original, and
most expensive, registrar at www.networksolutions.com) or go to www.betterwhois.com
and enter your domain name idea in the box provided, as shown in Figure 2-3.

Figure 2-3 Checking out a potential domain name at the www.betterwhois.com Web site.

TIPTIPTIPTIPTIP If all of your top choices for domain names are taken and you’ve exhausted
your naming options, you can look into aftermarket domain names. These
are domain names that were already purchased and are now being resold for
a usually obnoxious price. If you think it might be worth the added cost and
effort, a list of aftermarket domain name brokers is available on
www.dnresources.com.
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.TV and International T.TV and International T.TV and International T.TV and International T.TV and International Top-Level Domainsop-Level Domainsop-Level Domainsop-Level Domainsop-Level Domains
There are some instances when you might want to choose an international domain
name in addition to a standard American domain name (.com, .net, .org). If your
company is located in a country other than the United States of America, you
should probably get a domain name from the country you’re located in, such as .ca
(Canada), .mx (Mexico), or .jp ( Japan). You might also consider getting an inter-
national domain name if your Web site is of specific interest to residents of a cer-
tain country. For example, if your company sells fine teas and you want to cater to
residents of the United Kingdom, you might want to get a .uk domain name.

You can also acquire a .tv (Tivalu), .fm (Federal States of Micronesia), .md
(Moldova), or similar top-level domain if you want to take advantage of the fact
that some countries’ abbreviations have special meaning in English.

International domain names vary in price and must be purchased from the
appropriate registrar. See the Domain Name Registration section of the
www.dnresources.com site for a listing of registrars for international domains.
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.BIZ, .INFO, and Other New Domain Names.BIZ, .INFO, and Other New Domain Names.BIZ, .INFO, and Other New Domain Names.BIZ, .INFO, and Other New Domain Names.BIZ, .INFO, and Other New Domain Names
In November 2000 the Internet Corporation for Assigned Names and Numbers
(ICANN) approved seven additional top-level domains:

• .aero is for aeronautical companies.

• .biz  is for businesses.

• .coop is for business co-ops and credit unions.

• .info is for international information.

• .museum is for accredited museums.

• .name is for individuals.

• .pro is for professionals, such as physicians.

The domains should be available for use around mid 2001. In order to acquire a
domain name with these top-level domains, you need to go through the accredited
registrars for each top-level domain. For a list of these registrars, visit ICANN’s Web
site at www.icann.org/udrp/approved-providers.htm.

VVVVValid Domain Namesalid Domain Namesalid Domain Namesalid Domain Namesalid Domain Names
Although it’s likely that your company will choose a valid domain name, there are a few
restrictions to keep in mind. Domain names are case insensitive, so don’t spend time
thinking about what letters to capitalize. Also, you can use only letters, numbers and
the hyphen character, but a hyphen can’t start or finish a domain name. Lastly, the do-
main name can be a maximum of 63 characters long, not including the www. and the
top-level domain (.com, .net, or .org).

TIPTIPTIPTIPTIP Try to keep your domain names as short as possible. The average adult can
remember at most seven or eight “chunks” of information, which can be
letters, numbers, or words. If you choose a domain name longer than about
five or six words (with maybe a chunk or two used up by the www and .com),
people aren’t going to be able to remember your domain name long enough
to write it down, let alone remember it the next time they’re in front of a
computer.
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Domain Name DisputesDomain Name DisputesDomain Name DisputesDomain Name DisputesDomain Name Disputes
In general, if another company or individual takes the domain name you wanted, use
one of the alternative domain names your company or organization chose. However, if
the other company or individual took the domain name specifically to negatively af-
fect your company, you may be able to dispute their domain name registration.

In order to dispute a domain name registration, your company or organization needs
to give evidence that all three of the following conditions were met:

• The domain name in question is identical or confusingly similar to a trademark or
service mark to which your company or organization has legal rights.

• The current owner of the domain name has no rights or legitimate interests in the
domain name.

• The domain name was registered and used in bad faith (to somehow take advantage
of the domain name by either selling it for a profit, preventing the legitimate com-
pany or organization from acquiring it and/or disrupting their business, or by us-
ing it to take advantage of confused visitors going to the wrong site).

If you feel that your company or organization has a legitimate dispute on a domain name
and you want to take action, contact an approved dispute-resolution provider. A list of
these providers is available on the ICANN Web site at www.icann.org/udrp/approved-
providers.htm.

When your ideal domain name is already taken, it’s often by another company with
a similar name but a different business. This typically means that you can’t dispute the
domain name. However, depending on the domain name you end up choosing and the
willingness of the other company, you may be able to arrange a link exchange to help
both companies’ visitors find the correct site. Usually each company places a small link
to the other company’s Web site on their home page, enabling lost visitors to find the
correct Web site.

Choosing a RegistrarChoosing a RegistrarChoosing a RegistrarChoosing a RegistrarChoosing a Registrar
In order to use a domain name, you need to purchase it from an accredited Internet
domain name registrar. In the past, this meant Internic—now called Network Solutions
(www.networksolutions.com)—as shown in Figure 2-4. However, the Network Solu-
tions lock on domain name registrations is over, and a multitude of companies can now
sell you domain names.
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Figure 2-4 The Network Solutions Web page.

Generally, the easiest way to set up a domain name is to let your Web hosting company
set it up for you. This is usually done when you sign up for Web site hosting, and it
saves you the work of transferring your domain name from an independent registrar to
your Web hosting company (see the later section “Signing Up for Service”). The only
downside is that this service is usually provided through Network Solutions, which is
the most expensive registrar.

If you are willing to expend a slightly larger amount of time and effort in acquiring a
domain name, you can get one yourself from another registrar. Network Solutions charges
$70 for two years, but other registrars are available with cheaper prices. Some even offer
free domain name registration if you use the registrar as your Web hosting company.
Besides the additional time required to find a registrar, you’ll also need to transfer your
new domain to your Web hosting company, which takes a bit more time and effort (see
the later section “Signing Up for Service” ). For a current listing of available registrars,
go to the Domain Name Resource Directory Web site at www.dnresources.com, as shown
in Figure 2-5.
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Figure 2-5 Domain Name Resource Directory’s listing of registrars.

Choosing a WChoosing a WChoosing a WChoosing a WChoosing a Web Hosting Serviceeb Hosting Serviceeb Hosting Serviceeb Hosting Serviceeb Hosting Service
Choosing a company to host your Web site can be a bewildering experience. With
thousands of Web hosting companies, each offering several different hosting plans, it
takes a little knowledge and some patience to choose one.

The next sections will help you understand the different features available from host-
ing companies, determine whether to sign up with a local or out-of-state company, and
find out where to look for Web hosting companies.

NOTENOTENOTENOTENOTE You may see the terms ISP and hosting company used interchangeably. Strictly
speaking, an ISP provides Internet access and a hosting company hosts Web
sites. However, most ISPs provide Web hosting as well as Internet access, and
some hosting companies also provide Internet access.
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Comparing Host FeaturesComparing Host FeaturesComparing Host FeaturesComparing Host FeaturesComparing Host Features
Web hosting companies offer many different features, most of them described by an
excessive amount of technology jargon. Most ISPs offer several different hosting “plans,”
often divided into categories such as “personal,” “business,” and “e-commerce.” Your
company or organization will most likely need a business hosting plan.

Virtual Domains/Domain HostingVirtual Domains/Domain HostingVirtual Domains/Domain HostingVirtual Domains/Domain HostingVirtual Domains/Domain Hosting
In order for you to use your own domain name (www.yourcompany.com), your Web
hosting company will need to support virtual domains, or domain hosting (companies
use different terms). This is typically a basic feature of business hosting plans, but it
isn’t a feature of most personal hosting plans, since personal Web sites don’t usually need
their own domain name.

WWWWWebDAebDAebDAebDAebDAV SupportV SupportV SupportV SupportV Support
WebDAV is a document version control standard that lets you work on your Web site
with multiple users, without overwriting each other’s work. Like Visual SourceSafe,
another version control standard that Dreamweaver supports, WebDAV doesn’t pro-
vide much additional functionality unless it is used in conjunction with sophisticated
document control software that is beyond the reach of most small businesses and or-
ganizations. This feature is unnecessary for most users.

FrontPage Server ExtensionsFrontPage Server ExtensionsFrontPage Server ExtensionsFrontPage Server ExtensionsFrontPage Server Extensions
If you plan to use Microsoft FrontPage to create any parts of your site that are diffi-
cult to create with Dreamweaver—such as form processing or discussion groups—then
your Web hosting company needs to support FrontPage Server Extensions.

FrontPage Server Extensions provide server-based tools that make it easy for FrontPage
to create Web page components that are normally difficult to create, such as forms,
discussion groups, and Web site search capability.

CGI ScriptsCGI ScriptsCGI ScriptsCGI ScriptsCGI Scripts
Most ISPs offer the ability to use CGI or Perl scripts on your Web site. These scripts
allow Web page forms and online ordering to work. If you want to create forms with
Dreamweaver, your ISP needs to support CGI scripts (or Active Server Pages, discussed
below).
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Disk Space AllotmentDisk Space AllotmentDisk Space AllotmentDisk Space AllotmentDisk Space Allotment
Many organizations will find that the amount of disk space allotted to their Web site
isn’t a crucial factor in the decision of which company to use for Web hosting. Most
organizations’ Web sites are rather small, so they generally don’t have trouble fitting
comfortably in the 25MB of Web space provided by even the most barebones of Web
hosting plans.

However, if you plan on having a large number of images, audio, or video files on your
Web site, disk space allotment becomes an important issue. If this could be the case,
you may want to opt for a hosting plan that offers 100MB, 200MB, or an unlimited
amount of disk space.

Database Support and Active Server PagesDatabase Support and Active Server PagesDatabase Support and Active Server PagesDatabase Support and Active Server PagesDatabase Support and Active Server Pages
If your company wants to use a database on your Web site and dynamically create pages
based on data from the database, your Web hosting company needs to support both
databases and Active Server Pages (ASP) or some other database technology, such as
ColdFusion.

If you plan on accessing a database on your Web site, consider meeting with the Web
site consultant who will set up the database before choosing your hosting company. They
may have specific technology requirements to add to your hosting requirements.

E-Mail Accounts and AliasesE-Mail Accounts and AliasesE-Mail Accounts and AliasesE-Mail Accounts and AliasesE-Mail Accounts and Aliases
Most Web hosting companies will provide your company or organization with e-mail
accounts using your domain name for free with your Web hosting—i.e.,
bettysmith@yourcompany.com. In general, pick a hosting plan or company that pro-
vides as many e-mail accounts as you’re likely to need. Although most companies will
allow more accounts, these usually cost $2 to $5 per month per account extra.

Besides e-mail accounts, most hosting plans also offer e-mail aliases. An e-mail alias is
a virtual e-mail address that forwards received mail to another address. For example, you
could set up an info@yourcompany.com alias that forwards all mail received by that
e-mail address to infoyourcompany@hotmail.com.

Most Web hosting plans provide either a very large or unlimited number of aliases. This
allows you to create as many e-mail addresses using your domain name as you want (even
if you have a limited number of real e-mail accounts)—provided the people you’re cre-
ating addresses for already have at least one e-mail account elsewhere that they can use.
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E-Mail Server TE-Mail Server TE-Mail Server TE-Mail Server TE-Mail Server Typeypeypeypeype
Three types of e-mail servers are commonly used on the Internet:

• POP servers. When using POP servers, you download all mail from the server into
your mail program, such as Microsoft Outlook, Outlook Express, or Qualcomm
Eudora. Most hosting companies use POP servers.

• IMAP servers. When using IMAP servers, all messages are stored on the mail server
(and thus remain accessible from multiple locations). You can view your messages
using most popular e-mail programs (although Outlook Express 5.5 and earlier can’t
create message rules for IMAP accounts).

•  Web-based servers. When using Web-based servers (such as Hotmail), you access your
messages using a Web browser. This permits you to check your e-mail when you are
away from your computer by using any Web browser, but it is less powerful than using
an e-mail program such as Outlook. Some ISPs provide Web access to POP- or
IMAP-based e-mail accounts, providing the advantages of both server types, as
shown in Figure 2-6.

Figure 2-6 Checking e-mail through a Web-based interface.
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SubdomainsSubdomainsSubdomainsSubdomainsSubdomains
Some Web hosting companies allow you to create subdomains for your Web site, such
as support.yourcompany.com or events.yourcompany.com. This isn’t an important feature
for most smaller companies and organizations. In fact, you should avoid needlessly
creating subdomains, since the main reason to create a subdomain is to make it easier
for people to go directly to a specific part of your site. This is generally better done with
a link on your home page.

However, if your company or organization has separate divisions that want their own
sites, subdomains are a cost-effective solution, because you can have as many subdomains
as your Web host allows without having to pay any additional registration fees (you’re
still using only one domain name). Subdomains are administered and created as sepa-
rate Web sites, which can be highly desirable for divisions of your company or orga-
nization that want their own autonomy, but this places an added burden on your Web
site staff if this autonomy isn’t needed.

Mailing Lists, List Servers, and MajordomoMailing Lists, List Servers, and MajordomoMailing Lists, List Servers, and MajordomoMailing Lists, List Servers, and MajordomoMailing Lists, List Servers, and Majordomo
Depending on your business or organization, you may want to start a mailing list that
you can use to send mass mailings to all people subscribed to the list. This is very useful
for sending out information about upcoming events, specials, or tips.

A number of methods exist for creating mailing lists, but if your company or organi-
zation thinks this might be a desirable capability, consider finding a Web hosting
company that includes some sort of mailing list capability at little or no extra cost. Some
of the more common programs used for mailing lists are the Majordomo programs,
Listserv, and Petidomo.

NOTENOTENOTENOTENOTE For more information on mailing lists, see “Step 7: Deploy Your Web Site.”

Data TData TData TData TData Transfer Limitationsransfer Limitationsransfer Limitationsransfer Limitationsransfer Limitations
Every time someone views a page on your Web site or downloads a file, they’re trans-
ferring data from your site. Similarly, when you upload new pages or files to your site,
you’re also transferring data. Some Web hosting companies have a limit as to how much
data can be transferred per month. If your site goes above this limit (because of lots of
visitors or large file downloads), you’re charged extra.

Although most Web sites don’t generate a lot of data transfers even when they’re busy,
if you anticipate having a popular site with lots of images, audio/video, or downloadable
files, you may want to opt for a Web hosting service that doesn’t have a data transfer limit.
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SSL (Security)SSL (Security)SSL (Security)SSL (Security)SSL (Security)
Secure Sockets Layer (SSL) is a way of encrypting data that is transferred to and from
a Web site, and it is typically used for Web stores that process credit card transactions.
As such, it is an important feature if your company or organization has plans to set up
an online store (discussed in “Appendix D: Creating Web Stores”). Otherwise, the
feature isn’t necessary.

TTTTTechnical Supportechnical Supportechnical Supportechnical Supportechnical Support
All Web hosting companies provide technical support for any problems with publishing
your Web site, Web site availability, e-mail, and so forth. However, the type, quality,
and availability of this support vary. Not all companies provide toll-free technical support
phone numbers; not all companies provide 24-hour, 7-day-a-week (24/7) technical
support.

NOTENOTENOTENOTENOTE A toll-free number might be important to you, but the always-available tech-
nical support might not be if there isn’t going to be anyone working on or
checking your Web site after-hours.

Another support option that is becoming increasingly popular is Web-based techni-
cal support. This allows you to conduct a live chat with a technical support person over
your Internet connection, and it is handy for people who don’t want to wait on hold.
(You might have to wait online, but many people find it easier to get work done while
they are waiting this way.)

WWWWWeb Server Speedeb Server Speedeb Server Speedeb Server Speedeb Server Speed
The speed of a Web server is fairly difficult to ascertain from reading promotional
material on a company’s Web site. This is unfortunate because Web server speed is
important. (You’ve probably noticed times when your Internet connection was fast but
a particular site took an unusually long time to download. That’s an example of a slow
Web server.)

Reading reviews of hosting companies can be helpful, but they are difficult to find. You
can ask companies about their Web hosting speed, but the typical answer is “we’re fast
enough.” However, to be thorough, you may want to ask the following questions:

• How much bandwidth is available? A Web server running off a T1 connection may
saturate the connection during busy times or if it is hosting too many Web sites. When
the bandwidth available is fully utilized, Web site performance suffers. Table 2-1
summarizes the different connection speeds commonly used for Web servers.
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CONNECTION TYPECONNECTION TYPECONNECTION TYPECONNECTION TYPECONNECTION TYPE BANDWIDTHBANDWIDTHBANDWIDTHBANDWIDTHBANDWIDTH

T1 1.544Mbps

T3 45Mbps

T4 259.4Mbps

DS1 3.088Mbps

DS2 6.176Mbps

DS3 45Mbps

OC1 51.84Mbps

OC2 103.68Mbps

OCn n*51.84Mbps

Table 2-1 Various Web server Internet connections and their associated bandwidth.

• How many sites is the Web server hosting? A super-fast Internet connection on a
really powerful Web server doesn’t mean your site is going to be fast if there are too
many other sites hosted by the same Web server. Similarly, if too many users share
the Internet connection’s bandwidth, performance will suffer. (Many Web hosting
companies also act as ISPs and share the available bandwidth with both dial-up and
DSL customers as well as their Web servers.)

• How fast is their server? Once again, it’s hard to make a direct comparison since the
necessary speed of a server depends directly on the number and nature of the Web
sites it’s hosting. In general, though, servers are running pretty powerful processors,
often in a two-way or four-way multiprocessing setup (they contain two or four
processors), with a hardware Redundant Array of Independent Disks (RAID) for
storage. (A RAID is a collection of hard drives that is treated as one drive by the
operating system and usually provides extra speed and reliability.)

WWWWWeb Server Reliabilityeb Server Reliabilityeb Server Reliabilityeb Server Reliabilityeb Server Reliability
Even more important than Web server speed is the reliability of the server, since no-
body can view your site if the server is down. To assess Web server reliability, most people
rely on the uptime percentage, which is something that can easily be measured. Most
organizations aim for 99.9 percent uptime (roughly nine hours of downtime a year).

To attain a good uptime percentage, reliable Web hosts use a variety of hardware and
software to decrease the potential for downtime. Web servers should use a hardware
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RAID for storage, protecting your data in case a hard drive dies. The hosting company
should also perform routine tape backups of all data, as well as keep its Web servers on
Uninterruptible Power Supply (UPS) devices and possibly even have backup genera-
tors for major power trouble.

There’s no real consensus on what server software your ISP should run. Most ISPs
operate on either Linux with the Apache Web server, Sun’s Solaris, or Microsoft
Windows 2000 Server (or newer) with the latest service pack and hotfixes. WebDAV
and FrontPage Server Extensions are more commonly supported (and arguably more
reliable) on the Windows 2000 platform, so if these features are important to you, we
suggest you use Windows 2000 Server-based hosting.

Local vs. National WLocal vs. National WLocal vs. National WLocal vs. National WLocal vs. National Web Hosting Companieseb Hosting Companieseb Hosting Companieseb Hosting Companieseb Hosting Companies
One decision that’s difficult to make is whether your company or organization should
use a local or out-of-state Web hosting company.

Using a local company can be advantageous if you need consulting work done on your
Web site in addition to Web hosting, since there’s often no substitute for meeting in
person with a consultant and discussing what needs to be done. When that consult-
ant happens to work for your Web hosting company, they’re often more effective in
working on your site (at least if database integration or e-commerce are involved).

However, local Web hosting companies usually cost more and provide fewer features
than national companies. This is what nationwide competition does for you—it allows
you to pick the best mix of price and features for your company from a pool of thou-
sands of Web hosting companies. It’s unlikely that the best value will happen to be your
local Web hosting firm. Local companies also often lack some of the features that out-
of-town companies offer, such as 24/7 technical support, large numbers of e-mail
addresses, large amounts of disk space, and the ability to use subdomains.

Where to Find a WWhere to Find a WWhere to Find a WWhere to Find a WWhere to Find a Web Hosting Companyeb Hosting Companyeb Hosting Companyeb Hosting Companyeb Hosting Company
Even armed with good selection criteria, you’ll still need to locate prospective Web
hosting companies. And with the thousands of Web hosting companies that you can
choose from, narrowing your list of candidates to a reasonable number can be a time-
consuming and difficult process. Several useful resources exist, however, to point you
in the right direction.



3636363636 New Webmaster’s Guide to Dreamweaver 4 - Electronic Edition

TIPTIPTIPTIPTIP Choosing a Web hosting company isn’t like getting married—you can easily
change your mind and switch companies at almost any time (although you
might want to sign up for a one-year contract to avoid any setup fees). So
don’t waste too much time trying to find “the one”—take a little time, find
one you like, and then try them out. If you later locate a better one, switch
when your contract is up.

DN ResourcesDN ResourcesDN ResourcesDN ResourcesDN Resources
The www.dnresources.com Web site has a special Hosting section, as shown in Figure 2-7,
that lists sites that list Web hosting companies. It’s a little confusing, but it can still be a
good place to come up with some companies to possibly host your site.

Figure 2-7 The Web Site Hosting section of the DN Resources site.

Microsoft’Microsoft’Microsoft’Microsoft’Microsoft’s Locate A Ws Locate A Ws Locate A Ws Locate A Ws Locate A Web Presence Provider Siteeb Presence Provider Siteeb Presence Provider Siteeb Presence Provider Siteeb Presence Provider Site
Located at www.microsoftwpp.com, this site, as shown in Figure 2-8, allows you to per-
form a search for a Web hosting company that is a Microsoft registered host for FrontPage
Web sites. This is probably the best place to search for a Web hosting company if you
plan to use FrontPage 2000 to create forms or discussion groups for your site.
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Figure 2-8 Microsoft’s Locate A Web Presence Provider site.

Local Computer PapersLocal Computer PapersLocal Computer PapersLocal Computer PapersLocal Computer Papers
If you’re looking for a local Web hosting company, check out computer papers or the
technology section of your local paper for ads from local companies. You can also check
the Yellow Pages under Internet.

Signing Up for ServiceSigning Up for ServiceSigning Up for ServiceSigning Up for ServiceSigning Up for Service
After deciding on a domain name, locating a Web hosting company, and selecting the
appropriate hosting plan, you need to sign up for the actual service. Although the details
of the sign-up process are different for every company, the basic steps will be similar
no matter which company you use.

1. Locate your Web hosting company.

Find the Web hosting company you want to use, and go to its Web site.

2. Find the plan you want, and start the sign-up process.

Locate the hosting plan that is best suited to your company or organization on the
Web hosting company’s Web site. This is typically the cheapest one that offers all
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the features you need. Look for the business plans. Once you’ve found the best plan
for your company or organization, click the Order Now or similar link.

TIPTIPTIPTIPTIP If you’re uncertain about some of the questions on the sign-up forms or
prefer to talk to a person, call the Web hosting company—it’s just as easy to
sign up for Web hosting service over the phone.

3. Get your domain name.

This is typically the first step of the hosting company’s sign-up process, as shown
in Figure 2-9. To allow the Web hosting company to take care of the domain name
registration, indicate that this is a new domain and enter the domain name you want
in the box provided. If you already have a domain name, specify that you already have
a domain name or that you want to transfer a domain name, and then enter the
domain name in the box provided. If you want to get your domain name from a
registrar other than Network Solutions, go to the registrar’s site and purchase the
domain name, and then come back and enter it on the Web hosting company’s sign-
up form.

Figure 2-9 Signing up for Web hosting and registering a new domain name.
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NOTENOTENOTENOTENOTE Most Web hosting companies use Network Solutions for registering domain
names, which charges $70 to register your domain name for two years. If you
already have a domain name or want to save money by using a different
registrar, make sure to choose the Transfer Existing Domain or similar option.

4. Provide an e-mail address and password.

Enter the e-mail address that you want to use to receive information about your new
Web site, as shown in Figure 2-10. Enter a password for your site also—preferably
a long one that only you or your Web site administrator will know.

Figure 2-10 Entering an e-mail address, Web site password, and domain name.

TIPTIPTIPTIPTIP Keep your Web site’s password in a secure location and give it to only those
employees who will administer the Web site. When employees who know the
password leave your organization, change the password.
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5. Fill out user and billing information.

Verify your domain name and enter your credit card and billing information in the
last step (typically) of the Web hosting sign-up form, as shown in Figure 2-11.

Figure 2-11 Entering billing information.

6. Transfer your domain name (if registered separately).

If you are transferring a domain name from another Web hosting company (or if you
purchased a domain name from another registrar), go to your registrar’s Web site, sign
in, and change the name servers to those provided by your new Web hosting com-
pany. This typically involves clicking one or more Modify Domains links, as shown
in Figure 2-12.
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Figure 2-12 The Modify Domains section of a domain name registrar.

7. Provide your name server information.

Enter the primary and secondary name servers’ IP addresses and names (your Web
hosting company will give you these) in the boxes provided, as shown in Figure 2-13.
Doing this instructs the domain name registrar where to send the visitors who are
looking for your site.
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Figure 2-13 Entering your Web hosting company’s name servers.

NOTENOTENOTENOTENOTE Once you’ve set up your Web hosting account, you’ll need to set up any
e-mail accounts you want to use in a separate procedure. You should at the
very least create info@yourdomain.com and webmaster@yourdomain.com
accounts or aliases to handle general information questions and comments
or problems with the Web site. This is typically done by logging onto your Web
hosting company’s site and adding any e-mail accounts and aliases you want.
Check with your Web hosting company for more information on the exact
procedure. It varies with each company.

SummarySummarySummarySummarySummary
After selecting a domain name and signing up for Web hosting service, you’re ready
to assemble your content in preparation for constructing your Web site.
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Step 3

COLLECT AND ORGANIZE YOUR CONTENTCOLLECT AND ORGANIZE YOUR CONTENTCOLLECT AND ORGANIZE YOUR CONTENTCOLLECT AND ORGANIZE YOUR CONTENTCOLLECT AND ORGANIZE YOUR CONTENT

Featuring:Featuring:Featuring:Featuring:Featuring:

• Creating a Central Location for Content

• Establishing a File Naming Convention

• Collecting Existing Digital Content

• Creating New Digital Content

• Organizing Your Content and Planning Your Web Site

Once you’ve identified your Web site goals, acquired a domain name, and signed
 up for a Web hosting service, you collect your content and create the site itself.

Although it’s not strictly necessary, getting smart about the way you collect and orga-
nize your content makes Web site construction easier and yields better results.

Creating a Central Location for ContentCreating a Central Location for ContentCreating a Central Location for ContentCreating a Central Location for ContentCreating a Central Location for Content
Repeatedly searching for content in a number of different locations not only decreases
productivity but also increases the chance that important content will get misplaced
or duplicated on your Web site.

When you actually create a Web site in Dreamweaver, you first need to create a new
folder called the local root folder, or local site, that Dreamweaver uses to store the Web
site. Most, if not all, files stored in your Dreamweaver web will eventually get published
to your Web server (and made available on the Internet).
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Therefore, it makes sense to have a completely separate folder (known as the central
content folder) in which to store content before it gets added to the Web site, as shown
in Figure 3-1. Think of it as a staging area for content—anything that your company
considers potential content can be placed in this separate folder to be evaluated and
added to the site as appropriate.

Figure 3-1 Where Web content is stored in the process of creating Web pages.

TIPTIPTIPTIPTIP You may find that your organization doesn’t need a central content folder,
perhaps because all your content is quickly integrated into the site or because
it is easy to locate without having to centralize it. If this is the case, when we
suggest looking in or placing content in your central content folder, just go
to the source of your content instead.

Before you create a folder in which to store your potential Web content, first decide
on an appropriate computer or network disk. It’s ideal to use a network disk that is both
backed up regularly and uses some method of protecting against hard disk failure (such
as a RAID). It’s also preferable to use a Windows 2000 or Windows NT partition
formatted using the NTFS file system, which provides additional security features.
However, if your company or organization doesn’t have these resources, simply choose
the most convenient computer or network disk.



Step 3Step 3Step 3Step 3Step 3    Collect and Organize Your Content 4545454545

The central content folder could be located on the same computer or network disk as
the Dreamweaver web or in a completely different location. After you’ve decided on
a location, create the folder by following these steps:

1. Launch Windows Explorer.

Click the Start button, choose Programs, and then click Windows Explorer. (If you’re
using Windows 2000, click the Start button, choose Programs, choose Accessories,
and then click Windows Explorer.)

2. Navigate to the location where you want to create the folder.

In the Folders pane on the left of the Windows Explorer window, click the plus sign
to expand the subfolders next to the location where you want to store the content
folder. For example, click the plus sign next to My Computer to view the local hard
drives in your system (and any network disks that are mapped to a drive letter), as
shown in Figure 3-2.

Figure 3-2 Navigating to the desired content folder location using Windows Explorer.
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3. Create a new folder.

While viewing the drive or folder where you want to store your content, right-click
a blank area of the right pane, choose New from the shortcut menu, and then choose
Folder from the submenu, as shown in Figure 3-3.

Figure 3-3 Creating a new folder using Windows Explorer.

4. Enter a name for the folder.

When you create a new folder, the folder name is automatically highlighted. Enter
the name you want for the folder, and then click anywhere on screen to save the name.
If you make a mistake, right-click the folder and choose Rename from the shortcut
menu.

Establishing a File Naming ConventionEstablishing a File Naming ConventionEstablishing a File Naming ConventionEstablishing a File Naming ConventionEstablishing a File Naming Convention
Before you start collecting or creating content for your site, it’s important to establish
a file naming convention. This step makes it easier to identify files and work with them.

Opinion differs as to what makes good file naming conventions, but consistency is
paramount. Create some rules that work for you, and stick to them. Here are some
recommendations:
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• Unix Web servers treat spaces in filenames and capitalization differently than do
Windows Web servers. To accommodate this, name your files using all lowercase
letters, and instead of using spaces, use the underscore character or simply run words
together (for example, webpresentation1.htm or web_presentation1.htm). Even if
you’re using a Windows Web server now, this makes your Web site more flexible if
you decide to move to a Unix Web server in the future.

• If your content is time-sensitive, such as newsletter copy, use a date in the filename,
either at the beginning of the name or at the end.

• Images often come in large and small sizes (full size and thumbnail). Append a short
tag to differentiate large and small images—perhaps small_ or s_ in front of the image
name (for example, small_product1.jpg or s_product1.jpg). Alternatively, place the
tag at the end (for example, product1_small.jpg or product1_s.jpg).

Collecting Existing Digital ContentCollecting Existing Digital ContentCollecting Existing Digital ContentCollecting Existing Digital ContentCollecting Existing Digital Content
Most companies and organizations already have a large amount of digital content that
can be used on a Web site with only a minimal amount of work.

When we say digital content, what we mean is any content that can be opened in a
computer. This includes data on hard drives, your local network, the Internet (though
be careful about copyrights), floppy and Zip disks, CD-ROMS, and so forth.

To use existing digital content (which comes in many types), you need to convert it to
an appropriate format for importing into Dreamweaver.

TTTTTypes of Digital Content to Look Forypes of Digital Content to Look Forypes of Digital Content to Look Forypes of Digital Content to Look Forypes of Digital Content to Look For
Just about any kind of digital content you have can be adapted for use on the Web. The
following list gives examples of some common types of content that your organization
might have that would be suitable for publishing on your site. (This list is by no means
comprehensive. Other data types can also be used, although depending on your appli-
cations, it might take a little work to get them into Web page format.)

• Word-processor documents (.doc, .txt, .wpf ) include materials such as project re-
ports, manuals, company objectives, newsletters, and notices to customers created with
word-processing programs, such as Microsoft Word, AppleWorks, or Corel
WordPerfect.
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• Microsoft PowerPoint presentations (.ppt), such as slide shows or demonstrations,
might be great additions to your Web site.

• Spreadsheet documents (.xls) might also be good content for your Web site, provided
the data relates to your site’s purpose and target audience. This could include financial
information, analyzed data from technical companies, or statistical data from test
results.

• Digital images (.jpg, .gif, .png, .fpx) are a staple of any Web site, and any digital
images that your company has are potential content for your site. This includes
company logos or graphics.

• Flyers, brochures, or other computer-created content (.pub, .p65, and so on) stored
in some sort of computer format (perhaps created using Microsoft Publisher or
Adobe PageMaker) are also excellent sources of content.

• E-mails can often be a rich source of content, although special care needs to be taken
when using e-mail conversations on a Web site. Special messages sent out to custom-
ers can be placed in a Web page for users who didn’t receive the e-mail, customer
questions and answers can be integrated into a Frequently Asked Questions page,
or visitor comments can be placed on a Feedback page (usually with names removed).

• Existing Web pages might seem an obvious choice, but if your company or organi-
zation already has Web pages it has created for one reason or another, you should
probably evaluate how useful they would be on your new Web site.

• Sound files and/or video files (.wav, .au, .mp3, .mpg, .avi, .mov) are usually very large
and should generally be avoided on Web sites, but you might find audio and/or video
files that would be perfect for your site. Use discretion with these files because of their
large size and the slow speed of most visitors’ Internet connections.

Converting Existing Data to an Appropriate FormatConverting Existing Data to an Appropriate FormatConverting Existing Data to an Appropriate FormatConverting Existing Data to an Appropriate FormatConverting Existing Data to an Appropriate Format
You need to convert most content into Hypertext Markup Language (HTML) for-
mat before you can use it in Dreamweaver. To do this, open the content in the appli-
cation used to create the content and save it in the HTML format. To import the
content into Dreamweaver, open the HTML file in Dreamweaver and copy and paste
the text into the appropriate Web page.

If you want the content to stand apart from the rest of your Web site and the content
transfers elegantly to HTML, such as exported PowerPoint presentations as shown in
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Figure 3-4, simply link the pages to the rest of your site, as discussed in “Step 4: Create
Your Site” and “Step 5: Create Your Pages.”

Figure 3-4 A PowerPoint presentation exported to a Web page.

If the native application can’t export content to HTML format, it’s best to copy and
paste the text directly into Dreamweaver. However, if the formatting is important, you
can sometimes circumvent this limitation by opening the file in another program that
does support saving in HTML format, such as Microsoft Word.

TIPTIPTIPTIPTIP Dreamweaver has a special command for importing Web pages that were
created using Microsoft Word: choose the File menu’s Import command and
then choose Import Word HTML from the submenu. This command opens the
Web page and strips out a large amount of unnecessary code that Word places
in the page. For more information, see “Step 5: Create Your Pages.”

To import spreadsheet content, save the content to an HTML file or as a text file (either
tab-delimited or using comma-separated values, .csv). Then use Dreamweaver’s Import
Table Data command, as discussed in “Step 5: Create Your Pages.”
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Images present their own set of importing issues. Table 3-1 displays a list of the im-
age formats that Dreamweaver can use. In general, if the image is small or is a computer-
created graphic, such as a company logo, use the GIF image format. If the image is a
full-color, photograph-quality image, save it in JPEG format. The newer PNG format
is becoming a viable alternative for both formats, since it can be used in low-color mode
to keep file size down or in full-color mode for photographs. PNG images maximize
cross-platform quality, although they are often too large to use on the Web.

EXTENSIONEXTENSIONEXTENSIONEXTENSIONEXTENSION FILE FORMAFILE FORMAFILE FORMAFILE FORMAFILE FORMATTTTT

.gif CompuServe Graphics Interchange Format (GIF) image

.jpg, .jpeg Joint Photographic Experts Group ( JPEG) image

.png Portable Network Graphic (PNG) image

Table 3-1 Image formats that Dreamweaver can import.

WWWWWARNINGARNINGARNINGARNINGARNING PNG images aren’t supported by versions of Netscape Navigator or
Microsoft Internet Explorer older than 4 without using a plug-in.

If the quality or size of the image is important, or if you need to do something sophis-
ticated like create an image with transparency, modify the file using a stand-alone image
editor, such as Macromedia Fireworks, Adobe Photoshop, or Microsoft PhotoDraw. If
the program has a Save For Use On The Web function or similar command, consider
using it.

Using Macromedia Fireworks as your image editor offers some specific benefits when
creating Web pages in Dreamweaver, including the ability to quickly optimize an image
directly from Dreamweaver, as shown in Figure 3-5. (It also allows you to easily create
rollover buttons and perform batch image processing, such as quickly creating a photo
album from an image folder.)
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Figure 3-5 Optimizing an image with Dreamweaver’s Optimize Image In Fireworks
command.

TIPTIPTIPTIPTIP It’s best to avoid using large images to prevent Web pages from taking too
long to load. If you want to display a large, high-quality image, create a
thumbnail (miniature version) of the image that is linked to the full-size image.
This allows the Web page to load quickly, and then if some visitors want to
see the high-resolution image, they can click the hyperlink to display the larger
image. There is no hard rule about image sizes, but, generally, if your page
takes longer than 30 seconds to load over a 28.8 connection, make your
images smaller or remove some of them. For more information about working
with images in Dreamweaver, see “Step 5: Create Your Pages.”
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Creating New Digital ContentCreating New Digital ContentCreating New Digital ContentCreating New Digital ContentCreating New Digital Content
Not all content for your Web site is going to be available in digital format. Some of it
will exist in print form and yet more will need to be created from scratch.

In general, the new content falls into two categories: images and documents. Images
are usually created using a digital camera, a scanner, or from scratch using an art pro-
gram. Documents are generally created from scratch using a word processor or spread-
sheet program, although you might be tempted to scan printed documents that aren’t
already available in digital format.

Digital ImagesDigital ImagesDigital ImagesDigital ImagesDigital Images
There are several ways to create new digital images for use on a Web site. Photographs
can be scanned into the computer using a scanner, imported using a Photo CD picture
disk or online image processing service, or they can be taken using a digital camera and
directly imported into the computer. Digital images can also be created in the computer
using an art program. The following sections give you an overview of how digital image
resolution works, help you get images into the computer no matter what method you
choose, and also help your company decide which method will work best for future image
acquisition.

Dots per Inch and Image ResolutionDots per Inch and Image ResolutionDots per Inch and Image ResolutionDots per Inch and Image ResolutionDots per Inch and Image Resolution
Two factors determine the size and resolution of an image: dots per inch (dpi) and
resolution (pixels). All images on a computer monitor are displayed at 96dpi or 72dpi
(depending on whether you’re using a PC or a Macintosh), so the only way to increase
the quality onscreen is to increase the resolution.

However, when discussing photographs to scan or images to print, the situation gets a
little contradictory. Since you can’t change the size (and resolution) of a photograph
you’re scanning, in order to get a higher-quality image, you need to increase the dpi.
Similarly, when printing an image, if you keep the resolution (and size) the same or lower
it, but increase the dpi, you end up with a possibly smaller but more richly detailed
printout. Although a 300dpi image and a 96dpi image will look the same onscreen, the
300dpi image will look much better when printed out on a high-resolution printer.
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NOTENOTENOTENOTENOTE Inkjet printers can print upwards of 1440dpi, but you don’t need to create
1440dpi images to make the best use of these printers (and please don’t—
the resulting images would be gigabytes in size). A 300dpi image yields finely
detailed printouts on a 1440dpi inkjet printer and increasing the dpi further
doesn’t provide a large increase in image quality.

When you scan an image, the dpi you specify controls the resolution (size) of the image.
For example, a four-by-six-inch photograph scanned at 150dpi makes a roughly
900x600-pixel image—just a bit bigger than full screen for a computer using the
800x600 screen resolution. You can then crop this image a bit and save it as an 800x600-
sized image at 96dpi for use as a large image on the Internet.

Here are some recommendations for resolution, image size, and dpi:

• Scan images at whatever dpi necessary to get the size of image you want. If you have
a four-by-six-inch photo, scan at 150dpi to end up with a 900x600 image.

• Save images for use on the Internet or computer screens at 96dpi.

• Save images intended for high-quality printouts at between 150dpi and 300dpi,
depending on the resolution of the printer and the importance of quality.

Digital CamerasDigital CamerasDigital CamerasDigital CamerasDigital Cameras
The best way to quickly and easily acquire images for use on a Web site is with a digi-
tal camera. Digital cameras are here to stay, and they are already replacing standard film
cameras for many businesses and organizations—especially those that need to take lots
of pictures for use on the Web (such as real estate professionals).

Digital cameras offer numerous advantages. They’re the fastest way to get an image into
the computer because there is no need to develop prints. Most have a small display screen
so that you can instantly view captured photos—and immediately delete any that you
don’t like. The image quality on most new megapixel digital cameras (cameras that take
images at 1024x768 resolution or higher) are more than adequate for any Web site work,
and even print work can be accommodated by the highest resolution cameras (though
not quite as well as standard film).
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The biggest drawbacks with digital cameras are cost, battery life, and complexity. They’re
still pretty expensive, although this is changing, especially for midrange or low-end
cameras (which are now usually sufficient for Web site work). Digital cameras typically
have a voracious appetite for batteries. (Stock up on rechargeable batteries if your camera
doesn’t come with them.) Also, digital cameras are more complex to operate than normal
film cameras and have a slightly steeper learning curve than normal cameras.

TIPTIPTIPTIPTIP If you’re in the market for a digital camera, we strongly urge you to consider
getting one that has a USB interface, unless you have or plan to get a memory
card reader (preferably USB) for your computer. The USB interface makes
transferring images from the camera faster and much easier to configure, and
it is now a standard feature on most cameras. Also, consider getting a cam-
era with a zoom lens. Even a moderate two or three times magnification zoom
provides a lot of flexibility when taking pictures.

Here are some recommendations for using digital cameras for Web site image acquisition:

• Configure your camera to take pictures at the highest resolution you think your
company may require. If you know that the images will never be used anywhere other
than on the Internet or in a computer, it may be adequate to take pictures at 896x592
or similar resolution. You could even shoot images at 640x480 if the images will never
be used full screen or for print work. If it’s at all possible that the images will be used
for high-quality printouts, take images at 1440x960 resolution or higher.

• Even if you don’t require high-resolution images, configure your camera to use the
highest- or second-highest-quality setting available. Avoid using an uncompressed
image quality setting, which makes images much larger and isn’t necessary unless you
are doing high-resolution print work.

• After taking pictures, transfer them into a separate images subfolder located in your
central content folder.

• Give images a short but descriptive name so that it’s easy to tell what they are at a
glance.
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Scanning PhotosScanning PhotosScanning PhotosScanning PhotosScanning Photos
One of the most popular ways to get images into the computer is to take pictures using
a standard camera, get prints made, and then scan the prints using a scanner.

One of the best things about scanning photos is the low up-front cost associated with
it. Normal print cameras are relatively inexpensive and produce high-quality images.
Similarly, film isn’t very expensive, and excellent flatbed scanners can be purchased for
$100 or less.

Scanning is also the only way to get existing photos into the computer, and it’s still the
best way to get extremely high-quality images into the computer.

TIPTIPTIPTIPTIP Flatbed scanners provide the most flexibility in the types of items that can be
scanned, although sheet-fed scanners and photograph-specific scanners are
usually less expensive. However, if you anticipate scanning only photographs,
a photograph scanner may prove easier to use than a flatbed scanner because
there’s no glass to smudge and photographs won’t slide around as much.

If your company frequently takes pictures for use on its Web site, scanning pictures
isn’t always the most effective way of getting pictures into the computer. Generally, a
whole roll of film must be taken before prints can be made and getting prints made takes
both time and money. Once prints are made, scanning them can also take a fair amount
of time and patience.

TIPTIPTIPTIPTIP If you’re in the market for a scanner, we recommend picking up a USB scan-
ner that’s supported by Windows 2000. USB scanners are easy to set up and
fast, and even if your company doesn’t have Windows 2000 yet, Windows
2000 will serve as the foundation for Microsoft’s future business and consumer
operating systems, making it a good idea to get devices supported by it.

Here are some recommendations for scanning images into the computer:

• Scan images at a dpi setting to yield the largest size images you might need, and keep
these high-resolution images in a separate high-resolution folder. For use on the Web,
resize the images down to an appropriate size and save them in a different location
or using a different filename.
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• Scan images into the central content folder so that everyone working on the site can
find them.

• Give images a short but descriptive name so that it’s easy to tell what they are at a
glance.

Picture CDs and DisksPicture CDs and DisksPicture CDs and DisksPicture CDs and DisksPicture CDs and Disks
One way to get photographs into the computer if you don’t have a digital camera or
scanner is to pay an additional fee to get a Picture CD, Photo CD, or pictures on disk
when getting regular print film developed.

This method eliminates the hassle of scanning pictures; however, it isn’t very cost-ef-
fective for most organizations. Generally, in addition to the cost of developing and
creating prints, there is another charge of $3 to $20 per roll of film, depending on the
scanning resolution and the company. It doesn’t take too many rolls of film at this price
before you’ve matched the price of a new scanner.

However, if there’s a pressing need to acquire images and you don’t have an alternative
means to acquire images, paying to get pictures placed on CD or floppy disk at the time
of developing can be an effective way to accomplish the task at hand.

Here are some recommendations for helping you make the most of images from a CD
or floppy disk:

• If you regularly use picture CDs or floppies, label the CDs or floppies well and store
them where everyone working on the site can find them.

• The best way to take images from a picture CD or floppy is to browse to the images
on the CD or floppy using Windows Explorer and then copy the images directly
into your central content folder, as shown in Figure 3-6. Alternatively, you can use
the export function of the software included with the images to save the pictures as
JPEG images, as shown in Figure 3-7.
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Figure 3-6 Manually taking images off a picture CD using Windows Explorer.

Figure 3-7 Exporting an image from a picture CD.
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NOTENOTENOTENOTENOTE When you export images using the software included with the photos, you
will usually lose some image quality and/or resolution. This is fine most of the
time, but if quality is very important, take the original images off the CD using
Windows Explorer and manually resize them to the proper size for your Web
page using an image editor.

• Keep a close eye on the resolution and quality of the pictures exported. Typically the
highest resolution available is around 1536x1024, which is far too big for use on the
Web. However, it’s usually preferable to take the high-resolution image and manu-
ally resize it to a more appropriate size for your Web site, instead of initially exporting
a lower resolution image that might later turn out to be too small.

• Save images in the central content folder so that everyone working on the site can
find them.

• Give images a short but descriptive name so that it’s easy to tell what they are at a
glance.

Online Photo ServicesOnline Photo ServicesOnline Photo ServicesOnline Photo ServicesOnline Photo Services
Instead of paying to get your prints scanned and placed on a CD or floppy disk, many
photo labs and services now offer to scan photos and place them on a secure Web site,
from which you can then download them, as shown in Figure 3-8.
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Figure 3-8 A scanned roll of film at an online photo service.

The advantage of using an online photo service is the somewhat quicker turnaround
time when compared to picture CDs and disks. In most other aspects the process is
identical, except that instead of taking pictures off a CD or disk you download them
over the Internet. Of course, if your company or organization needs high-resolution
images and has a slow-speed Internet connection, this might not be the most effective
means of acquiring images. Instead, use picture CDs, or preferably, get a scanner or
digital camera.
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Here are some recommendations for using an online photo service more effectively:

• Download the highest resolution version of the image you might need, since the
higher resolution image may not be available later. In general, it’s best to download
a high-resolution image, make a copy of it, and then resize it for use on your Web
site.

• Depending on the processing company, you may need to convert the images you
download into JPEG (.jpg) images using their software before you can work with
the images on your Web site.

• Make sure to download the images you want to use promptly. Some services keep
images posted for only 30 days.

• Save images in the central content folder so that everyone working on the site can
find them.

• Give images a short but descriptive name so that it’s easy to tell what they are at a
glance.

DocumentsDocumentsDocumentsDocumentsDocuments
Documents are the other half of the new content equation, and, unfortunately, not every
document that belongs on your Web site is going to exist, or at least not in digital form.

Dealing with Print DocumentsDealing with Print DocumentsDealing with Print DocumentsDealing with Print DocumentsDealing with Print Documents
If you have content that would be good on your Web site, but you can’t find a digital
version of it, here’s a suggested course of action:

1. Look again.

We can’t emphasize enough how much easier it is to use content that’s already in
digital form than it is to bring a print document into the computer.

2. Retype the document.

Unless the document is really long, and even if it is, consider retyping any print
documents that you want to use on your site. This is especially true for documents
that have small typefaces, complex layouts or graphics, or are in poor condition. It’s
usually less hassle than scanning and performing Optical Character Recognition
(OCR), and many documents won’t need to be entirely retyped—just those sections
that are needed for your site.
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3. Scan the document and use an OCR program.

Although OCR programs have greatly improved and are now quite useful, unless you
have a long document that needs to be placed in its entirety on your Web site, it’s
usually faster to retype the document than it is to scan it, run it through the OCR
program, and then correct the mistakes.

NOTENOTENOTENOTENOTE OCR programs are standalone programs that convert a scanned document
into text that can be used in a word processing program or Web page edi-
tor. They can provide an easy way to digitize existing, typewritten content,
but they do produce errors in the scanned documents. We recommend that
you carefully evaluate the amount of time involved in correcting scanned
documents before relying heavily on OCR programs.

4. Save the document in the central content folder.

After finding, retyping, or scanning the content, save it in your central content folder
with a descriptive filename so that the file can be identified easily.

Creating New DocumentsCreating New DocumentsCreating New DocumentsCreating New DocumentsCreating New Documents
When creating new content for use on a Web site, you can take specific steps to make
the content import into Dreamweaver more elegantly:

• Create any large amounts of text you want to use on your site using Microsoft Word
or another word-processing program, and then either copy and past the text into your
Web pages, save it as a plain text file for importing into your pages, or save it directly
as an HTML document that Dreamweaver can then edit. Although Dreamweaver
is a passable text editor, it’s much easier and more efficient to create content of any
substantial length in a dedicated word processor.

• Avoid using complex formatting or graphics in documents. These are best created
later using Dreamweaver.

• Before creating a large amount of content with a particular application, test out how
well the content can be exported to HTML from the application and then imported
into Dreamweaver. Knowing the limitations of the process beforehand can save a lot
of time and money in the long run.

• Save new documents in the central content folder with useful filenames so that
everyone working on the site can identify them.
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Organizing YOrganizing YOrganizing YOrganizing YOrganizing Your Content and Planning Your Content and Planning Your Content and Planning Your Content and Planning Your Content and Planning Yourourourourour
WWWWWeb Siteeb Siteeb Siteeb Siteeb Site

Although it’s not strictly necessary to do any further organization and planning for your
Web site if you’re treating your site like a virtual bulletin board, it can be a big help in
the long run. By spending some time reviewing your content and outlining your site,
you can more easily create a logical and effective site.

Gathering all or most of your content together in one place is a good first step in planning
your Web site’s structure because it gives you an understanding of the content the site
will contain. After doing this, we recommend that you sit down and organize the content,
and then draw up a preliminary site plan.

Organizing YOrganizing YOrganizing YOrganizing YOrganizing Your Contentour Contentour Contentour Contentour Content
After you’ve rounded up the content for your Web site, it makes a lot of sense to or-
ganize it before starting work on the site—both physically in the central content folder
and logically for the structure of the Web site.

There are a number of different ways to arrange content in your central content folder.
One method that works well is to place content into folders depending on what action
needs to be done with it. For example, a high_priority folder could store important
content, or a possible_content folder could store content that you’re not yet sure be-
longs on the Web site. Within these folders you could further categorize the data by
subject, source, and data type (i.e., documents and images).

In addition to deciding how to physically organize your content, you might want to
work on some more abstract organization. One way to do this is to sit down with a pad
of paper and poke around the central content folder, making notes of what you have
available and creating some logical groupings. The organization you decide upon may
or may not be reflected in the folder structure of your central content folder. It’s more
important to get an idea of how the content should be logically organized on your site
than to actually separate it out into folders.

We can’t tell you exactly how to organize your content, since the material usually dic-
tates this, but here are some general recommendations:

• Look at the Web site’s purpose and the content that you identified as important in
“Step 1: Determine Your Web Site’s Goals” and keep this focus central in your mind.
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• Organize content logically and intuitively by subject. For example, a Web site de-
signed to advertise or sell products would do well to organize content into product
information, company information, and support information categories. This makes
sense and is intuitive for visitors, since these categories match key topics that visitors
will probably look for.

• Try not to organize your content in a way that leaves any categories with too much
content or too little. If you find this happening, consider splitting or merging the
categories, or creating subcategories.

Creating YCreating YCreating YCreating YCreating Your Site Planour Site Planour Site Planour Site Planour Site Plan
At this point you may want to actually sketch out the design for your Web site. Simple
as it sounds, this is one of the more important parts of the process, since the way in which
you structure the site determines how easy and intuitive it is for visitors to use.

To create a plan for your site, sit down with a pad of paper or create a new Word
document in Outline view. Pull out any notes you took on the content available for the
site, above and take out, the Web site goals that you wrote down in “Step 1: Determine
Your Web Site’s Goals.”

When creating the site plan, start with the home page—the page that is first displayed
when visiting a site. The home page acts as the top of the outline that is your Web site.
Briefly list what content should be contained here—perhaps a summary of the site, as
well as short leaders on the site’s most interesting or frequently accessed content. (For
more help with this, see the “Creating an Effective Home Page” section in “Step 6: Polish
Your Pages.”)

Then write down the categories for the next level of your site. Each of these categories
will be a page and a navigational link for your site if you make a navigation bar or set
of hyperlinks for your site (you’ll probably want to). As discussed above, the catego-
ries should be logical and intuitive to visitors. Also, the second-level headings (the first
level below the home page) should provide users with an accurate summary of the
content in your site.

TIPTIPTIPTIPTIP Allow room for additional pages and content when creating your site plan,
especially when creating your second-level headings (those right under the
home page). Redesigning a Web site to accommodate new content can be
resource intensive as well as inconvenient to visitors who have learned your
site layout or bookmarked individual pages in the site.
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Try to avoid making too many levels in your Web site. From the home page, the most
important content should be one click away, and all important content should ideally
be no more than three clicks away for most sites. (Larger sites may need to have addi-
tional levels, but avoid it if possible.) Keeping information accessible with a low number
of clicks makes accessing information faster and easier for visitors. It also increases the
chance that visitors will stay at your site rather than get impatient and leave.

Besides watching out for a Web site structure that’s too deep, you also need to avoid
making the structure too wide (too many pages at the same level). This is especially true
for the second level of pages (the first under the home page). Too many second-level
pages will overload the site’s navigation bars with too many options. Although there are
no rules about how many links are too many, navigation bars (and Web pages) lose their
effectiveness if there are too many options to choose from. In general, limit your navi-
gation bars to fewer than ten links, and possibly no more than five, depending on your
page design.

While not absolutely necessary, we recommend taking at least a quick pass through your
entire site at this stage, creating a diagram of what pages should be created and what
content belongs on each page. Creating this site plan will not only make your Web site
more coherent, intuitive, and effective but also make it easier to delegate work.

SummarySummarySummarySummarySummary
This step walked you through the last phase of Web site planning—collecting, creat-
ing, and organizing your content—before you start the work of creating pages. This step
involves preparing a directory to store all content before it’s added to the site, collect-
ing existing digital content, creating new digital content, organizing the content, and
then creating a plan for your Web site’s structure.
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Step 4

CREACREACREACREACREATE YOUR SITETE YOUR SITETE YOUR SITETE YOUR SITETE YOUR SITE

Featuring:Featuring:Featuring:Featuring:Featuring:
• Defining a New Local Site

• Configuring Dreamweaver to Work with a Firewall

• Overview of the Site Window

• Creating the Initial Structure

• Coordinating Work with Multiple Users

When you’re ready to start construction on your Web site, you use Dreamweaver’s
Site window to create your site. “Step 4: Create Your Site” shows you how to

set up your site in Dreamweaver, as well as how to create and link pages together in the
Site window to mimic the site design you worked out in “Step 3: Collect and Orga-
nize Your Content.” You’ll also learn the basics of working with remote sites (Web
servers) and allowing multiple users to edit your site.

Defining a New Local SiteDefining a New Local SiteDefining a New Local SiteDefining a New Local SiteDefining a New Local Site
The first thing you need to do when actually creating your Web site is to create or open
your local Dreamweaver Web site. The local version of your Web site, also called the
local root folder, is stored in a folder on your hard drive or company network. You
perform all your work on the local site, and after testing for errors, you transfer the files
to your Web hosting company’s Web server, which then makes the site accessible to
everyone on the Internet.
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Although you can use Dreamweaver just to create pages, using Dreamweaver also to
manage your site saves you a lot of time, while providing additional functionality and
decreasing errors in your site, such as broken hyperlinks.

TIPTIPTIPTIPTIP You can change the information in your site definition anytime after creat-
ing it—just choose the Site menu’s Define Sites command, select your site, and
click the Edit button.

To define a new site, follow these steps:

1. Start Dreamweaver.

Click the Start button, click Programs, click Macromedia Dreamweaver 4, and then
click Dreamweaver 4.

2. Create a new site.

To do this, choose the Site menu’s New Site command.

3. Enter the local site information.

Enter a descriptive name for your Web site in the Site Name box, as shown in
Figure 4-1. In the Local Root Folder box, enter the path to the folder in which you
want to store your local Web site, or click the folder icon to locate or create the folder.
(You can also open an existing Web site you’ve created.) In the HTTP Address box,
enter the domain name you acquired for your Web site. Leave the Refresh Local File
List Automatically and the Cache check boxes selected.

Figure 4-1 Creating a new Web site.
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4. Specify the type of Web server.

Select the Remote Info item in the Category list to enter information about your
Web server, as shown in Figure 4-2. In the Access box, select FTP, or WebDAV if
your Web server supports this protocol. (If you select WebDAV, click the Settings
button that appears to enter the server settings.) To publish to a company intranet
or a local Web server, select Local/Network from the Access box and then enter the
path to the remote network folder or Web server in the Remote Folder box that
appears.

Figure 4-2 Entering the information about your remote Web server.

5. Enter the FTP information.

In the FTP Host box, enter the FTP hostname given to you by your ISP, for ex-
ample, ftp.mycompany.com (leave out the ftp://). Enter your Web site username and
password in the Login and Password boxes, and select the Save check box to save this
information. If your company or organization uses a network firewall, see the next
section. Leave the Host Directory box blank, and check with your ISP if you have
trouble with publishing to the wrong directory.

6. Enable File Check In and Check Out.

To set up your site so that multiple people can edit it simultaneously, leave the En-
able File Check In And Check Out check box and the Check Out Files When
Opening check box selected. Also be sure to enter the name and e-mail address you
want others to see associated with files you check out in the Check Out Name box.
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7. Specify a home page.

Select Site Map Layout in the Category list, and then enter a filename for your home
page in the Home Page box, as shown in Figure 4-3. We recommend entering
index.htm. Optionally, click the Page Titles option button to display the page titles
of pages in your site map instead of filenames. Click OK when you’re finished. Click
OK if Dreamweaver asks whether you’d like to create the index.htm file. Dreamweaver
then creates your local site and displays it in the Site window, which we discuss later.

Figure 4-3 Specifying the home page for your Web site.

Configuring Dreamweaver to WConfiguring Dreamweaver to WConfiguring Dreamweaver to WConfiguring Dreamweaver to WConfiguring Dreamweaver to Work with aork with aork with aork with aork with a
FirewallFirewallFirewallFirewallFirewall

If your company network is protected by a firewall and you can’t access your remote
site using Dreamweaver, you’ll probably have to configure Dreamweaver to find your
firewall host or proxy server.

Make sure that you know your firewall settings before you follow this procedure. If you
don’t know the address of your firewall host, either ask someone who does or check
Microsoft Windows Internet Options. To do this, click the Internet Options icon in
Windows Control Panel, click the Connections tab, click the LAN Settings button,
and then look for an address entered in the Proxy Server box.
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To configure Dreamweaver to work with a firewall, follow these steps:

1. Open the Preferences dialog box.

Choose the Edit menu’s Preferences command, and then select Site in the Category
list, as shown in Figure 4-4.

Figure 4-4 Specifying the Firewall Host and Port.

TIPTIPTIPTIPTIP If you have everything configured correctly but you have problems with your
FTP connection timing out, increase the number in the FTP Time Out box.
Don’t increase the timeout duration to more than 120 seconds though, or
you’ll be forced to wait excessively when the FTP server can’t be reached.

2. Specify your firewall or proxy server.

In the Firewall Host box, enter the address of your firewall or proxy server. In the
Firewall Port box, enter the port on which access is allowed. (This is most likely 21,
but check your firewall if this doesn’t work.) Click OK.
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3. Configure your site to use a firewall.

Choose the Site menu’s Define Sites command, select your site from the list, and then
click the Edit button. Select Web Server Info in the Category list, and then select
the Use Firewall check box, as shown in Figure 4-5. Click OK.

Figure 4-5 Enabling a site to work with a firewall.

Opening Local SitesOpening Local SitesOpening Local SitesOpening Local SitesOpening Local Sites
When you launch Dreamweaver, it automatically opens the last site you worked on,
allowing you to get started quickly. However, if you have multiple sites, you’ll need to
be able to switch between these sites.

To open a local site, select the site from the Site window’s drop-down list box, as shown
in Figure 4-6, or choose the Site menu’s Open Site command, and then select the site
you want to open from the submenu.



Step 4Step 4Step 4Step 4Step 4    Create Your Site 7171717171

Figure 4-6 Switching sites in the Dreamweaver Site window.

Overview of the Site WindowOverview of the Site WindowOverview of the Site WindowOverview of the Site WindowOverview of the Site Window
Before we go much farther, it helps to be more comfortable with the Dreamweaver Site
window interface. At the top of the window, as shown in Figure 4-7, is a familiar-
looking menu bar—where the File, Edit, View, Site, Window, and Help menus are
located. Immediately below this is the site management toolbar, where the most fre-
quently accessed site management commands are located.
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Figure 4-7 The Dreamweaver Site window.

Below the menu bar and toolbar is the main portion of the Dreamweaver Site window.
The default view shows the contents of your local folder (the local copy of your Web
site) on the right and the contents of your remote site (your actual Internet Web site)
on the left, when you connect to it. The window looks and acts similar to Windows
Explorer or the Macintosh Finder. At the bottom of the window is the status bar, which
shows you the status of file transfers or the properties of the currently selected file.

TIPTIPTIPTIPTIP You can hide the left pane (which displays either the remote site or the site
map) by clicking the small triangle on the far left side of the status bar. Click
it again to restore the pane.

The following list describes some of the tasks you can do in the Site window:

• To connect to your Internet Web site, click the Connect toolbar button.

• To sort your files by name, click the Local Folder heading.

• To sort files by Size, Type, or some other field, click the corresponding heading in
the Local Folder (or Remote Site) pane.
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• To open a page, double-click it. (This works in all panes: the Local Folder, Remote
Site, and Site Map.)

• To switch between viewing your site files and viewing a visual map of your Web site,
as shown in Figure 4-8, use the Site Files and Site Map buttons on the left of the
toolbar.

Figure 4-8 The Dreamweaver Site window in Site Map view.

The rest of the Site window is covered in the following sections.

Creating the Initial StructureCreating the Initial StructureCreating the Initial StructureCreating the Initial StructureCreating the Initial Structure
If you’re building a Web site from scratch, it’s a good idea to create the site’s structure
before you do anything else. Since Dreamweaver functions best when you save Web
pages before editing them, creating all or most of your pages in the Site window makes
the actual editing process work smoother. You can also link the pages together in the
Site window to form a coherent Site Map and automatically insert the proper hyperlinks
into the empty pages.

The following sections explain how to accomplish this task.
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TIPTIPTIPTIPTIP You’ll probably want to move and rename files in Dreamweaver to minimize
the chance that hyperlinks are broken. If you move or rename a file using
Dreamweaver, hyperlinks to that file are automatically updated.

Adding New Pages and FoldersAdding New Pages and FoldersAdding New Pages and FoldersAdding New Pages and FoldersAdding New Pages and Folders
To add a new Web page or folder to your site, right-click the folder in the Local Folder
pane to which you would like to add a page or folder and then choose New File or New
Folder from the shortcut menu. This creates a new file or folder in the Local Folder pane.
Enter the name you want to assign to the file or folder, and then click anywhere else
onscreen to save the name.

To add a new page that is pre-linked to an existing page (a great way to quickly build
the structure of your site), follow these steps:

1. Click the Site Map toolbar button.

2. Create the new file.

Right-click the page in the Site Map pane that you want to link to a new file, and
then choose Link To New File from the shortcut menu, as shown in Figure 4-9.

Figure 4-9 Creating a new page already linked to an existing page.
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3. Name the file.

In the Link To New File dialog box, as shown in Figure 4-10, enter a filename for
the page. In the Title box, enter a title for the page, and in the Text Of Link box,
enter the text you want to appear as the hyperlink in the original page (the page that
links to the page you’re creating). Click OK to create the page.

Figure 4-10 Naming the newly created page.

NOTENOTENOTENOTENOTE The only page that works as a home page on most Web servers is index.htm
or index.html.

Managing Hyperlinks with the Site MapManaging Hyperlinks with the Site MapManaging Hyperlinks with the Site MapManaging Hyperlinks with the Site MapManaging Hyperlinks with the Site Map
The Site Map is an invaluable tool for creating your site’s initial structure. You can use
it to get a quick overview of your site’s structure, and to manage the links between your
pages.

Use the following list which describes how to work with hyperlinks and the Site Map:

• To select multiple pages in the Site Map, click and drag an outline around the pages
you want to select, or hold down the Ctrl key and click the pages you want to se-
lect. (The latter method also works in the Local Folder pane.)

• To create a new hyperlink between files, select the page you want to create the link
in, and drag the round icon beside the file in the Site Map onto another page or file,
as shown in Figure 4-11. This works well when the local folder is displayed next to
the Site Map.
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Figure 4-11 Creating a link to an existing file.

NOTENOTENOTENOTENOTE If you’re using Dreamweaver’s Check In/Out feature, you’ll need to check out
a file in order to create a hyperlink in it. In other words, check out the file in
which you’re creating a link, not the file to which you’re linking.

• To remove a hyperlink, right-click the target of the link (the page that the link points
to) and choose Remove Link from the shortcut menu.

• To change a hyperlink, right-click the target of the link, choose Change Link from
the shortcut menu, and select a different page from the Select HTML File dialog
box, as shown in Figure 4-12.
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Figure 4-12 Modifying an existing link.

NOTENOTENOTENOTENOTE The URL listed in the URL box of the Select HTML File dialog box isn’t the current
link, it’s just a generic link that usually connects to your Windows desktop.
When you select a page, Dreamweaver fills in the URL box, either in document
relative format or as site-root relative format (if you select Site-Root from the
Relative To box, which we don’t recommend). For more information on rela-
tive addressing, see “Appendix C: Hyperlinks in Dreamweaver.”

• To hide (but not delete) a link, right-click the page or file that you don’t want to appear
in the Site Map and choose Show/Hide Link from the shortcut menu. To redisplay
the page, choose the View menu’s Show Files Marked As Hidden command. (You
can also select Show Dependent Files if you want to see images and other dependent
files in the Site Map.) Hidden files appear in italics when Show Files Marked As
Hidden is selected, as shown in Figure 4-13.
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Figure 4-13 Hiding links in the Site Map.

NOTENOTENOTENOTENOTE Pages that are “lost” (the links to them are broken) appear in red, while
external links (links to pages outside your local site) appear in blue and have
a small globe icon next to them.

• To save the Site Map as an image, display the Site Map the way you want it and then
choose the File menu’s Save Site Map command. In the Save Site Map dialog box,
choose where to save the file, enter a name for the image, and choose to save it either
as a bitmap file (.bmp) or as a PNG file (.png). Figure 4-14 shows an actual Site
Map saved this way and placed directly into this book.
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Figure 4-14 A Site Map image.

TIPTIPTIPTIPTIP Consider selecting the View menu’s Show Page Titles command if you’re
saving the Site Map as an image—this labels each page in the map by the
page’s title instead of its filename.

Changing the Site Map DisplayChanging the Site Map DisplayChanging the Site Map DisplayChanging the Site Map DisplayChanging the Site Map Display
The Site Map is a valuable tool, but it usually requires a bit of modification to suit
your needs:

• To resize the Site Map display, click 100% on the status bar and select the ap-
propriate display size.

• To display your Local Folder as well as the Site Map, drag the bar at the right
side of the window to the left, revealing the Local Folder pane.

• Click a plus sign next to a page to view the pages it links to, or click a minus sign
to hide the pages.

• To view a page as the root of the Site Map (the topmost page displayed), right-
click the page and choose View As Root from the shortcut menu. This hides all
pages above the selected page, as shown below. To get back to the parent page
(the page that links to the page you temporarily designated to be the root of the
Site Map), click the parent page’s name in the Site Navigation pane right un-
derneath the toolbar.
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• To switch the Site Map display from showing filenames to showing page titles,
choose the View menu’s Show Page Titles command from the View menu.

Managing FilesManaging FilesManaging FilesManaging FilesManaging Files
Performing common file management tasks in Dreamweaver’s Site window is easy; the
following list describes how to move, copy, rename, and delete files:

• To move a file to another folder, click the file in the Local Folder pane and drag it
to the desired folder.

• To copy a file, select the file and press Ctrl-C. Then navigate to the folder in which
you want to place a copy and press Ctrl-V.

TIPTIPTIPTIPTIP These keyboard shortcuts—Ctrl-C for copy and Ctrl-V for paste—work in
every part of Windows and any Windows application, so you can use them
to copy and paste files, text, or images anywhere.
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• To rename a file, select a file in the Folder list, wait a moment (maybe a second), and
then click it again. The filename is highlighted, and you can then type in a new
filename or edit the existing one, as shown in Figure 4-15. Alternatively, choose the
File menu’s Rename command.

Figure 4-15 Renaming a file.

WWWWWARNINGARNINGARNINGARNINGARNING Don’t change the file’s three-letter extension or you won’t be able to view
the file or use it properly.

• To delete a file or folder, right-click it and choose Delete from the shortcut menu,
as shown in Figure 4-16. Alternatively, select the file or folder, and press the Delete
key.
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Figure 4-16 Deleting a file.

TIPTIPTIPTIPTIP If you delete a file in Dreamweaver, you can retrieve it from the Recycle Bin,
unlike in Microsoft FrontPage where files are permanently deleted.

Coordinating WCoordinating WCoordinating WCoordinating WCoordinating Work with Multiple Usersork with Multiple Usersork with Multiple Usersork with Multiple Usersork with Multiple Users
Dreamweaver comes with a couple of features that make it easier to work with others
to construct and maintain a Web site. The Design Notes feature provides a way of
annotating files and assigning statuses to the files. Dreamweaver also has the ability to
keep track of which files are currently being edited and restricting access to these files.

The following sections detail how to work with Design Notes, how to check out files
for editing, and how to set up Dreamweaver so that changes you or others make to your
site remain private until you’re ready to make them publicly available.
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TIPTIPTIPTIPTIP You can run a report that details which pages are checked out by whom and
which pages have Design Notes associated with them. To do so, choose the
Site menu’s Reports command, select Entire Local Site from the Report On
drop-down list box, and select the Checked Out By and Design Notes check
boxes in the Workflow category.

Adding Design Notes to FilesAdding Design Notes to FilesAdding Design Notes to FilesAdding Design Notes to FilesAdding Design Notes to Files
Design Notes is a useful feature that allows you and your collaborators to store notes
about files in Dreamweaver. Using Design Notes, you can share the status of the file
and any other notes with all authors of your Web site.

TIPTIPTIPTIPTIP You can add Design Notes to any kind of file in Dreamweaver. Additionally,
Macromedia Fireworks supports Dreamweaver-compatible Design Notes so
that users of Fireworks can work seamlessly in both applications, making it
easy to share information with any graphic designers you may employ.

To use Design Notes, follow these steps:

1. Open the Design Notes dialog box.

Right-click the file to which you want to add Design Notes, and then choose Design
Notes from the shortcut menu.

2. Specify the status and enter notes.

Choose a status for the file from the Status drop-down list box, and enter any notes
about the file in the Notes box, as shown in Figure 4-17.

Figure 4-17 Entering Design Notes information.
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3. Specify when to display the Design Notes.

Select the Show When File Is Opened check box to automatically display the Design
Note when this particular file is opened.

4. Add optional fields.

To add custom fields, click the All Info tab, as shown in Figure 4-18. Click the plus
sign button to create a new field, enter a name for the field (such as Author), and
then enter a value for the field (such as your name). To remove a field, select it and
click the minus sign button. Click OK when you’re finished entering information
in the Design Note.

Figure 4-18 Creating a custom field in a Design Note.

NOTENOTENOTENOTENOTE You should have the Maintain Design Notes and Upload Design Notes For
Sharing check boxes selected in the Design Notes category of your site’s Site
Definition. These are enabled by default.

Checking Files In and OutChecking Files In and OutChecking Files In and OutChecking Files In and OutChecking Files In and Out
Dreamweaver provides a Check In/Out feature so that you can check out individual files
to a particular user. During the time that the file is checked out, it is unavailable for
editing by other users. This feature prevents the loss of data from a situation in which
two users try to edit the same file at the same time.
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If you enabled the Check In/Out feature when you created your site definition in
Dreamweaver (see the earlier section “Defining a New Local Site”), it’s simple to check
files in and out. The following points will help you to use this convenient feature:

• Before you can check out files, you need to publish your local folder to your Remote
Site. For more information on uploading your files, see “Step 7: Deploy Your Web
Site.”

• To check out a file, right-click the file in the Folder List pane and choose Check Out
from the shortcut menu, or open the file by double-clicking it. This prevents other
users from editing the file until you check it back in. To prevent other users from
modifying associated files (such as embedded images) while you have the file checked
out, click Yes when asked whether you want to check out dependent files.

• Files you check out have a green checkmark next to them.

• Files others check out have a red checkmark next to them. Move your mouse over the
file to see the name of the user who checked out the file displayed in the status bar.

• You can open files checked out by other users, but you can’t save them using the same
filename.

• If you try to check out a file already checked out by another user, Dreamweaver asks
whether you want to override the check-out. Obviously, this is something you do only
when absolutely necessary.

• To check in a file, right-click a checked-out file (one with a green checkmark next
to it) and choose Check In from the shortcut menu, as shown in Figure 4-19. The
check-in step saves your changes and allows others to then edit the file.

• To check in a file without saving your changes, right-click a checked-out file and choose
Undo Check Out from the shortcut menu.
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Figure 4-19 Checking in a file.

TIPTIPTIPTIPTIP You must first connect to your remote site before you can check files in or out.

Keeping WKeeping WKeeping WKeeping WKeeping Web Site Web Site Web Site Web Site Web Site Work Private Until York Private Until York Private Until York Private Until York Private Until You Publishou Publishou Publishou Publishou Publish
Dreamweaver’s Check In/Out feature is valuable, but it works only if each user maintains
a separate local folder and synchronizes all changes at the Remote Site. This approach
works fine if your company or organization doesn’t mind creating its Web site directly
on your Internet Web site (instead of constructing it locally, testing it, and then posting
it to the Internet). Unfortunately, if you need to manage the work of multiple people on
the site and keep the site private until you’re ready, this approach is inadequate.

Fortunately, there is a workaround—you can create a remote site that sits on your local
network and then have everyone use this site as his or her remote site instead of using your
actual Internet Web site.

To set up Dreamweaver to keep your work private until you’re ready to make it public,
use the following steps:
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1. Set up each user with a unique local folder.

Install a separate copy of Dreamweaver for each user, and configure each to use a
different local folder (users can’t share local folders).

2. Set up all site definitions to use the same local network location as the remote site.

In the Site Definition dialog box for each user’s copy of Dreamweaver, click select
the Remote Info item in the Category list, and choose Local/Network from the Access
drop-down list box., and then in the Remote Folder box, specify a folder on your
network to use as the central publishing location, as shown in Figure 4-20. All users
will synchronize their changes with the same remote site, thus maintaining privacy
while ensuring that no changes are lost.

Figure 4-20 Configuring a locally stored remote site.

3. Set up a site definition for publishing your site to the Internet.

Set up a site definition on one computer (most likely on the computer belonging to
whoever is in charge of the Web site) with the folder used in step 2 as the local folder,
as shown in Figure 4-21. Enter your actual Internet Web site’s address in the Re-
mote Info section of the Site Definition, as you would normally (see “Defining a New
Local Site” in “Step 4: Create Your Site”).
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Figure 4-21 The configuration for the site definition used to publish to the Internet.

To publish your work to the Internet, use this site definition, but to do any edit-
ing, you should switch back to the other site definition (which is set up to do all pub-
lishing to the locally stored remote site instead of your Internet Web site).

NOTENOTENOTENOTENOTE Although this pseudo–remote site can be located anywhere on your local
network, if you create it on an actual Web server, you can preview your pages
better before publishing them to your Internet Web site.

SummarySummarySummarySummarySummary
The first step in creating your Web site is to define the site in Dreamweaver and cre-
ate an initial site structure. This involves creating new Web pages and linking them
together. Dreamweaver makes this easy by providing a Site Map feature that allows you
to see the organization of your Web pages. Dreamweaver also lets you coordinate the
work of multiple authors on your Web site by using Design Notes and Dreamweaver’s
Check In/Out feature.
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Step 5

CREACREACREACREACREATE YOUR PAGESTE YOUR PAGESTE YOUR PAGESTE YOUR PAGESTE YOUR PAGES

Featuring:Featuring:Featuring:Featuring:Featuring:
• Overview of the Dreamweaver Interface

• Opening, Creating, and Saving Pages

• Working with Text and Hyperlinks

• Working with Images

Web sites are made up of individual Web pages, and creating these pages is what
comprises the bulk of Web site construction. “Step 5: Create Your Pages” in-

troduces the Dreamweaver interface and then shows you how to add text and images
to your Web pages, create hyperlinks, and modify Web page properties.

Overview of the Dreamweaver InterfaceOverview of the Dreamweaver InterfaceOverview of the Dreamweaver InterfaceOverview of the Dreamweaver InterfaceOverview of the Dreamweaver Interface
The Dreamweaver program has two main windows: the Site window and the Docu-
ment window. “Step 4: Create Your Site” introduced the Site window, where you can
manage all aspects of your local and remote sites. Now we take a look at the Document
window, as shown in Figure 5-1.
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Figure 5-1 The Dreamweaver Document window.

Dreamweaver is a so-called WYSIWYG (What You See Is What You Get) Web page
editor. This means that when you create a Web page in Dreamweaver, the way the content
appears in the Document window is almost identical to how it will look in a Web browser.

The following sections detail the essentials of using the Document window’s menus,
toolbar, the unique Tag selector, the status bar, and various floating palettes. Because
Dreamweaver’s interface is significantly different from most other business software
applications, we strongly recommend that you review the following sections to get a
better feel for how to use Dreamweaver.

NOTENOTENOTENOTENOTE The interface of Dreamweaver 4 matches that of other current Macromedia
products such as Fireworks, Flash, and Director. If you’re familiar with any of
these programs, you’ll feel comfortable with Dreamweaver 4 right away.
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Introducing Dreamweaver’Introducing Dreamweaver’Introducing Dreamweaver’Introducing Dreamweaver’Introducing Dreamweaver’s Menuss Menuss Menuss Menuss Menus
Dreamweaver makes heavy use of its menus—more so than most other modern programs
you’re likely to use. Because of this, and the fact that Dreamweaver’s menus are differ-
ent from those other programs, we briefly describe them here:

• The File and Edit menus are similar to those in any Microsoft Windows program—
use them to open and save pages, undo actions, copy and paste objects, and locate
text in your pages.

• The View menu controls what kinds of content Dreamweaver displays within the
Web pages you work in and other aspects of the Web-page-creation process—for
example, you can toggle background grids and rulers here.

• The Insert menu provides a comprehensive list of objects that you can insert on your
Web page.

• The Modify menu is similar to other programs’ Format menu—use it to alter the
properties of any object in your Web page (or use the Property inspector).

• The Text menu is concerned with everything having to do with text on your Web
pages (except for hyperlinks, which are best modified using the Property inspector).

• The Commands menu contains specially created commands that extend the capa-
bilities of Dreamweaver, such as the Clean Up Word HTML and Optimize Image
In Fireworks (which requires Macromedia Fireworks) commands. You can also easily
create your own commands using the History palette or download new commands
from the Dreamweaver Exchange Web site (choose the Help menu’s Dreamweaver
Exchange command).

• The Site menu contains commands that you can use to work with your Web site.
For more information on managing your Web site, see “Step 4: Create Your Site” and
“Step 7: Deploy Your Web Site.”

• The Window menu differs from most typical Window menus—besides allowing
you to switch between open pages, the Window menu is where you turn on or off
all floating palettes (which are discussed later).

• The Help menu offers access to the Help system, three reference books, and
Dreamweaver-related Web sites. Several useful animated tutorials are also available
in Dreamweaver’s Help system to assist you with different parts of Dreamweaver.
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The TThe TThe TThe TThe Toolbaroolbaroolbaroolbaroolbar
Dreamweaver 4 now includes a small toolbar that you can use to change the Document
window view, change a Web page’s title, and access several useful settings, as described
below:

• Use the Code View and Design View buttons to choose between working directly
with the HTML code for your page or working in strict WYSIWYG Design view.

• Use the Show Code And Design View button to display a split screen view of your
page—displaying both the HTML code and Dreamweaver’s standard Design view,
as shown in Figure 5-2. This is an easy way to learn how HTML code works.

Figure 5-2 Displaying a Web page in the split-screen Code view.

• Use the Title box to enter a title for your Web page.

• Use the Preview/Debug In Browser button to preview the current page in a Web
browser.

• Use the View Options button to control visual aids, such as rulers and grids.
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The TThe TThe TThe TThe Tag Selectorag Selectorag Selectorag Selectorag Selector
The Tag selector, located on the left side of the status bar, as shown in Figure 5-3, is
an extremely useful tool for making selections in a Web page quickly and precisely.

Figure 5-3 Selecting a paragraph using the Tag selector.

The following list describes Tag selector functions:

• Click a tag to select all the content within that tag. (If you’re unfamiliar with tags
and how they work, see “Appendix B: An Introduction to HTML.”)

• Place the cursor anywhere in a Dreamweaver Web page to display in the Tag selec-
tor the HTML tags associated with the current cursor location. The tags are displayed
left to right, ranging from general to specific.

• When you click a tag, Dreamweaver immediately selects everything on the page
within that particular tag. For example, clicking <body> would select the entire page,
while clicking <h1> would select only the particular heading where the cursor is
located. Tags are hierarchical; consequently other headings aren’t selected because
Dreamweaver treats them as if they are in a different branch of the tree.

The Rest of the Status BarThe Rest of the Status BarThe Rest of the Status BarThe Rest of the Status BarThe Rest of the Status Bar
The status bar in the Dreamweaver Document window contains a number of other
useful functions in addition to the Tag selector, as described below:

• The current size of the Document window is displayed to the right of the Tag se-
lector, which is helpful when trying to target your Web pages to different screen
resolutions (see “Step 6: Polish Your Pages”).
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• To select a window size that matches a typical screen resolution, click the Window
Size display. Choose the screen resolution you want from the pop-up menu, as shown
in Figure 5-4. Dreamweaver resizes your window to match the selected size.

Figure 5-4 Resizing the Document window to match visitors’ screen sizes better.

NOTENOTENOTENOTENOTE Dreamweaver adjusts its window size to match the typical viewable area that
visitors will have in their Web browsers when viewing your page. For example,
if a visitor has her monitor set to 800x600 resolution and her Web browser
window is maximized (filling the screen), typically only a 760x420 resolution
will be available for viewing pages, after accounting for the Web browser’s
menu bar, status bar, and toolbars.

• The current size of the open Web page is displayed to the right of the window size
display along with the estimated amount of time required to download the page
using a 28.8Kbps modem. In general, no Web page you create should take longer
than 30 seconds to download over a 28.8Kbps modem. Keep an eye on this indi-
cator while you make your Web pages, and if they get too big, delete some images
or reduce the size of the images.
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TIPTIPTIPTIPTIP To change the display to show a different connection speed, choose the Edit
menu’s Preferences command, select Status Bar from the Category list in the
Preferences dialog box, and then select a speed from the Connection Speed
box. To create your own download speed—such as 42Kbps, a typical speed
for most 56Kbps modem connections—enter the speed directly in the Con-
nection Speed box.

• On the far right side of the status bar is a series of buttons that open the various
Dreamweaver floating palettes. Table 5-1 shows the buttons as they appear from left
to right and describes which palette or interface element they display. Each palette
is discussed in more detail in the following sections.

BUTTONBUTTONBUTTONBUTTONBUTTON BUTTON NAMEBUTTON NAMEBUTTON NAMEBUTTON NAMEBUTTON NAME DESCRIPTIONDESCRIPTIONDESCRIPTIONDESCRIPTIONDESCRIPTION

Show Site Opens the Site window.

Show Assets Displays the Assets floating palette.

Show HTML Styles Displays the HTML Styles floating palette.

Show CSS Styles Displays the CSS Styles floating palette.

Show Behaviors Displays the Show Behaviors floating palette.

Show History Displays the Show History floating palette.

Show HTML Source Displays the HTML source editor.

Table 5-1 The palettes available from the status bar.

Floating PalettesFloating PalettesFloating PalettesFloating PalettesFloating Palettes
Floating palettes are the heart of the Dreamweaver Document window. You use float-
ing palettes to insert images, position elements using layers or tables, reuse chunks of
text or images throughout your Web site, selectively undo or redo actions, and change
the properties of items on your pages.

We discuss individual palettes throughout this book as they apply to the task at hand;
to use palettes, refer to the following list:

• To display a palette, either click its button on the status bar or select it from the
Window menu.

• To move a palette, click the blue title bar of the palette and drag it to a new position.
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• To resize a palette, move the cursor over an edge until it turns into a dual-sided arrow
and then drag the edge out or in.

• To close a palette, click the small X in the corner of the palette.

• To remove tabs from a floating palette, drag them out of the palette and then close
the new palette that is created.

• To combine palettes, open both palettes and then drag the tab you want into the
palette that you want to keep. Click the tab that you want to work with to display
it within the single floating palette. Figure 5-5 shows a palette created by adding
the History and Layers tabs to the Reference and Assets floating palette.

Figure 5-5 Combining floating palettes to suit your work style.

Opening, Creating, and Saving PagesOpening, Creating, and Saving PagesOpening, Creating, and Saving PagesOpening, Creating, and Saving PagesOpening, Creating, and Saving Pages
The basics of working with files in Dreamweaver’s Document window are much the same
as working with files in any other Windows program. Opening pages, creating new pages,
and saving pages all work as you expect them to, so you might be tempted to skip this
section. Don’t. At the very least, read the information on saving Web pages.

Opening, Closing and Creating New PagesOpening, Closing and Creating New PagesOpening, Closing and Creating New PagesOpening, Closing and Creating New PagesOpening, Closing and Creating New Pages
You open and close Web pages in Dreamweaver in the same way that you open and close
a file in any other Windows program.
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• To open a Web page, choose the File menu’s Open command. When Dreamweaver
displays the Open dialog box, as shown in Figure 5-6, select the folder containing
the Web page from the Look In drop-down list box. When you find the Web page
you want to open, select it and then click Open.

Figure 5-6 Using the File menu’s Open command to open a Web page.

TIPTIPTIPTIPTIP You can also open a file by double-clicking its icon in the Site window.

• To close a Web page, click the Close button on the page’s title bar or choose the File
menu’s Close command.

• To create a new page, choose the File menu’s New command. After creating a new
page, it appears open in Dreamweaver ready for you to add your content.

• To create a new Web page from a template that you’ve developed (as described in
“Step 6: Polish Your Pages”), choose the File menu’s New From Template command.
In the Select Template dialog box, shown in Figure 5-7, select the local site that con-
tains the template, select the template, and then click Select.

Figure 5-7 Creating a new Web page from a previously created template.
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Saving WSaving WSaving WSaving WSaving Web Pageseb Pageseb Pageseb Pageseb Pages
As soon as you create a Web page in Dreamweaver—before you even add content to
it, you should save it. Many Dreamweaver features will work only after you’ve saved the
page. Additionally, after saving a page, you can postpone adding content if you like.

To save your Web page, first enter a title for the page in the Title box on the toolbar
and then choose the File menu’s Save As command. Select the folder you want to use,
and enter the name of your file in the File Name text box, as shown in Figure 5-8. Click
the Save button when you’re finished.

Figure 5-8 Using the Save As dialog box to save your Web pages.

TIPTIPTIPTIPTIP Even though Dreamweaver will let you create a Web page with spaces or
uppercase letters in its filename, don’t use them. Filenames with spaces or
uppercase letters may never cause problems if you stick with a Web hosting
company that uses Windows 2000 or Windows NT Web servers, but if you
move to a Unix-based Web server at some point, you could end up in big
trouble. Unix handles spaces and capitalization much differently from Win-
dows, and this minor naming difference could cause your entire Web site to
break.
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Previewing WPreviewing WPreviewing WPreviewing WPreviewing Web Pageseb Pageseb Pageseb Pageseb Pages
Generally, the Web pages you create in Dreamweaver will display in a Web browser
almost identically as they do in Dreamweaver, but it is important to frequently double-
check this, especially since different Web browsers do display pages a bit differently.

To preview a page in a Web browser, click the Preview In Browser toolbar button and
then select a browser from the pop-up menu. This opens a new browser window with
your page displayed in it.

TIPTIPTIPTIPTIP To add browsers to the list of browsers with which you can preview pages,
choose the Edit Browser List command from the pop-up menu and then click
the plus sign to locate an additional browser.

WWWWWorking with Torking with Torking with Torking with Torking with Text and Hyperlinksext and Hyperlinksext and Hyperlinksext and Hyperlinksext and Hyperlinks
Text is still the heart of most good Web pages, providing a clear and concise means of
communicating to your visitors. Web pages that consist largely of text download quickly
and search engines can index their content easily. (Images don’t index well in search
engines.)

Importing TImporting TImporting TImporting TImporting Textextextextext
Having text that you can import directly into Dreamweaver rather than having to retype
it is the ideal situation. Dreamweaver provides support for importing text saved in the
HTML file format or as plain text. Dreamweaver also provides special support for
importing tables and HTML files created using Microsoft Word.

Importing HTML FilesImporting HTML FilesImporting HTML FilesImporting HTML FilesImporting HTML Files
The best way to import text into Dreamweaver is to first save it as an HTML file using
whatever program you created it in, and then open this file in Dreamweaver and move
the text into the Web page where you want to place it. To do so, follow these steps:

1. Choose the File menu’s Open command.

This displays the Open dialog box, as shown in Figure 5-9.
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Figure 5-9 Opening an HTML file.

2. Locate your central content folder.

Select the drive where your central content folder is located from the Look In drop-
down list box. Navigate to your central content folder by double-clicking folders to
open them. When you find it, double-click it to view the contents of the folder. (If
the file is located elsewhere, open the appropriate folder.)

3. Choose the file type you’re looking for.

Select the type of file you want to import from the Files Of Type drop-down list
box, or select All Documents from this box if you’re unsure.

4. Select the file you want to import, and click Open.

Dreamweaver opens the file in a new Document window, as shown in Figure 5-10.

Figure 5-10 Opening an HTML file in Dreamweaver.
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5. Work with the text.

Edit the page as you would any other Web page. To place the text in a different Web
page, select the text, press Ctrl-C to copy it, open the page in which you want to insert
the text, position the cursor where you want to insert the text, and press Ctrl-V.

Importing HTML Files from Microsoft WImporting HTML Files from Microsoft WImporting HTML Files from Microsoft WImporting HTML Files from Microsoft WImporting HTML Files from Microsoft Wordordordordord
Dreamweaver has a special command for importing Microsoft Word documents saved
in HTML format that opens the HTML document and removes a large amount of
unnecessary code that Word places in the page. To use this command, follow these steps:

1. Use the Import Word HTML command.

To do so, choose the File menu’s Import command and then choose Import Word
HTML from the submenu. The Select Word HTML File To Import dialog box
is displayed, as shown in Figure 5-11.

Figure 5-11 Importing an HTML file created with Word.

2. Locate your central content folder.

Select the drive where your central content folder is located from the Look In drop-
down list box. Navigate to your central content folder by double-clicking folders to
open them. When you find it, double-click it to view the contents of the folder. (If
the file is located elsewhere, open the appropriate folder.)

3. Select the file you want to import, and click Open.

Dreamweaver displays the Clean Up Word HTML dialog box, as shown in Figure 5-12.
Verify that the correct version of Word is selected (Dreamweaver automatically detects
the file type), and then click OK.
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Figure 5-12 The Clean Up Word HTML dialog box.

4. Work with the text.

Dreamweaver opens the file in a new Document window. You can edit the page as
you would any other Web page. To place the text in a different Web page, press Ctrl-
C to copy it, open the page in which you want to insert the text, position the cursor
where you want to insert the text, and press Ctrl-V.

NOTENOTENOTENOTENOTE When you move text from a Word-created HTML file into another Web page
inside Dreamweaver, Dreamweaver strips out Word’s special CSS style infor-
mation. This allows you to format the text better; however, it also results in
the loss of some of the text’s original formatting information. If you want to
strip out this style information without moving the text, making it easier to
format the text, choose the File menu’s Convert command and then choose
3.0 Browser Compatible from the submenu. See “Step 6: Polish Your Pages”
for more information.

Importing Plain TImporting Plain TImporting Plain TImporting Plain TImporting Plain Textextextextext
If you can’t import the text you want as an HTML file, the best way to get the text
into Dreamweaver is to open the text in a program that can read the text file and then
copy and paste it into your Dreamweaver Web page. To do this, follow these steps:
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1. Open the document in its native application.

Open the text in the application that created it or another application that can read
it. Figure 5-13 shows an e-mail message opened in Microsoft Outlook.

Figure 5-13 Importing text from an e-mail message.

2. Copy the text.

Select the text you want to import, and press Ctrl-C.

3. Paste the text in your Web page.

Open the Web page in Dreamweaver in which you want to place the text, place the
cursor where you want to insert the text, and press Ctrl-V. Dreamweaver inserts the
text, without any formatting, as shown in Figure 5-14. You may need to go in and
format the text as appropriate for your Web page.
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Figure 5-14 Importing an e-mail message converted to plain text.

Importing TImporting TImporting TImporting TImporting Tablesablesablesablesables
If you want to import a table from a spreadsheet or other program into a table in a
Dreamweaver Web page, you can use the spreadsheet program’s Web page export ca-
pabilities (if available), and then treat the Web page like any other you want to import.
You can also save the table into a text file and use Dreamweaver’s Import Tabular Data
command to import the data into a new Web page as an automatically created table.

To import a table from a spreadsheet program, follow these steps:

1. Save the data as a text file.

In your spreadsheet program, save the table as a text file, as shown in Figure 5-15,
preferably using tab delimiters (comma-separated values [.csv files] and other de-
limiters work also).
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Figure 5-15 Saving a table as a tab-delimited text file.

2. Import the table into Dreamweaver.

In Dreamweaver, position the cursor where you’d like to insert the table, choose the
File menu’s Import command, and then choose Import Tabular Data from the
submenu.

3. Select the file to import.

In the Import Table Data dialog box, shown in Figure 5-16, click the Browse but-
ton to specify the file you want to import. Use the Delimiter drop-down list box to
specify which character separates columns in the table. Specify any other table
characteristics, and then click OK. Dreamweaver inserts the table in your Web page.

Figure 5-16 Importing a table into Dreamweaver.
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Entering and Formatting TEntering and Formatting TEntering and Formatting TEntering and Formatting TEntering and Formatting Textextextextext
Entering text in Dreamweaver works much the same as it does in a typical word pro-
cessor. Click in the location where you want to add text, and type the text.

Formatting text in Dreamweaver works a little differently from most word processors—
all formatting is done using the Text menu or using the Property inspector floating
palette, as shown in Figure 5-17. To format text, select it and then use the Property
inspector to change the formatting, as described in the list below.

Figure 5-17 Using the Property inspector to format text.

• To change the style of text—for example, to make the text into a heading—select
the text and choose the style you want from the Format drop-down list box on the
Property inspector.

• Use the Bold and Italic buttons to boldface or italicize the selected text.

• Use the Align Left, Align Center, and Align Right buttons to change the alignment
of the selected paragraph.

• Use the Unordered List and Numbered List buttons to make bulleted or numbered
lists.
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• To increase or decrease the indentation of the text, click the Text Indent or Text
Outdent toolbar buttons.

• Choose the Text menu’s Check Spelling command to check your Web page for
spelling errors. The rest of the typical text-formatting tools are also here, and quite
easy to use.

• To change the font, select the text and choose the font you want from the Font drop-
down list box. The available fonts are relatively common across different comput-
ers and alternative fonts are indicated in case the specified font is unavailable.

• To change the font size, select the text and then choose the font size from the Size
drop-down list box.

NOTENOTENOTENOTENOTE Font sizes in Web pages are relative—unless you use CSS styles, the best you
can do is make the font “bigger” or “smaller.” There are seven font sizes; the
default is size 3. Choosing size 1 or 2 makes the text smaller, anything over
3 makes the text bigger. Numbers with a plus (+) or minus (-) sign are rela-
tive to the default size.

• To change the color of the selected text, click the Text Color box on the Property
inspector and choose a color from the pop-up menu.

• To apply a professionally designed color scheme, which sets the background color,
text color, and hyperlink color, choose the Commands menu’s Set Color Scheme com-
mand and choose a color scheme. Color schemes don’t override CSS styles.

WWWWWARNINGARNINGARNINGARNINGARNING When you change a style’s formatting using the Property inspector, you
prevent a CSS style sheet from modifying the attributes you change. This
is relevant only if you are using CSS styles—a specialized tool for mak-
ing text on your Web pages consistent in appearance. To change the font,
font size, or font color for text on your Web pages, we recommend using
an external CSS style sheet, as discussed in “Step 6: Polish Your Pages.”
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Undoing Things—Using the History PaletteUndoing Things—Using the History PaletteUndoing Things—Using the History PaletteUndoing Things—Using the History PaletteUndoing Things—Using the History Palette
You can use the History palette as an enhanced Undo and Redo tool, and you can
even use it to record commands. The following list describes some of the things you
can do with the history palette:

• Undo recent actions by dragging the small slider on the left side of the window
up until all commands you want to undo are grayed out, as shown below. You
can only undo and redo contiguous actions—you can’t selectively undo actions.

• Drag the slider back down to redo the functions you undid.

• To perform a step or series of steps again on a different object, select the new ob-
ject, select the steps in the History palette you want to repeat, and then click the
Replay button in the palette.

• Select steps and then click the Save button to save these steps to a new command
that you can then access later from the Commands menu. This is a tremendous
way to save time on tasks that you perform often.

Do’Do’Do’Do’Do’s and Don’s and Don’s and Don’s and Don’s and Don’ts of Wts of Wts of Wts of Wts of Web Web Web Web Web Writingritingritingritingriting
Writing effective copy is just as important on the Web as it is in print. Good writing
clearly conveys your message to your visitors, doesn’t call attention to itself, and estab-
lishes a tone for your Web site. Here’s a list of Do’s and Don’ts when writing copy for
the Web.

DoDoDoDoDo
• Keep your copy tight. Conciseness is power, and short and clear sentences are easier

to digest than longer sentences with too many ideas.
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• Use a lively tone. Contrary to what many Web marketers say, your Web site shouldn’t
use a flat, serious tone, unless absolutely necessary.

• Use the active voice. Instead of saying simply that something happened, state who
performed the action. For example, instead of “The prestigious Widget of the Year
Award was won by the WaterWidget™,” try “The WaterWidget™ won the Wid-
get of the Year Award.”

• Make a call to action. Instead of “Click here to select product,” try “Buy.” Also try
enticing visitors with special offers, such as “For a limited time, purchase a
WaterWidget™ and we’ll throw in a WackyWidget™ free!”

• Write good headlines. Newspaper and magazine editors write headlines to call at-
tention to their content and so should you.

• Tell a story or include a testimonial about your product. Both increase the interest
factor, and can enticingly convey good information about your product or service.

• Make consistent use of styles. Using styles standardizes the look of text across pages
on your site. Use the Paragraph style for most text, use Heading 1 for the page or
Web site title, and Heading 2, 3, etc. for subsequent headings. If the styles don’t look
the way you want, use an external CSS style sheet to modify them.

Don’tDon’tDon’tDon’tDon’t
• Use the spacebar or Tab key to position text. If you want text indented, use the

Increase Indent toolbar button or use a table, as discussed in a later section and in
“Step 6: Polish Your Pages.”

• Press the Enter key at the end of a line—only at the end of a paragraph. If you press
Enter at the end of every line, the lines will be of uneven length when displayed on
a different-size monitor or in a different-size window. To manually create a new line
within the same paragraph, press Shift-Enter—this is called a line break and uses
the <br> HTML tag.

• Use clichés. They’re by definition overused and tired—let them rest in peace.

• Use hyperboles, unless it’s used to lighten up the writing. Every Web site can’t be
“the best widget shop on the Web,” so don’t make meaningless assertions.

• Be overly pushy. Web visitors are coming to you, so making a hard sell is unnecessary,
and probably undesirable. Provide the information visitors are looking for, and let
them do the rest.
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• Manually change font, font size, or color, unless you’re prepared to do so identically
on all pages. To maintain consistency, stick to the default styles (Heading 1, 2, 3)
or modify the styles using an external CSS style sheet.

Creating HyperlinksCreating HyperlinksCreating HyperlinksCreating HyperlinksCreating Hyperlinks
A hyperlink is a piece of text or an image that when clicked takes the visitor to another
page, image, or file. Hyperlinks are one of the most useful features of Web pages. They
allow visitors to easily access information they’re seeking and provide a way for visitors
to access related information they might not have otherwise sought.

Although hyperlinks are indispensable tools, they are not without hazard. Hyperlinks
leading to other Web sites can quickly take visitors away from your site, something that
you need to be careful about. In general, placing a hyperlink in a document is an in-
vitation for visitors to follow the link, so place links only when you want to lead visi-
tors elsewhere.

TIPTIPTIPTIPTIP If you want to include references to related information but don’t want to
explicitly send visitors away from the current page, make a related informa-
tion column or section of the page with links to other pages and sites with
more information.

Standard HyperlinksStandard HyperlinksStandard HyperlinksStandard HyperlinksStandard Hyperlinks
To create a hyperlink, follow these steps:

1. Select the text or image.

2. Specify what page to link to.

To do this, type the file’s address in the Link text box on the Property inspector or
click the folder icon to display the Select File dialog box, as shown in Figure 5-18.
Select the file to which you want to link, and click Select. The most recently created
hyperlinks can be quickly reused by selecting them from the Link drop-down list
box on the Property inspector.
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Figure 5-18 Creating a hyperlink.

TIPTIPTIPTIPTIP Creating effective text for hyperlinks can be an art unto itself, but in general,
all you need to do is make the linking text short and descriptive. There’s no
need to include the words click here—this instruction is implicit. For example,
use widgets instead of click here for widgets.

E-Mail HyperlinksE-Mail HyperlinksE-Mail HyperlinksE-Mail HyperlinksE-Mail Hyperlinks
To make a hyperlink to an e-mail address, follow these steps:

1. Click the Insert Email Link button on the Objects palette.

2. Enter the text to display.

In the Insert Email Link dialog box, shown in Figure 5-19, enter the text you’d like
to appear in the Web page.

Figure 5-19 Creating a hyperlink to an e-mail address.

3. Enter the e-mail address in the E-Mail box.

Click OK when you’re finished.
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Hyperlinks Within a WHyperlinks Within a WHyperlinks Within a WHyperlinks Within a WHyperlinks Within a Web Pageeb Pageeb Pageeb Pageeb Page
If your page becomes much longer than can fit in one screen, you may want to use named
anchors to make it easier for visitors to navigate the page. Named anchors are made by
placing bookmarks in key sections of the page and then creating hyperlinks to those
bookmarks. To create a named anchor, follow these steps:

1. Place the cursor where you want to insert a bookmark.

This will most likely be immediately before a key heading on your page or at the top
of the page. (In this way visitors can quickly get to the top of the page without
scrolling up.)

2. Create the named anchor.

Choose the Insert menu’s Invisible Tags command and then choose Named Anchor
from the submenu. You can also click the Named Anchor button in the Invisibles
group of the Objects palette. (Click the Common heading in the Objects palette to
select a different group of objects.)

3. Name the anchor.

In the Insert Named Anchor dialog box, shown in Figure 5-20, enter a short name
for the anchor in the Anchor Name text box, and then click OK. Dreamweaver places
a small yellow anchor icon onscreen to represent the named anchor. To delete the
anchor, select it and press the Delete key. To move the anchor, drag it to a new lo-
cation.

Figure 5-20 Creating a named anchor to permit in-page hyperlinks.

TIPTIPTIPTIPTIP Place your named anchor on the line above the heading or section to which
you want to link. Doing this ensures that the heading won’t end up partially
off-screen.

4. Highlight the text you want to make into a link.

Enter some descriptive text at the top of your page, and select it.
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5. Drag the Point To File icon to the named anchor.

Drag the Point To File icon (the small target icon located to the right of the Link
box in the Property inspector) until the target pointer is over the named anchor to
which you want to link, as shown in Figure 5-21. When you do this, Dreamweaver
fills in the Link field with the named anchor’s name, preceded by the pound (#) sign
(which indicates the link is to a named anchor).

Figure 5-21 Linking to a named anchor by dragging the Point To File icon.

Opening Links in a Different WindowOpening Links in a Different WindowOpening Links in a Different WindowOpening Links in a Different WindowOpening Links in a Different Window
Usually, when a visitor clicks on a hyperlink, you want the link to open in the same
browser window. However, if it’s a link to another company’s Web site or somewhere
outside your own site, you might want to make the link open in a new browser win-
dow so that your site remains open. To do so, follow these steps:

1. Select the link.

Select the hyperlink you want to open in a new window.
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2. Specify the target window.

Select the window in which you want the link to open from the Target drop-down
list in the Property inspector, as shown in Figure 5-22. Choose _blank to open the
link in a new window—the other options are primarily for targeting different frames
if your site uses them.

Figure 5-22 Making a hyperlink open in a new browser window.

WWWWWorking with Imagesorking with Imagesorking with Imagesorking with Imagesorking with Images
After text, images are the next most important element in a Web page. The following
sections explain how to insert images, modify image properties (including size and
spacing), and set alternative representations.

TIPTIPTIPTIPTIP To set a background image, choose the Modify menu’s Page Properties com-
mand, click the Browse button next to the Background Image box, and se-
lect the image you want to use.
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Inserting ImagesInserting ImagesInserting ImagesInserting ImagesInserting Images
The easiest way to insert an image into a Web page is to use the Insert Image object
on the Objects palette. To do this, follow these steps:

1. Click or drag the Insert Image object.

Either click the Insert Image object on the Objects palette to insert an image at the
current cursor location or drag the Insert Image object to the location where you want
to insert the image.

2. Select an image.

In the Select Image Source dialog box, shown in Figure 5-23, select an image to
display a preview of it. When you’ve found the image you want, click Select.
Dreamweaver inserts the image into your Web page.

Figure 5-23 Selecting an image to insert.

TIPTIPTIPTIPTIP To insert a horizontal line—a visual divider used to separate content elements—
position the cursor where you want to place the horizontal line and then click
the Horizontal Line button in the Objects palette. To modify the horizontal
line’s properties, select it and use the Property inspector.
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Using the Assets PaletteUsing the Assets PaletteUsing the Assets PaletteUsing the Assets PaletteUsing the Assets Palette
The Assets palette, shown in Figure 5-24, displays all the different assets your site has.
This is particularly useful for quickly finding images to insert in your pages.

Figure 5-24 The Assets palette.

The following list describes some things you can do with the Assets palette:

• To view a different type of asset, click one of the asset type buttons along the left
side of the Assets palette.

• To insert an asset into the current Web page, select it and click the Insert button.

• To add an asset to a list of favorite assets, right-click the asset and choose Add To
Favorites from the shortcut menu.

• To view the assets in your Favorites list, click the Favorites option button at the top
of the Assets palette, as shown in Figure 5-25. Note that separate Favorites lists are
maintained for every asset type, so to find the images you added to the Favorites list,
click the Images button.
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Figure 5-25 The Favorites view of the Assets palette.

Resizing ImagesResizing ImagesResizing ImagesResizing ImagesResizing Images
Some images just won’t be the right size for your Web page. In general, if the image
doesn’t fit properly on your page, you should resize it in a standalone image editor, such
as Macromedia Fireworks.

You can resize images directly in Dreamweaver, but doing so only changes how large
the image is displayed in a Web browser—the actual image file remains exactly the same
size. This means that even if you reduce the size of an image in Dreamweaver, it will
still take the same amount of time to download unless you resize the actual image file
in a standalone editor.

There are circumstances, though, when it is appropriate to resize an image in
Dreamweaver. For example, perhaps you’ve created an image to serve as a visual divider
for the page—maybe a graphical horizontal rule or an image to delimit a column of a
table. Instead of resizing the image file itself to fit the page, simply adjust the size in
Dreamweaver to expand the image to fit the space you intend. This allows you to use
a smaller image to fit a larger space, which lets the page download faster.

TIPTIPTIPTIPTIP Keep in mind that you can only discard image information, not gain it; so try
to increase the size of images on only one axis—the axis where the image
simply repeats. An image that you enlarge too much on the wrong axis looks
pixilated and unattractive. To see this in action, resize some images and look
at them.
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To resize an image, follow these steps:

1. Select the image.

2. Resize the image.

Move the mouse over an edge of the image until the cursor turns into a dual-sided
arrow, and then drag the outline of the image in or out to make the image smaller
or bigger, as shown in Figure 5-26.

Figure 5-26 Resizing an image.

3. Optionally, resize the image precisely.

To precisely resize an image, select the image, and then enter a new size in the W
and H (Width and Height) boxes of the Property inspector. The default unit is
pixels—to make the image size relative to the size of the browser window (a good
idea for horizontal rules and other simple, repeating graphics), enter the size in
percentage by adding a percent sign after the size you enter. Clear the Keep Aspect
Ratio check box if it’s okay to distort the image by adjusting the height and width
non-proportionally.
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NOTENOTENOTENOTENOTE In general, images shouldn’t be sized by percent because they’ll end up
strangely distorted, the wrong size, or pixilated. Some exceptions are images
used as horizontal lines and images used as visual dividers.

Adjusting Image LayoutAdjusting Image LayoutAdjusting Image LayoutAdjusting Image LayoutAdjusting Image Layout
To adjust how text is laid out with an image—for example, how it’s aligned with the
image and how much spacing is in between the image and the text, follow these steps:

1. Select the image.

2. Specify the alignment.

To specify how you want to align text adjacent to your image, choose an option from
the Align drop-down list box on the Property inspector, as shown in Figure 5-27.
Figure 5-28 shows a list of the alignment options.

Figure 5-27 Specifying how text next to an image should be aligned.
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Figure 5-28 The different alignment options available.

3. Set the image spacing.

To control the amount of space between the image and whatever it’s next to, click
the down arrow in the lower right corner of the Property inspector to display the
advanced image properties. Use the V Space and H Space boxes to control the amount
of spacing (in pixels) on all sides of the image, as shown in Figure 5-29.
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Figure 5-29 Changing the image spacing.

4. Set the border thickness.

To add a border around the image, enter a border thickness in pixels in the Border
box.

Setting Alternative Image RepresentationsSetting Alternative Image RepresentationsSetting Alternative Image RepresentationsSetting Alternative Image RepresentationsSetting Alternative Image Representations
One way you can make a Web page more effective is to provide alternative text-based
descriptions of your images. These descriptions display while images are loading (which
on slow Internet connections can often take a while)—or they display in browsers that
have images disabled—helping to make your Web site usable for a wider audience.

TIPTIPTIPTIPTIP Setting alternatives is a good practice, but it is no substitute for creating pages
that load quickly. In general, your Web pages should load in less than 30
seconds over a 28.8 connection. (See the page size and download time dis-
play on the far right end of Dreamweaver’s status bar for an estimate of how
long the current page will take to load.) For more help on optimizing your
Web pages, see “Step 6: Polish Your Pages.”
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To specify what your alternative text should be, select the image, and then in the Alt
box on the Property inspector, enter the text you want visitors to see when they can-
not see your image, as shown in Figure 5-30.

Figure 5-30 Setting alternative representations for an image.

To specify a low-resolution image to display while the full-size image is loading, click
the down arrow in the lower right corner of the Property inspector to display the
advanced image properties, click the folder icon next to the Low-Src text box, select
the image you want to display, and then click OK.

TIPTIPTIPTIPTIP In general, don’t worry about providing a low-resolution version of an im-
age unless you have a very large image on a Web page. If this is the case,
consider reducing the image size (create a thumbnail) and linking it to the full-
size version for those visitors who might want to see the larger image.
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Creating Image MapsCreating Image MapsCreating Image MapsCreating Image MapsCreating Image Maps
Image maps allow you to create multiple hyperlinks within a single image. Each
hyperlink is assigned to a different region of the image called a hotspot. To create an
image map, follow these steps:

1. Select the image.

2. Open the advanced properties.

Click the down arrow in the lower right corner of the Property inspector to display
the advanced image properties.

3. Draw a hotspot.

Click the Square Hotspot, Oval Hotspot, or Polygonal Hotspot button on the Prop-
erty inspector, and then click and drag inside the image, as shown in Figure 5-31.

Figure 5-31 Creating the outline for a hotspot.
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4. Create the hyperlink.

Click the folder icon next to the Link box in the Property inspector to locate a Web
page or file to which you can link the hotspot.

5. Set the alternative text.

In the Alt box of the Property inspector, enter a short but descriptive name for the
hotspot, as shown in Figure 5-32. This name will be used for browsers that display
the Alt information in a small ToolTip when the cursor is moved over the hotspot.

Figure 5-32 Naming the hotspot.

WWWWWARNINGARNINGARNINGARNINGARNING To accommodate visitors who use text-only browsers, either add text-
based links to your page or create a link to a text-only version of the page.

SummarySummarySummarySummarySummary
“Step 5: Create Your Pages” explained the basics of Dreamweaver’s interface and also
showed you how to create Web pages. The tasks involved in this process include cre-
ating and editing text and images, as well as creating hyperlinks.
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Step 6

POLISH YOUR PAGESPOLISH YOUR PAGESPOLISH YOUR PAGESPOLISH YOUR PAGESPOLISH YOUR PAGES

Featuring:Featuring:Featuring:Featuring:Featuring:
• Creating an Effective Home Page

• Advanced Web Page Layout

• Making Your Pages Look Consistent

• Ensuring Proper Display of Your Pages

To turn your basic Web pages into pages that will hold the interest of your visitors,
you’ll need to learn how to make an effective home page, how to make your pages

look consistent, and how to create advanced Web page layouts using layers and tables.
To help any visitors who may have trouble finding your site, you also need to know how
to prepare your home page for search engines. “Step 6: Polish Your Pages” explains how
to do these tasks.

Creating an Effective Home PageCreating an Effective Home PageCreating an Effective Home PageCreating an Effective Home PageCreating an Effective Home Page
The home page (index.htm or index.html) is the first page visitors see. It acts as a sum-
mary of the entire Web site, serves as a navigational aid, and is used by search engines
to determine how to catalog your Web site. As such, an effective home page should meet
the following goals:
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• Summarize the content of the Web site.

• Attract visitors’ interest and attention.

• Show up prominently in search engines.

To make sure that your home page achieves all three goals, you want to choose the best
content for your home page, make the page visually interesting, and prepare the page
for search engines.

Choosing the Best Content for YChoosing the Best Content for YChoosing the Best Content for YChoosing the Best Content for YChoosing the Best Content for Your Home Pageour Home Pageour Home Pageour Home Pageour Home Page
Because the home page is the first page visitors see when they come to a Web site, it’s
vital that this page has the right content. Here are some suggestions for choosing con-
tent for your home page:

• Summarize what your company and Web site is about so that visitors know what to
expect (this also helps the Web site place well in search engines).

• Include hyperlinks to your major content categories. This also helps visitors easily
navigate the site.

• Attract visitors’ attention. One way effective Web sites do this is to highlight key
content from pages within the site (and provide links to the content) and also list
what’s new on the site. Special sales or event information can also attract visitors’
attention.

• Keep the content on your home page short. Each featured section should contain only
a couple of lines of text with one or two small images.

• Place the most important content at the top of the page. Visitors may never scroll
down to catch the rest of the page if the content at the top isn’t of interest to them,
so make sure to put your best content first.
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• Choose content that reflects the feel of your company or organization. Also be sure
to use the appropriate tone, as discussed in “Step 5: Create Your Pages.”

• Think like a visitor and choose your content accordingly. Why would someone come
to your site, and what can you do to make it easier for them to find exactly what they
want?

An example of a site that provides effective, brief content on its home page is the Fortune
Web site (http://www.fortune.com), shown in Figure 6-1. It highlights key articles and
then links to other content of interest. In addition, the site is clean, quick to load, and
easy to understand.

Figure 6-1 A home page with well-chosen content.
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Making YMaking YMaking YMaking YMaking Your Home Page Vour Home Page Vour Home Page Vour Home Page Vour Home Page Visually Appealingisually Appealingisually Appealingisually Appealingisually Appealing
While it’s important that all of your pages be visually appealing, it’s particularly im-
portant for your home page. Here are some specific recommendations to improve the
attractiveness of your home page:

• Use your company logo. Keep it small, place it in a consistent location with a con-
sistent size, and consider saving it as a transparent GIF, perhaps in a template or in
Dreamweaver’s Library (discussed later in the section “Using the Library”). If you
don’t have a logo (or have one in computer-readable format), consider hiring a graphics
professional to create one.

• Use an attractive set of colors to present a consistent look to your visitors. If possible,
use your company colors. The best way to apply a color scheme to pages is by using
an external Cascading Style Sheet (CSS) linked to all your pages.

• If you don’t have a color scheme, use one of Dreamweaver’s color schemes. To do so,
choose the Commands menu’s Set Color Scheme command.

• Don’t overload your home page with content. Overloading your home page makes
it difficult for visitors to find the most important links and information, so choose
some key elements to display and leave the rest of the page blank.

• Have good visual flow. Design your pages to attract the eye to the entire page, not
just a single part of it. Be careful not to overload your page though; otherwise, the
eye won’t be able to settle comfortably on anything.

• Make sure that your home page (and other pages on your site) load quickly even over
a slow Internet connection. In general, pages should take no more than 15 to 30
seconds to download over a 28.8Kbps modem. Dreamweaver’s status bar gives an
estimate of how long it will take to download any open page.
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Using Flash Buttons and TUsing Flash Buttons and TUsing Flash Buttons and TUsing Flash Buttons and TUsing Flash Buttons and Textextextextext
Dreamweaver 4 provides the ability to easily add stylized text and buttons that re-
spond to visitors’ actions. To do so, you use a Flash Text or Flash Button object to
create a small Macromedia Flash plug-in file for your Web page.

Flash makes it easy to create attractive, interactive text and buttons; however, it’s
not without its drawbacks. Flash buttons and text cannot be viewed in Web browsers
that don’t support it natively or have the Flash plug-in installed. Flash text is not
indexable by search services, which lessens the information a search service will
collect from your site. Also, Flash animations take longer to download than stan-
dard text, which may add some sluggishness to the feel of your Web site to visi-
tors with slow Internet connections.

Many companies get around these drawbacks by letting visitors choose a “Flash-
Enabled” or “Flash-Disabled” version of your site from your home page. However,
this usually entails maintaining two versions of your site, and can sometimes double
the work involved.

To insert Flash buttons or text, click the Insert Flash Text or Insert Flash Button
on the Objects palette and then use the resulting dialog box to create your button
or text, as shown below.
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Preparing YPreparing YPreparing YPreparing YPreparing Your Home Page for Search Enginesour Home Page for Search Enginesour Home Page for Search Enginesour Home Page for Search Enginesour Home Page for Search Engines
One crucial part of Web site design that you shouldn’t overlook is preparing your site
for search engines. This includes more than just submitting your site to the most popular
search engines. It also means adding some special HTML codes to your home page that
tell search engines how to deal with your Web site.

These special codes are called meta tags (or meta variables). Meta tags store informa-
tion about your site, such as a description and keywords, which some search engines use
to determine when to display your site in a list of search results, as well as how to dis-
play your Web site.

To insert meta tags into a Web page using Dreamweaver, follow these steps:

1. Insert a Keywords object.

Open your home page, and then click the Insert Keywords object in the Head group-
ing of the Objects palette, as shown in Figure 6-2. (Click Common on the Objects
palette to select a different group.)

Figure 6-2 Inserting the Keywords meta tag.
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TIPTIPTIPTIPTIP You can display header information in Dreamweaver by clicking the View
Options toolbar button and selecting Head Content from the pop-up menu.

2. Create the Keywords meta tag for your site.

In the Keywords box, enter all the keywords you want search engines to use to iden-
tify your site, separated only by commas, as shown in Figure 6-3. Click OK when
you’re finished.

Figure 6-3 Creating the Keywords meta tag to help search engines find your site.

TIPTIPTIPTIPTIP Enter any common misspellings of your organization’s name along with the
names of your products or services, and the names of your competitors.

3. Insert a Description object.

Click the Description object in the Head grouping of the Objects palette. (Click
Common on the Objects palette to select a different group.)

4. Create the Description meta tag for your site.

In the Description box, as shown in Figure 6-4, enter a concise (25 words or less)
but attractive description of your Web site. Avoid repeating your site’s name or
claiming absolutes, such as “the best widgets on the Web.”

Figure 6-4 Creating the Description meta tag to describe your site for search engines.
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TIPTIPTIPTIPTIP For more information on how search engines find pages and how to make
your Web site more effective with search engines, check out http://

www.searchengine.com.

WWWWWorking with Navigation Barsorking with Navigation Barsorking with Navigation Barsorking with Navigation Barsorking with Navigation Bars
Navigation bars are a series of buttons that help visitors quickly access the most important
pages on a Web site. Although no more functional than a simple list of hyperlinks,
navigation bars look more polished and have become the standard navigational aid for
Web sites.

Creating Standard Navigation BarsCreating Standard Navigation BarsCreating Standard Navigation BarsCreating Standard Navigation BarsCreating Standard Navigation Bars
To make a standard navigation bar that works in all Web browsers, follow these steps:

1. Create a series of image buttons.

Using a program such as Macromedia Fireworks or Microsoft PhotoDraw, create a
button image for each link you’d like to include in your navigation bar.

2. Place the buttons in your navigation bar.

Insert the images in a table along one side of the page, at the top or bottom of the
page, or in a frame. (A frame is a separate section of a page that can contain a com-
pletely different Web page. For more information, see “Appendix E: Creating
Frames.”)

3. Assign hyperlinks to the buttons.

Link the images to the pages you want to include in your navigation bar. (For help
with creating hyperlinks, see “Step 5: Create Your Pages.”) Also make sure to assign
alternative text for each button so that visitors who can’t view images can still use your
navigation bar.

Creating Navigation Bars with Rollover ButtonsCreating Navigation Bars with Rollover ButtonsCreating Navigation Bars with Rollover ButtonsCreating Navigation Bars with Rollover ButtonsCreating Navigation Bars with Rollover Buttons
Dreamweaver provides a special Navigation Bar object that you can use to insert a
navigation bar with rollover buttons. Rollover buttons (buttons that change appearance
when you move the mouse over them or click them) quickly increase the visual appeal
of your site, and since the images are small, the extra time involved to download them
is often a worthwhile trade-off.

NOTENOTENOTENOTENOTE The rollover effect won’t appear in Web browsers that don’t support JavaScript (such

as version 2 browsers).
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To create a navigation bar with rollover buttons, follow these steps:

1. Create a series of image buttons.

Using a program such as Macromedia Fireworks or Microsoft PhotoDraw, create a
button image for each link you’d like to include in your navigation bar. To make
rollover buttons, create a different version of each button for each image state you
want to use. The four states are shown in Table 6-1.

BUTTON STBUTTON STBUTTON STBUTTON STBUTTON STAAAAATETETETETE DESCRIPTIONDESCRIPTIONDESCRIPTIONDESCRIPTIONDESCRIPTION

Up Default—no user action required.

Over When the user moves the mouse over the image.

Down When the user clicks the image.

Over While Down When the user clicks the image and then moves the mouse
over it.

Table 6-1 The different image states for a rollover button.

Typically, two or three image states are adequate (Up, Down, and Over). Usually the
Over image has some sort of glowing effect to it (or brighter text), and the Down
image looks depressed or the text is drawn lighter.

2. Insert a Navigation Bar object.

Place the cursor where you want to insert the navigation bar—most likely along the
top or side of a Dreamweaver template. Click the Insert Navigation Bar object on
the Objects palette to display the Insert Navigation Bar dialog box, as shown in
Figure 6-5.
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Figure 6-5 Creating a rollover button navigation bar.

TIPTIPTIPTIPTIP Frames can make good navigation aids. By placing a navigation bar in a
navigation frame and placing your home page in the main frame, the navi-
gation bar will be available from any page on your Web site without any
additional work.

3. Name the first button.

In the Element Name box, enter the name for the first navigation button (probably
Home). This button name is also shown in the Nav Bar Elements list, which shows
the buttons in your navigation bar.

4. Specify the images.

Click the Browse button next to each image state you want to specify. (Specify the
Up image only if you don’t want to make rollover buttons.) Use the Select Image
Source dialog box, as shown in Figure 6-6, to select the images.
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Figure 6-6 Selecting images for the navigation bar.

5. Assign hyperlinks to the button.

Link the button to the page you want by clicking the Browse button next to the
When Clicked, Go To URL box and selecting the page. If your page uses frames,
select the frame in which your page should open from the Main Window drop-down
list box next to the URL field.

6. Add more buttons.

To create additional buttons, click the plus sign (+) at the top of the dialog box and
then repeat steps 3 through 5. To remove a button, select it in the Nav Bar Elements
list and click the minus sign (–). To rearrange the buttons, use the up and down
arrows located above the Nav Bar Elements list.

7. Specify options.

To preload the images for hidden button states so that there isn’t a delay when a
mouse is moved over the button, leave the Preload Images option selected. Select the
Show “Down Image” Initially check box to have the button appear depressed ini-
tially. (Select this option for the Home button so that when someone initially loads
the home page, your navigation bar indicates that the visitor is viewing the home
page.) Use the Insert drop-down list box to specify whether the navigation bar should
be created horizontally (all buttons in a row) or vertically (all buttons in a column).
Select the Use Tables check box to create the navigation bar in a table. Click OK
when you’re finished.
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TIPTIPTIPTIPTIP Determining which pages to include on your navigation bar(s) may initially
involve a bit of head scratching. Users should be able to easily figure out where
they are, where in the Web site they want to or should go next (sometimes
you’ll want to lead visitors through your site), and how to get back to where
they were. Regardless, you’ll probably want to fiddle with your navigation bars
and test the results—ideally with some new users. For more information on
testing Web sites, see “Step 7: Deploy Your Web Site.”

To modify the navigation bar, select an image in the navigation bar and then choose the
Modify menu’s Navigation Bar command.

TIPTIPTIPTIPTIP In addition to using navigation bars, it’s often helpful to create smaller navi-
gational aids for certain sections of your Web site. For example, multiple-page
stories can benefit from a mini Table of Contents with links to all pages in the
story. Long pages can benefit from using named anchors (hyperlinks to a
different part of the same page) to improve the ability to quickly get to part
of the page.

Advanced WAdvanced WAdvanced WAdvanced WAdvanced Web Page Layouteb Page Layouteb Page Layouteb Page Layouteb Page Layout
When you’re designing Web pages, it doesn’t take long to get frustrated with HTML’s
limited positioning abilities. It’s hard to indent text, it’s difficult to wrap text around
images, and it’s really hard to make columns or line up items on a Web page.

There are a couple of techniques you can use in Dreamweaver to create better Web page
layouts. The first technique is to use layers. You can use layers to position anything in
a Web page, anywhere onscreen. The main drawback to layers is their incompatibility
with Web browsers that don’t support Cascading Style Sheets (CSS), such as Internet
Explorer or Netscape Navigator versions 3.x and older.
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If compatibility with older Web browsers is important, you can create your layouts using
tables, which are built and modified much like tables in a word processor. Tables al-
low you to create layout effects similar to those of layers, and they can be made invis-
ible so as not to reveal the tool used to position the objects on the Web page. Of course,
tables are also useful for presenting data or items in a list, so even if you use layers, tables
are still an invaluable tool for creating Web pages.

Layers and tables are discussed in the following sections.

TIPTIPTIPTIPTIP Another tool that professional Web developers use when creating advanced
layouts is transparent GIF images. Create a small, completely transparent GIF
image, and then use it to fill the space that you want to appear blank. If the
image isn’t quite the right size, resize it using the Image Properties dialog box.

Using LayersUsing LayersUsing LayersUsing LayersUsing Layers
Dreamweaver makes positioning text and images in layers very easy. Using layers, you
can place objects pixel perfectly anywhere on your Web page. However, if you want to
maintain resolution independence so that visitors can properly view your Web pages
at a variety of screen resolutions and window sizes, special caution needs to be taken.

TIPTIPTIPTIPTIP Making text wrap around images is easy—you don’t even have to use layers.
Just select the image you want to wrap text around and select Left or Right
from the Align drop-down list box in the Property inspector.

Creating LayersCreating LayersCreating LayersCreating LayersCreating Layers
You can create layers in a couple of ways. If you already have your page laid out using
tables, you can convert this layout to layers by following these steps:

1. Use the Convert Tables To Layers command.

Choose the Modify menu’s Convert command, and then choose Tables To Layers
from the submenu, as shown in Figure 6-7.
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Figure 6-7 Converting a page using tables into a page using layers.

2. Choose your options.

In the Convert Tables To Layers dialog box, shown in Figure 6-8, select Prevent
Layer Overlaps if you think you might at some point want to convert your layout
back into tables. Select Show Layer Palette if you want to display the Layer palette,
which is useful for selecting layers. Select Show Grid to display a grid that
Dreamweaver uses to position layers, and select Snap To Grid to force layers to be
aligned on this grid. Click OK when you’re finished.

Figure 6-8 Setting table conversion options.

To create layers from scratch, most likely on an empty page, follow these steps:
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1. Click the Draw Layer object on the Objects palette.

2. Draw the layer.

Draw your layer by clicking and dragging the layer outline to the size you want, as
shown in Figure 6-9. When you release the mouse button, the layer appears in your
page, as well as in the Layers palette, if you have that displayed. The layer is anchored
by its <div> tag, which is placed in the top left of the page, resulting in an absolutely
positioned layer that won’t move onscreen regardless of the window size.

Figure 6-9 Drawing a layer.

3. Name the layer.

Select the layer and in the Layer ID box of the Property inspector, enter a name for
the layer, such as NavLayer (for a layer with navigation links) or Header (for a layer
with header content such as a company logo).

WWWWWARNINGARNINGARNINGARNINGARNING Netscape 4 has a bug in the way it displays layers. If you resize a window
with layers, the layers lose their positioning information. Dreamweaver
automatically inserts this fix when you create layers, but you can turn this
feature off by choosing the Edit menu’s Preferences command, select-
ing Layers in the Category list, and then clearing the Netscape 4 Com-
patibility check box.
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How Dreamweaver Positions LayersHow Dreamweaver Positions LayersHow Dreamweaver Positions LayersHow Dreamweaver Positions LayersHow Dreamweaver Positions Layers
Layers are anchored by a <div> tag, which appears graphically in Dreamweaver as
a yellow “C” usually placed at the top left of the page. Most layers you create are
positioned absolutely onscreen in pixels, measured from the top left of the page (and
controlled by the T and L boxes in the Property inspector).

If you drag a Draw Layer object onto your Web page and drop the object into your
page, a relatively positioned layer is created at the location where you dropped the
object. This layer will move depending on the window size and how the text or
images surrounding its <div> tag adjust to the changing window size. The layer will
also overlap or underlay any nearby content, as shown below. Needless to say, rela-
tively positioned layers move around rather unpredictably depending on the win-
dow size of the browser displaying the Web page. To avoid this dilemma, test the
page at different resolutions or stick to absolutely positioned layers.

All layers are displayed by default on top of any Web page content not placed in
a layer. If you don’t want content in layers displayed on top of other content, ad-
just the Z-Index of the layers you want to appear behind Web page content so the
layer has a negative Z-Index. (For more information, see the following section,
“Positioning Layers.”)
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Positioning LayersPositioning LayersPositioning LayersPositioning LayersPositioning Layers
To position a layer, follow these steps:

1. Select the layer.

To select a layer, click its positioning handle (the box attached to the top left of the
layer), click inside the layer, and then click the <div> tag in the Tag selector to se-
lect the entire layer. You can also select the layer from the Layers palette.

2. Resize the layer.

Move the mouse over one of the positioning handles on the layer’s outline until the
cursor turns into a double-sided arrow, and then click and drag the layer’s outline
to the desired size. You can also enter the layer’s width and height in the W and H
boxes of the Property inspector. To size a layer relatively, enter the size in percent-
age. For example, the layer shown in Figure 6-10 is sized at 80% width; the height
is left blank so that it can adjust to compensate for a changing width.

Figure 6-10 A relatively sized layer.
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TIPTIPTIPTIPTIP To maintain resolution independence, size your main body layer relatively in
at least one dimension. To do so, enter the width or height in percent. To
ensure that all content fits inside the layer, size one dimension relatively and
leave the other dimension left unspecified.

3. Reposition the layer.

To move a layer, either click the layer’s positioning handle and drag the layer where
you want it, or enter the coordinates relative to the top of the screen and the left edge
of the screen in the T and L boxes of the Property inspector. If you want to posi-
tion a layer relatively based on where the layer’s <div> tag (the yellow “C” tag in your
page) is located, delete the coordinates in the T and L boxes.

TIPTIPTIPTIPTIP To change the size of the positioning grid, choose the View menu’s Grid
command and then choose Settings from the submenu.

Adjusting Layer VisibilityAdjusting Layer VisibilityAdjusting Layer VisibilityAdjusting Layer VisibilityAdjusting Layer Visibility
In addition to having a position relative to the top left of the Web page (the Y and X
axes), all layers also have a position on the vertical, or Z, axis. This allows layers to overlap
each other, unless you have the Prevent Layer Overlaps option selected in the View
menu. You can hide layers too, although in general you should do this only temporarily
in order to edit an overlapping layer, since even hidden layers take time to download.
To adjust layers, follow these steps:

1. Adjust the layer’s visibility.

To specify whether you want to display or hide a layer, click in the eye column of
the layers palette, as shown in Figure 6-11. Click the eye above the column to mark
all layers explicitly visible. You can also adjust a layer’s visibility using the Vis drop-
down list box of the Property inspector (when a layer is selected).
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Figure 6-11 Adjusting a layer’s visibility and stacking order.

2. Adjust the layer’s Z-Index.

To control how layers stack on top of each other, select a layer and then enter a stack-
ing order in the Z-Index box of the Property inspector. Layers with higher num-
bers are displayed on top of layers with lower numbers; any objects not placed in a
layer are considered to have a Z-Index of zero.
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WWWWWorking with Torking with Torking with Torking with Torking with Tablesablesablesablesables
Tables are tremendously useful for creating advanced layouts in a Web page and are
used much more often than you might realize. Besides their obvious use for creating
tables of text and graphics, tables are often used to make more precise text and graphic
layouts than can be accomplished simply with standard techniques. They are also
compatible with older Web browsers.

The following sections detail how to create tables to organize data or content on a page,
how to create advanced page layouts using tables, and how to modify table and cell
properties.

Creating TCreating TCreating TCreating TCreating Tables for Contentables for Contentables for Contentables for Contentables for Content
The easiest way to create a table for tabular display of content such as data or lists is
by using the Insert Table object.

To create a table using the Insert Table object, follow these steps:

1. Position the cursor where you want to insert the table.

2. Use the Insert Table object.

Either click the Insert Table object on the Objects palette to insert the table at the
cursor location, or drag the Insert Table object to the location you want.

3. Specify the number of rows and columns.

In the Insert Table dialog box, shown in Figure 6-12, enter the number of rows and
columns for the table in the Rows and Columns boxes.

Figure 6-12 Creating a table.
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4. Specify the table size.

Enter a width for the table in the Width box. Use the drop-down list box to specify
whether the table should be sized relatively (in percent, so the table changes in size
with window size) or absolutely (in pixels, so the table never changes size).

5. Modify the border size.

In the Border box, enter a border width for the table in pixels. To make the table
boundaries invisible, enter a border width of zero.

6. Add content to the table.

Add content to the table by entering text or inserting images directly in the table.
You can also add content by selecting a block of text or an image and dragging it into
a table cell.

TIPTIPTIPTIPTIP You can sort the contents of a table by selecting the table and choosing
the Commands menu’s Sort Table command.

Creating Advanced Page Layouts Using TCreating Advanced Page Layouts Using TCreating Advanced Page Layouts Using TCreating Advanced Page Layouts Using TCreating Advanced Page Layouts Using Tablesablesablesablesables
Dreamweaver 4 now includes a visual table editing mode that makes it the most pow-
erful tool for quickly creating complex layouts with tables. The Layout view mode is
so easy to use that many users who may have chosen to use layers can now achieve similar
layouts using tables alone—making it more likely that the layout will display properly
in all browsers.

To use Layout view to create and edit a table visually, follow these steps:

1. Switch to Layout view.

Click the Layout View button on the Objects palette. Dreamweaver displays a dia-
log box giving you a quick overview of how to use the Layout view. Click OK.

2. Draw a table.

Click the Draw Table button on the Objects palette, and then click and drag the
outline to fill the entire Document window, as shown in Figure 6-13.
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Figure 6-13 Drawing the table outline.

TIPTIPTIPTIPTIP You can create a mock-up of your site layout in an image editing program,
such as Adobe Photoshop or Macromedia Fireworks, and then trace the mock-
up image in Dreamweaver to duplicate the design. To do this, choose the
Modify menu’s Page Properties command and then specify the tracing image
to use in the Tracing Image box.

3. Create table cells.

To create cells in the table, click the Draw Cell button, and then draw the cells you
want to create. Cells that you create appear as empty white boxes, as shown in Fig-
ure 6-14. To draw additional cells, click the Draw Cell button again, or hold down
the Ctrl key (or Command key on a Macintosh) to draw multiple cells without having
to click the Draw Cell button each time.
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Figure 6-14 Inserting the first cell in a table.

TIPTIPTIPTIPTIP To draw a cell boundary more precisely, hold down the Alt key while draw-
ing the cell.

4. Resize columns and rows.

Click the border of a cell, column, or row to display sizing handles. Click a sizing
handle (one of the small squares) on the cell, column, or row outline to resize it.

5. Insert your content.

Insert your text and images to fill in your page’s design.

TIPTIPTIPTIPTIP To create a nested table, or a table within an existing table, switch to Stan-
dard view, place the cursor where you want to insert the table, and click the
Insert Table object.
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6. Make a column stretch to fit.

The top of the table displays the width in pixels for every column in your table. Click
one of these numbers and select Make Column Autostretch from the pop-up menu,
as shown in Figure 6-15. This makes that column adjust in size to match the size
of a visitor’s browser window. The number you click should be the one that corre-
sponds to the column you want to change in size.

Figure 6-15 Enabling Autostretch.

7. Clear cell heights.

Once you’ve inserted your content, you can shrink the heights of each table cell to
fit the content it contains, unless you’re using some cells for vertical positioning. To
clear cell heights, click a column width number (as discussed above) and choose Clear
Cell Heights from the pop-up menu.

TIPTIPTIPTIPTIP To split an existing cell into multiple columns or rows, switch to Standard view,
right-click in the desired cell, choose Table from the shortcut menu, and
choose Split Cell from the submenu. Specify the number of rows or columns
to divide the cell into, and click OK.
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Modifying TModifying TModifying TModifying TModifying Table Propertiesable Propertiesable Propertiesable Propertiesable Properties
You may need to adjust the sizing of a table, its alignment on the page, or the colors
or background image.

Dreamweaver displays table properties in the Property inspector differently depend-
ing on whether or not you’re in Layout view or Standard view. If you’re using Design
view, you probably won’t need to adjust your table properties and cell properties much.
If you do, you can either use the Property inspector in Design view, which is fairly
simple, or you can switch to Standard view and follow these steps:

1. Select the table.

Click anywhere inside the table, and click the <table> tag in the Tag selector.

2. Specify how the table should be aligned on the page.

Select an entry from the Align drop-down list box in the Property inspector, as shown
in Figure 6-16, to specify how the table should be aligned on the page.

Figure 6-16 Using the Property inspector to change a table’s appearance.

3. Specify the cell padding and spacing.

In the CellPad box, specify how many pixels you want between the contents of a cell
and the cell wall. In the CellSpace box, enter the width in pixels of the cell wall. Note
that this is different from the width of the border. You can have a CellSpace value
higher than zero and still have the border be invisible.

4. Optionally, add extra rows or columns.

Choose the Modify menu’s Table command, and choose Insert Rows Or Columns
from the submenu. In the dialog box, as shown in Figure 6-17, select either Rows
or Columns, specify how many to insert, and indicate whether to insert them above
or below the current selection.

Figure 6-17 Inserting extra rows or columns using the Insert Rows Or Columns command.
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5. Manually specify the width and height of the table.

Enter the width or height of the table in the W (width) and H (height) boxes. Specify
whether the sizes are in percent or in pixels by selecting % or Pixels from the drop-
down list boxes. You can also change the widths of the individual rows and columns
in the Advanced Properties section of the Property inspector. (Click the small up
arrow in the bottom right corner of the palette to display this section.)

• Use the Clear Column Widths and Clear Row Heights buttons to allow columns
and rows to fit the content exactly.

• Use the Convert Table Widths To Pixels button to make all cell and columns
widths sized absolutely, or use the Convert Table Widths To Percent button to
quickly make your column sized relatively so that it can resize with the browser
window.

6. Specify the thickness of the table’s lines.

In the Border box, enter a thickness for the table’s dividing lines in pixels. You can
also use the Brdr, Light Brdr, and Dark Brdr boxes in the Advanced Properties section
of the Property inspector to change the colors used to draw the dividing lines.

TIPTIPTIPTIPTIP To hide all lines in a table so that only the contents show, set the border
thickness to zero.

7. Optionally, select a background color or image for the table.

Select a background color for your table from the Color drop-down list box in the
Background section, or select the Use Background Picture check box and type the
name of the image you want to use in the text box provided. Click OK when you’re
finished.

8. Specify how much space to leave around the table.

In the V Space and H Space boxes, enter the amount of space, in pixels, to leave
around the table.

Specifying Cell PropertiesSpecifying Cell PropertiesSpecifying Cell PropertiesSpecifying Cell PropertiesSpecifying Cell Properties
You can change the properties of individual cells or a group of cells, such as a column or
a row, separately from the rest of the table. This is useful if you want the contents of
particular cells to be aligned differently, or perhaps if you want to visually set some cells
apart by giving them a different colored background. (This feature can also be used with
invisible tables to create a visual divider in a page, without the actual table showing up.)

To change the appearance of an individual cell, follow these steps:
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1. Select the cell(s) you want to modify, and open the cell properties.

Click inside a cell, and then click the <td> tag in the Tag selector to select the cell
or click the <tr> tag to select the row. Alternatively, hold down the Ctrl key while
clicking inside individual cells to select them, or move the mouse over the top of a
column or to the left of a row until the cursor turns into either a vertical or horizontal
arrow, and then click to select the whole column or row.

2. Modify the cell properties.

Cell properties are the same as those for a table, except for a couple of advanced options
that are accessible by clicking the small down arrow in the bottom right corner of
the Property inspector, as shown in Figure 6-18.

Figure 6-18 Using the Property inspector to modify a table cell.

To modify cell properties, select from the following options:

• Select the Header Cell check box if the cell is a header for the table. (This makes
the cell’s contents boldface and centered.)

• Select the No Wrap check box to force all the text inside a cell to remain on one
line, no matter how small the window size gets. (This is useful for text that
absolutely cannot wrap; use it sparingly.)

• Click the Merges Selected Cells Using Spans button to merge selected cells into
one cell.

• Click the Splits Cells Into Rows Or Columns button to split the selected cell into
two cells. Use the Split Cell dialog box to specify whether to split the cell into rows
or columns and how many cells to split it into.
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Making YMaking YMaking YMaking YMaking Your Pages Look Consistentour Pages Look Consistentour Pages Look Consistentour Pages Look Consistentour Pages Look Consistent
A Web site appears coherent and well integrated when the pages in the site are con-
sistent in look and feel. This doesn’t mean they all have to be identical. It’s good to have
some variation, and depending on the size of the site, you may want to have a couple
of different looks for your pages. However, your site has a better overall impact if your
pages use consistent colors, graphics, and page designs.

The following sections tell you how to create templates to use for quickly creating new
pages that already have the same look and feel as an existing page, use the Library palette
to reuse text and images across your site, and use external CSS files to standardize the
look of your Web pages.

Using Page TUsing Page TUsing Page TUsing Page TUsing Page Templatesemplatesemplatesemplatesemplates
Creating templates is a great way to streamline the page-creation process as well as to
help give the pages on your site a consistent look.

A template is a Web page that you can use as a sort of cookie cutter to rapidly construct
pages based on the template page. Dreamweaver’s templates contain editable regions,
which you can modify like any typical Web page, and uneditable regions, which are
locked to ensure that these regions look the same on all the pages based on the template.
In addition, when you make changes to a locked region of a template, the locked, or
uneditable, regions of all the pages that were created using that template are automati-
cally updated. This feature makes it easy to revise multiple pages on your Web site, and
it is ideal for a page header containing the company logo or a sidebar with navigation
hyperlinks.

Creating TCreating TCreating TCreating TCreating Templatesemplatesemplatesemplatesemplates
To create a template, follow these steps:

1. Create a Web page exactly how you want the template to appear.

Create a new page or open an existing one, and enter any text and images you want
to appear in the template. Format the text and colors as appropriate (or better yet,
link the page to an external CSS style sheet). You may want to insert placeholder text
and graphics in the regions you will make editable so that it’s easy to see how con-
tent should be placed in the new pages. Figure 6-19 shows an example of a typical
template page.
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Figure 6-19 Creating a template page.

2. Save the page as a template.

Choose the File menu’s Save As Template command, select the site in which you
want to save the template from the Site drop-down list box, enter the name for the
template in the Save As box, and then click Save, as shown in Figure 6-20.

Figure 6-20 Saving a page as a template.
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TIPTIPTIPTIPTIP Place all meta tags directly in the template, and the tags will then be applied
to all the pages that are created using the template. To individually modify
meta tags on a page-by-page basis, you need to manually edit the tags in the
HTML code.

3. Make editable regions.

All regions in a Dreamweaver template start out locked so that users can’t edit them
in the pages that are created using the template. To “unlock” regions and make them
editable, select a block of text, an image, a table, or a layer; choose the Modify menu’s
Templates command; and choose New Editable Region from the submenu, as shown
in Figure 6-21.

Figure 6-21 Creating a new editable region.

4. Name the editable region.

In the New Editable Region dialog box, shown in Figure 6-22, enter a name for this
editable region. The name can’t contain single or double quotation marks (‘ “ ”), angle
brackets (< >), or an ampersand (&). Click OK when you’re finished. The editable
region shows up selected in a different color.
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Figure 6-22 The New Editable Region dialog box.

TIPTIPTIPTIPTIP Creating new layers in template-created pages is a challenge if you don’t want
overlapping layers. To work around this difficulty, create all necessary layers
as editable regions in the template file itself.

Creating Pages from a TCreating Pages from a TCreating Pages from a TCreating Pages from a TCreating Pages from a Templateemplateemplateemplateemplate
To create a page using a template you made, follow these steps:

1. Choose the File menu’s New From Template command.

2. Select the site and template you want to use.

Choose the site you’re working on from the Site drop-down list box, and choose the
template from the Templates box, as shown in Figure 6-23. Click Select to create
the page.

Figure 6-23 Creating a page from a template.

TIPTIPTIPTIPTIP You can apply a template to an existing page by displaying the Templates
palette, selecting the desired palette, and clicking Apply, although this may
create an unpredictable and undesirable page layout.

3. Add content to the editable regions.

Enter content and modify it in the editable regions as if they were normal Web pages.
To select an editable region, click in the region and then click the <mm:editable> tag
in the Tag selector. You can also choose the Modify menu’s Templates command and
choose the region you want to edit from the submenu, as shown in Figure 6-24.
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Figure 6-24 Selecting an editable region in a page created with a template.

To modify a template after creating it, open the template from the Templates folder
located in the local folder of the site in which you saved the template. Dreamweaver
templates have the .dwt file extension.

Using the LibraryUsing the LibraryUsing the LibraryUsing the LibraryUsing the Library
The Library is another invaluable tool that you can use to quickly create consistent-
looking Web pages that can be easily modified en masse from a central location. The
Library tool works similarly to Dreamweaver templates.

Any object on a Web page can be placed in the Library and then easily inserted into
any other page in your Web site. Objects taken from the Library can’t be edited directly
in the Web page in which they were inserted; instead, they are edited centrally from
the Library.

Just as with Dreamweaver templates, to make a change all you need to do is edit the object
once in the Library and all the pages containing the object are then automatically
updated. This is an incredible time-saver when changing objects such as a company logo,
legal text, navigation links, or any other object that you need to use in multiple pages.
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To use the Library, follow these steps:

1. Display the Library.

Click the Assets button on the status bar, and then click the Library button in the
Assets floating palette.

2. Create a Library object.

Drag any text, image, or object currently in a Web page into the Library palette to
turn it into a Library object. (You can’t drag items from the Site window into the
Library.)

‘ 3. Name the object.

Enter a name for the Untitled object that is created in the Library, as shown in
Figure 6-25. Don’t rename any Library objects after creating them, since doing so will
break all links to the objects.

Figure 6-25 Creating a new Library object.
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4. Insert the new Library object into a page.

Display the Library, and then drag the object you want into the Web page. The object
appears in the page highlighted in yellow to indicate that it’s a Library object.

5. Edit the Library object.

Select a Library object in a Web page, and click the Open button in the Property
inspector, as shown in Figure 6-26. You can also open the Library palette, select the
object, and click the Open Library Item button at the lower right of the palette. To
delete a Library object, select the object in the Library and click the Delete button
in the palette (the trash can icon).

Figure 6-26 Editing a Library object in the Property inspector.

TIPTIPTIPTIPTIP To disconnect a Library object in a Web page from the Library—preventing
it from being centrally updated and permitting direct editing in the Web
page—select the object and click the Detach From Original button in the
Property inspector.

Using Style SheetsUsing Style SheetsUsing Style SheetsUsing Style SheetsUsing Style Sheets
Cascading Style Sheets (CSS) provide a powerful way to centralize the control of text
appearance on your Web site.

Standard Web page styles (Heading 1, Paragraph) are rather plain. To liven them up, you
can manually change the font, font size, or color of the styles, as discussed in “Step 5:
Create Your Pages.” However, applying this formatting identically to all pages in a Web
site is tedious. Additionally, if you want to make a sitewide change in the style of your
text—for example, to change your Web site’s text colors—you need to change every page
manually.

A better way to apply text formatting is to modify the styles in an external CSS file
and then link all pages to this file. Doing this causes every page linked to the CSS file
to use the same formatting that’s provided by the CSS file. Then to change the color
of Heading 1, for example, all you have to do is change the style definition in the CSS
file and all the pages using this file automatically get the new heading color.
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NOTENOTENOTENOTENOTE Browser versions older than Internet Explorer 4 and Netscape Navigator 4
cannot properly apply formatting using CSS files.

To use an external CSS style sheet to standardize the look of your Web pages, follow
these steps:

1. Open a page you want to modify.

2. Display the CSS Styles palette.

Click the Show CSS Styles button on the status bar to display the CSS Styles palette,
as shown in Figure 6-27.

Figure 6-27 The CSS Styles palette.

3. Click the Edit Style Sheet button in the CSS Styles palette.

This displays the Edit Style Sheet dialog box, as shown in Figure 6-28.

Figure 6-28 The Edit Style Sheet dialog box.
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4. Link to a style sheet.

Click the Link button. In the Link External Style Sheet dialog box, shown in Fig-
ure 6-29, enter the name for your new style sheet and click OK, or click Browse to
locate an existing style sheet (.css file).

Figure 6-29 The Link External Style Sheet dialog box.

5. Select the style, and click Edit.

This displays a similar dialog box named after your style sheet.

6. Click New to create or modify a style.

This displays the New Style dialog box, as shown in Figure 6-30.

Figure 6-30 The New Style dialog box.

7. Create a new style or modify an existing style.

In the New Style dialog box, create a new style or modify existing styles, such as
Heading 1 and Paragraph, as described below. Click OK to continue.

• To make a new style, click the Make New Style option button and enter a name
for the style in the Name box.

• To modify an existing HTML tag, click the Redefine HTML Tag option but-
ton and select the tag from the Tag drop-down list box.

8. Define the style.

In the Style Definition dialog box, shown in Figure 6-31, customize your new style
or modify the formatting of the existing HTML tag you selected. Click OK when
you’re finished.
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Figure 6-31 The Style Definition dialog box.

9. Create or modify additional styles, and then click Save.

Click Done in the Edit Style Sheet dialog box to return to the Dreamweaver Docu-
ment window. The styles you created or modified are applied to the currently open
page.

10. Link other pages to the style sheet.

Open any other pages that you want to use the style sheet, and follow steps 2 through
4 to link the style sheet to the pages.

Ensuring Proper Display of YEnsuring Proper Display of YEnsuring Proper Display of YEnsuring Proper Display of YEnsuring Proper Display of Your Pagesour Pagesour Pagesour Pagesour Pages
It’s important that your Web pages display properly in your visitors’ Web browsers,
regardless of the browser type and version they’re using and what screen resolution
they’re running. The following sections help you tailor your pages to display properly
in a wide range of environments.

Making YMaking YMaking YMaking YMaking Your Pages Compatible with Multiple Browsersour Pages Compatible with Multiple Browsersour Pages Compatible with Multiple Browsersour Pages Compatible with Multiple Browsersour Pages Compatible with Multiple Browsers
Your Web site needs to be accessible to your audience no matter what type of Web
browsers they’re using, because if it isn’t, they’ll move on to some other company’s site.

Dreamweaver can test your pages for potential Web browser compatibility problems,
redirect visitors with a particular browser version to an alternative version of your home
page, and convert any pages that use layers into pages that are compatible with version
3 browsers.
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TTTTTesting Pages for Browser Compatibilityesting Pages for Browser Compatibilityesting Pages for Browser Compatibilityesting Pages for Browser Compatibilityesting Pages for Browser Compatibility
To test a Web page for compatibility problems, follow these steps:

1. Open the Site window.

2. Select the pages you want to check for compatibility problems.

Select the pages that you want to check by holding down the Ctrl key and clicking
each page, as shown in Figure 6-32. Alternatively, hold down the Shift key, click the
first file in a list, and then click the last file to select every file in between. (You can
also press Ctrl-A to select all files.)

Figure 6-32 Selecting pages to check for compatibility problems.

3. Choose the File menu’s Check Target Browsers command.

4. Choose the browser versions you want to support.

In the Check Target Browsers dialog box, shown in Figure 6-33, select the browser
versions you want to check for compatibility problems. To make multiple selections,
hold down the Ctrl key when clicking on browser versions. Click the Check button
to perform the compatibility test.
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Figure 6-33 The Check Target Browsers dialog box.

5. Review the compatibility report.

Dreamweaver examines your selected files and issues a report, as shown in Figure 6-34.
At the top of the report is a listing of how many errors and warnings were found for
each browser version. Scroll down to view each error, the line number on which it’s
found (in the actual HTML), and the tag containing the error.

Figure 6-34 A compatibility report.
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6. If necessary, edit your pages.

If you want to view or change the line of your Web page with an error or warning,
open the page, click the Show Code And Design View toolbar button, click the View
Options toolbar button, and then select Show Line Numbers from the pop-up menu.
Select the offending line to see the object highlighted in the Document window, as
shown in Figure 6-35.

Figure 6-35 Viewing an incompatible object in HTML view in the Document window.

Redirecting Visitors with Old BrowsersRedirecting Visitors with Old BrowsersRedirecting Visitors with Old BrowsersRedirecting Visitors with Old BrowsersRedirecting Visitors with Old Browsers
Dreamweaver allows you to redirect visitors with older browsers to a version of your Web
page that supports their browser. This is done by inserting a special behavior for the
Web page that detects the visitor’s browser version.
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You should carefully consider whether this makes sense for your company or organi-
zation. The advantage of redirecting visitors with old browser versions is that you can
make Web pages that optimally target newer browsers without worrying about the pages
displaying improperly in older browsers. The disadvantage is that redirecting visitors
can double the number of pages that you need to create and keep updated.

An alternative to this situation is to make multiple versions of your home page. You can
create a blank home page that detects visitors’ browser versions and redirects them to
the appropriate version of your home page. This saves visitors from having to wait while
your home page loads, only to be redirected to your alternative home page where they
have to wait again while that page loads.

To create your alternative home page that redirects visitors based on the browser ver-
sion they’re using, follow these steps:

1. Create and save a blank page.

Create a new blank page, making sure that the page background is the same color as
your main home page. You’ll also want to title this page and insert the same Key-
words and Description meta tags so that search engines can still properly locate your
page, as discussed in the earlier section “Preparing Your Home Page for Search
Engines.”

2. Select the entire page.

Click the <body> tag on the Tag selector to select the body of the page.

3. Add the Check Browser behavior.

Display the Behaviors palette (if not already visible), click the plus sign, and choose
Check Browser from the pop-up menu, as shown in Figure 6-36.
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Figure 6-36 Adding the Check Browser behavior to a Web page.

4. Specify where to send new browsers.

In the Check Browser dialog box, shown in Figure 6-37, click the Browse button
next to the URL box to specify the main home page to which you want to redirect
visitors with new browsers. Use the Select File dialog box to select the appropriate
page.

Figure 6-37  The Check Browser dialog box.
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5. Specify where to send old browsers.

In the Check Browser dialog box, click the Browse button next to the Alt URL box
to specify the alternative home page to which you want to redirect visitors with old
browsers. Use the Select File dialog box, shown in Figure 6-38, to select the appro-
priate page.

Figure 6-38  The Select File dialog box.

6. Set up redirection in the two pages.

Set up each alternative home page to redirect visitors with the incorrect browser version
to the other version of the home page. To do so, repeat steps 2 through 5 for each
page, with the exception that in the Check Browser dialog box, select Stay On This
Page for the browser version for which the page is designed. For example, if the page
was designed for version 4 browsers, select Stay On This Page from the Or Later drop-
down list boxes, as shown in Figure 6-39.

Figure 6-39 The redirection settings for the main home page.
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TIPTIPTIPTIPTIP Dreamweaver can easily convert Web pages that use layers into Web pages
that use tables, making the pages compatible with older browsers. To do so,
first make sure that all content is in layers, and that there aren’t any nested
layers. Then choose the Modify menu’s Layout Mode command, and choose
Convert Layers To Table from the submenu. To convert a page that uses CSS
styles back to normal HTML, choose the File menu’s Convert command and
choose 3.0 Browser Compatible from the submenu.

Making YMaking YMaking YMaking YMaking Your Home Page Resolution-Independentour Home Page Resolution-Independentour Home Page Resolution-Independentour Home Page Resolution-Independentour Home Page Resolution-Independent
Your Web site is going to be viewed at many different screen resolutions and window
sizes, so it’s important that your home page (and entire site) look good at the widest
possible range of sizes. Some visitors will be browsing with old computers running their
display at 640x480, some will be using giant monitors at 1600x1280 resolution, and
some will even be using a TV-based Web appliance, possibly running at 544x372
resolution. Figure 6-40 shows a resolution-independent Web page at 640x480 reso-
lution; Figure 6-41 shows the same page at a fairly typical 1024x768 resolution.

Figure 6-40 A Web page that looks good at 640x480 resolution.
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Figure 6-41 The same page, scaling well to a higher resolution of 1024x768.

Dreamweaver makes it easy to preview how your Web pages will look at different reso-
lutions. Simply click the Window Size display on the status bar and select a resolution
from the pop-up menu. Dreamweaver adjusts its window size to match the typical
viewable area that visitors will have in their Web browsers when viewing your page.

Thus, if visitors have their monitors set to 800x600 resolution and have their Web
browser windows maximized (filling the screen), typically only 760x420 resolution will
be available for viewing pages, after accounting for the Web browser’s menu bar, sta-
tus bar, and toolbars.

Here are some recommendations for making your site look good at all these resolutions:

• Don’t overload your home page and other pages with so much content that the pages
are wider than a 640x480 screen. It’s okay to have long pages so that users have to
scroll down, but users should never have to scroll from side to side.

• Make sure that your graphics aren’t too wide to fit in a 640x480 screen (or 544x372
for WebTV support).
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• Don’t press the Enter key at the end of each line of text. Dreamweaver automatically
wraps lines as appropriate for a given window size unless you force line breaks by
pressing Enter at the end of a line. Allowing Dreamweaver to wrap the lines makes
your pages adapt well to both higher and lower resolutions.

• If you need to force a line break, but don’t want to create a new paragraph, press Shift-
Enter to insert a line-break tag (<br>).

• When creating tables, use Dreamweaver’s Autostretch feature to permit columns to
shrink and expand in size.

• When creating tables, also consider using the Clear Cell Heights command (acces-
sible the same way the Autostretch feature is accessed in Layout view) to make cells
only as high as the content they contain.

• If you’re creating tables in Standard view, specify the table size in percentage, not
in pixels. This allows the table to grow in size to fill large-size windows.

• When creating layers, try to size your main body text layer relatively by using a
percentage, for example, 85% width. You’ll have to tinker a bit, since other layers will
be sized absolutely, but using percentage allows the main part of your page to grow
and shrink with window size.

• Size horizontal lines in percentage, not in pixels.

• Test your pages at high and low resolutions and with a variety of different window
sizes. You can use the Window Size feature of the status bar to resize the
Dreamweaver window to reflect different screen resolutions, but you should also
preview your pages in a Web browser.

SummarySummarySummarySummarySummary
In this step, we showed you some specific techniques you can use to make your Web
pages more effective. This included ways to sharpen up your home page by improving
site navigation and increasing visual appeal, as well as how to make all the pages in your
Web site consistent in appearance and how to create advanced page layouts using lay-
ers and tables.
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Step 7

DEPLOY YOUR WEB SITEDEPLOY YOUR WEB SITEDEPLOY YOUR WEB SITEDEPLOY YOUR WEB SITEDEPLOY YOUR WEB SITE

Featuring:Featuring:Featuring:Featuring:Featuring:

• Testing Your Web Site

• Publishing Your Web Site

• Publicizing Your Web Site

• Monitoring Your Web Site

After you create your Web site with Dreamweaver, you need to perform several
 important tasks as part of deploying the site. You want to test that everything

works properly; you need to publish your site’s pages to the server; you need to pro-
mote your site to generate traffic; and you need to monitor your site on an ongoing basis,
keeping track of the number and type of visitors and collecting any forms results.

TIPTIPTIPTIPTIP It’s important to revise your Web site frequently to keep the content fresh and
up-to-date. To do so, simply open and edit your pages as described in “Step 5:
Create Your Pages.” Consider assigning this task to a staff person to perform
on a daily, weekly, or as-necessary basis.
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TTTTTesting Yesting Yesting Yesting Yesting Your Wour Wour Wour Wour Web Siteeb Siteeb Siteeb Siteeb Site
Testing before publishing your Web site can result in fewer complaints from visitors
as well as a more effective site.

Here are some recommendations for Web site tests:

• Check your site for broken hyperlinks.

• Check your site for poorly coded pages.

• Test your site with different Web browsers.

• Perform usability testing with users who haven’t yet seen your site.

TIPTIPTIPTIPTIP You should also make sure that none of your pages require too much time
to download. Unfortunately, Dreamweaver provides no centralized method
of doing this, so you’ll have to open each page manually and check the
download time indicator on the status bar.

TTTTTesting and Fixing Hyperlinksesting and Fixing Hyperlinksesting and Fixing Hyperlinksesting and Fixing Hyperlinksesting and Fixing Hyperlinks
Broken hyperlinks, the scourge of Webmasters everywhere, can be easily vanquished
using a couple of tools provided by Dreamweaver. The first is the Check Links Sitewide
command that allows you to check the status of all hyperlinks in your site. The second
is the Change Link Sitewide command, which you can use to change all occurrences
of a hyperlink to a new address.

Checking HyperlinksChecking HyperlinksChecking HyperlinksChecking HyperlinksChecking Hyperlinks
Although Dreamweaver generally does an admirable job of maintaining valid hyperlinks
as you move and rename filenames, it’s not perfect, and inevitably broken hyperlinks
creep into your Web site. You can use Dreamweaver to check individual Web pages for
broken hyperlinks, or you can check your entire site all at once.

To check your hyperlinks, follow these steps:

1. Open the Site window.

Click the Show Site button on the right side of the status bar to display the Site
window.

2. Choose the Site menu’s Check Links Sitewide command, as shown in Figure 7-1.

Alternatively, select one or more pages in the Local Folder pane or Site Map and choose
the File menu’s Check Links command to test hyperlinks only in the selected pages.
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Figure 7-1 Using the Check Links Sitewide command.

3. Review the broken links.

In the Link Checker dialog box, shown in Figure 7-2, review the list of broken
hyperlinks. The Files heading shows which files contain broken hyperlinks, and the
Broken Links heading displays the incorrect hyperlinks.

Figure 7-2 The Link Checker dialog box.
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4. Fix broken links.

Double-click a file in the Files column to open it and edit it directly. You can also
select the file, click the broken link next to it, and type in the correct link, or click
the small folder icon that appears to the right of the broken link to locate the cor-
rect file.

TIPTIPTIPTIPTIP Use the Change Link Sitewide command, discussed in the following section,
to change a broken link that appears multiple times on your pages.

5. View orphaned files.

Choose Orphaned Files from the Show drop-down list box in the Link Checker to
display a list of files that haven’t been linked to on your site. Although orphaned files
don’t affect visitors, they can take up extra server space. If you are running out of space
on your Web server, look for orphaned files to delete.

6. View external links.

External links, or hyperlinks to locations outside of your own Web site, frequently
break as the Web sites you link to reorganize their sites or go out of business. To view
a list of external hyperlinks so that you can check their validity, choose External
Hyperlinks from the Show drop-down list box in the Link Checker. Unfortunately,
you’ll have to test the links manually by entering them in a Web browser.

7. Optionally, save the report.

To save the Link Check report as a tab-delimited text file that you can import into
a spreadsheet program such as Microsoft Excel, click Save, enter a name ending with
the .txt file extension in the File Name box, and click Save.

Changing HyperlinksChanging HyperlinksChanging HyperlinksChanging HyperlinksChanging Hyperlinks
Dreamweaver lets you easily change all instances of a hyperlink in your Web site, which
can be particularly valuable for fixing broken hyperlinks. This feature can also be handy
when you want to update a link to point to new content. For example, if you have a
monthly column, you could easily change all “Current Month” hyperlinks to point to
the new month’s column instead of the previous month’s column.

To use this feature, follow these steps:
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1. Open the Site window.

Click the Show Site button on the right side of the status bar to display the Site
window.

2. Select the link you want to change.

Optionally, select a file from the Site Map or the Local Folder pane from which you
want to divert hyperlinks.

3. Choose the Site menu’s Change Link Sitewide command.

4. Select the hyperlink to change.

In the Change All Links To box of the Change Link Sitewide dialog box, shown in
Figure 7-3, enter the link you want to change, or click the folder icon to select the
file from which you want to divert links.

Figure 7-3 The Change Link Sitewide dialog box.

5. Enter the new hyperlink.

Enter the new hyperlink in the Into Links To box, or click the folder icon to select
the file to which you want to make all new links.

6. Click OK, and select the pages to update.

Dreamweaver displays the Update Files dialog box, as shown in Figure 7-4. Select
the pages you want to update (hold down the Ctrl key while clicking to select
multiple pages), and then click Update. Dreamweaver processes the selected files,
changing each hyperlink.

Figure 7-4 The Update Files dialog box.
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NOTENOTENOTENOTENOTE When replacing hyperlinks, Dreamweaver uses the addressing format used
by the hyperlink it replaces on a page-by-page basis. Thus, if your index.htm

links to your contact.htm page using a document relative address, this for-
mat will be maintained, as will the site-root relative address used by a differ-
ent page. The Relative To drop-down list box available in the Select Link To
Change dialog box has no effect on the links replaced using the Change Link
Sitewide command. For more information on addressing, see “Appendix B:
An Introduction to HTML.”

TTTTTesting Yesting Yesting Yesting Yesting Your Site in Difour Site in Difour Site in Difour Site in Difour Site in Different Browsersferent Browsersferent Browsersferent Browsersferent Browsers
Dreamweaver does a pretty accurate job of portraying your Web pages as they will appear
in a Web browser. However, your Web site might look drastically different when dis-
played in another company’s Web browser or on a non-PC platform, such as WebTV.
In order to confirm that your Web site is functional and effective for all your visitors,
you need to test your site using several different browsers.

The easiest way to test your site in several browsers is to open each Web browser using
Dreamweaver’s Preview In Browser command. If you have Web browsers installed on
your computer that don’t appear in the Preview In Browser list, you should add them
to this list. The following sections show you how to do these tasks.

TIPTIPTIPTIPTIP In addition to     previewing your Web pages in a number of browsers, you should
also run a browser compatibility check using Dreamweaver’s Check Target
Browsers feature, as discussed in “Step 6: Polish Your Pages.”

Previewing WPreviewing WPreviewing WPreviewing WPreviewing Web Pageseb Pageseb Pageseb Pageseb Pages
To preview a Web page you’ve created in Dreamweaver, open the page, choose Preview
In Browser from the File menu, and then choose a browser from the submenu. Figures
7-5, 7-6, 7-7, and 7-8 show a Web page created in Dreamweaver, as displayed in
Microsoft Internet Explorer 5.5, Netscape 6, Netscape Navigator 4.75, and Opera 5.
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Figure 7-5 A Web page as it appears in Internet Explorer 5.5.

NOTENOTENOTENOTENOTE Test your Web site with the latest versions of Internet Explorer and Netscape
Navigator. If you have access to computers running older versions of the
browsers or a different browser, such as Opera, consider testing your site in
these browsers, too. Testing on Macintosh and information appliances (such
as WebTV) is usually easiest to do after your site has been published to the
Internet.
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Figure 7-6 The same Web page in Netscape 6.
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Figure 7-7 The same Web page in Netscape Navigator 4.75.
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Figure 7-8 The same Web page in Opera 5.

After opening your Web site in a couple of browsers, spend a few minutes testing all
the links and examining each page. Is the layout consistent on all the browsers? Do
all the features work as expected? Make notes on which pages have problems, and then
go back into Dreamweaver and see whether you can fix them.

Adding Browsers to the Preview In Browser ListAdding Browsers to the Preview In Browser ListAdding Browsers to the Preview In Browser ListAdding Browsers to the Preview In Browser ListAdding Browsers to the Preview In Browser List
If your Web browsers aren’t set up to work with Dreamweaver’s Preview In Browser
command, then follow these steps:

1. Open the Preferences dialog box.

From the Dreamweaver Document window, click the Preview/Debug In Browser
toolbar button, and then choose Edit Browser List from the pop-up menu, as shown
in Figure 7-9.
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Figure 7-9 Choosing the Edit Browser List command.

2. Add your browser.

Click the plus sign in the Preview In Browser section of the Preferences dialog box,
as shown in Figure 7-10.

Figure 7-10 The Preferences dialog box.
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3. Specify your browser settings.

In the Add Browser dialog box, shown in Figure 7-11, enter the name of the browser,
and then click Browse to locate the program file for your browser. Select the Primary
Browser check box to make this your default browser in Dreamweaver, or select the
Secondary Browser check box to make the browser your secondary browser. (The
primary and secondary browsers have their own hotkeys you can press to quickly
preview your page in the browser.)

Figure 7-11 Adding a browser to the Preview In Browser list.

4. Modify the browser list.

In the list of browsers (see Figure 7-10), select a browser and click Edit to change
the browser’s display name. To delete a browser from the list, select it and click the
minus sign. To preview Web pages using your computer’s Web server (if you have
a Web server such as Internet Information Server installed on your computer), select
the Preview Using Local Server check box.

NOTENOTENOTENOTENOTE Using the Preview Using Local Server check box will enable some Web pages
to preview more accurately (images and links that might not work otherwise
often do when previewed this way); however, some things don’t work as well,
such as site-root relative hyperlinks. The best way to test a Web site is to publish
it to a Web server—either on the company network or on the Internet—and
then test the pages there.

Usability TUsability TUsability TUsability TUsability Testingestingestingestingesting
In addition to testing for broken links and browser incompatibilities, you’ll find it
informative to perform some degree of usability testing. Here are some ideas for simple
usability tests:

• Recruit people who aren’t involved in the Web site project to test your site. The feed-
back of your customers or other people in your target audience can be invaluable in
evaluating the effectiveness of your site. For very small organizations, even recruiting
family and friends to test your site can provide valuable feedback.
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• Develop some purposeful tasks for your testers to perform, and then watch how they
accomplish them. You might use tasks such as “find the company contact informa-
tion” or “find the product information for product x.” If you need to interject and
help the testers, your site might need more work.

• Pay special attention to the navigational structure of your Web site. How well can
users locate information using your site? (See “Step 3: Collect and Organize Your
Content” and “Step 6: Polish Your Pages” for more information on creating an ef-
fective navigational structure.)

• Test your Web site at a variety of resolutions. (See “Step 6: Polish Your Pages” for
more information on creating resolution-independent Web pages.) We recommend
that you test your site at 640x480 (a fairly low resolution) and at 1024x768 (a typical
high resolution).

• If you decide to publish your site immediately, perform the testing after it is pub-
lished. A short user survey on your Web site can also be a valuable way of gathering
feedback on the effectiveness of your site.

NOTENOTENOTENOTENOTE If your site contains online ordering capabilities, it is very important to thor-
oughly test your system no matter what the size of your company or Web site.
For more information about online ordering, see “Appendix D: Creating Web
Stores.”

Publishing YPublishing YPublishing YPublishing YPublishing Your Wour Wour Wour Wour Web Siteeb Siteeb Siteeb Siteeb Site
When you’re ready to make your Web site available to the general public on the World
Wide Web, you need to publish it to the Internet. Publishing your site to your Web
hosting company’s Web server is easy. To do this, follow these steps:

1. Open the Site window.

Click the Show Site button on the right side of the status bar to display the Site
window, as shown in Figure 7-12.



184184184184184 New Webmaster’s Guide to Dreamweaver 4 - Electronic Edition

Figure 7-12 The Dreamweaver Site window.

2. Connect to your remote site.

Click the Connect toolbar button to connect to your remote site. (You might need
to connect to the Internet first.) The contents of the remote site are displayed in the
Remote Site pane.

3. Choose the Site menu’s Synchronize command.

To manually publish only a few files, select the files and click the Put toolbar but-
ton. To retrieve a few files from the remote site, select them and click the Get toolbar
button.

4. Specify how many files to synchronize.

In the Synchronize drop-down list box, select Entire Site to synchronize all files in
the site or select Selected Files Only to synchronize only the currently selected files
in the local folder or remote site, as shown in Figure 7-13.
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Figure 7-13 The Synchronize Files dialog box.

5. Specify a direction in which to transfer files.

In the Direction drop-down list box, select Put Newer Files To Remote to publish
only new files from the local folder to the remote site. Alternatively, select Get Newer
Files From Remote to retrieve only new files from the remote site, or select Get And
Put Newer Files to synchronize the remote site and local folder with each other,
downloading and uploading the newest files. Select Delete Remote Files Not On
Local Drive if you want to remove orphaned files from the remote site, freeing up
some server space.

6. Click Preview.

Dreamweaver checks the remote site and local folder to see which files are newest,
and then displays the Site dialog box, as shown in Figure 7-14.

Figure 7-14 Selecting which files to synchronize.

NOTENOTENOTENOTENOTE If you get an error message, you may need to reconnect to your remote site,
because many FTP servers will timeout if you take too long after connecting
to do something.
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7. Select the files to synchronize.

In the Site dialog box clear the check boxes for any files you don’t want to synchro-
nize, and then click OK. Dreamweaver synchronizes the files and displays the re-
sults in the Site dialog box.

WWWWWARNINGARNINGARNINGARNINGARNING All the users who work on your Web site should make sure that their
computer clocks are synchronized; otherwise, it’s possible that one user
could overwrite changes made by another.

Publicizing YPublicizing YPublicizing YPublicizing YPublicizing Your Wour Wour Wour Wour Web Siteeb Siteeb Siteeb Siteeb Site
In order for your Web site to succeed, you need to publicize it. There are a number of
ways to publicize your site, both on and off the Internet. The online methods include
search engines, online advertising, newsgroups, and mailing lists. Offline methods
include placing links on all print material your company or organization creates, Yel-
low Pages ads, and newspaper ads. These methods are discussed in greater detail in the
sections that follow.

TIPTIPTIPTIPTIP One form of publicity that we don’t cover here is word of mouth. This is not
a method to underestimate. The best way to stimulate positive publicity via
word of mouth is to have high-quality, timely content on your Web site.

Submitting YSubmitting YSubmitting YSubmitting YSubmitting Your Site to Search Enginesour Site to Search Enginesour Site to Search Enginesour Site to Search Enginesour Site to Search Engines
Since most people locate a Web site using a search engine, the most important step you
can take to publicize your site is to submit it to the top search engines. Although this
process takes some time, it is very important.

TIPTIPTIPTIPTIP Avoid using a search engine submission service. These services usually offer to
submit your site to hundreds of search engines for a sum of money—some-
times with recurring fees. Since the vast majority of searches are conducted
on only a handful of search engines, this level of submission is superfluous.
In addition, submission firms usually don’t submit your site to directory-based
search engines, or if they do, they do an inadequate job of it. Take the time
to submit to search engines yourself—it’s worth it.
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Understanding Search ServicesUnderstanding Search ServicesUnderstanding Search ServicesUnderstanding Search ServicesUnderstanding Search Services
Before you start submitting to search engines, it helps to understand them. There are
three types of search engines: crawler-based search engines, directories, and the hybrid
search engine, which is a combination of the first two.

Crawler-based search engines automatically crawl (explore) the Web, examining Web
sites and adding the relevant information from each site into their search databases.

Directories such as Yahoo! take descriptions submitted by Web site authors and use
human editors to review the submissions. The editors then create a hierarchical, topic-
based directory out of the Web sites submitted that visitors can either browse by topic
or perform a search on.

Hybrid search engines are usually search engines that also contain a human-created
directory. Editors create the directory by looking at the search engine’s results, the actual
Web sites, and sometimes sites that are submitted by site authors to the hybrid direc-
tory.

NOTENOTENOTENOTENOTE A few search services don’t fit neatly into the crawler-based, directory, or
hybrid categories. For example, Ask Jeeves (www.askjeeves.com) uses a natural-
language-processing search engine that searches a human-created database of
Web sites. Mamma.com is a metasearch engine—a search engine that performs
searches on a number of other search engines.

Submitting to Search EnginesSubmitting to Search EnginesSubmitting to Search EnginesSubmitting to Search EnginesSubmitting to Search Engines
The type of search engine determines how you’ll submit your site. Crawler-based search
engines generally request only your Web site’s URL, as shown in Figure 7-15. The
search engine then automatically visits your site, determines the content of your site,
and adds it to the search engine’s database.
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Figure 7-15 Submitting to a crawler-based search engine.

TIPTIPTIPTIPTIP Although search engines generally look into your Web site for content on
pages other than your home page, you can’t always count on this, so it’s a
good idea to submit your two or three most important pages separately to
each search engine. (Make sure each of these pages has Description and
Keywords meta tags inserted and a good title.) But limit yourself to two or
three pages; submitting too many pages to the same search engine can
actually cause a search engine to exclude your site.

Directory-style search engines require a greater amount of effort for submission. First,
visit the directory (such as Yahoo!) and perform some searches for content similar to
that of your Web site.

Second, take note of the kinds of sites that are returned in the search results and the
categories under which they’re listed. It’s very important with directories to find the
most specific and appropriate category for your site, so do some exploring. (Your site
may belong in multiple categories. If this is the case, note each one.)
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Third, read the directory’s Site Submission Tips or the equivalent page for the proce-
dure the directory wants you to follow when submitting your site. Most require that
you navigate to the category under which you want to list your site, and then click the
Suggest A Site link. Fourth, in the actual submission form, as shown in Figure 7-16,
submit the title of your Web site (generally your official business or company name),
your site’s URL, and a 25-word-or-less description of your site.

Figure 7-16 Submitting to Yahoo!’s directory.

TIPTIPTIPTIPTIP Make your site description more than just a series of keywords. It should be
a succinct, well-written summary of what visitors will find on your site.
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Table 7-1 lists search engines that we recommend you submit your site to, their URLs,
and their type.

SEARCH ENGINESEARCH ENGINESEARCH ENGINESEARCH ENGINESEARCH ENGINE URLURLURLURLURL SEARCH ENGINE TYPESEARCH ENGINE TYPESEARCH ENGINE TYPESEARCH ENGINE TYPESEARCH ENGINE TYPE

AOL Search search.aol.com Hybrid using Open Directory

AltaVista www.altavista.com Hybrid using Open Directory and
Looksmart

Direct Hit www.directhit.com Crawler-based, modified by popularity

Excite www.excite.com Crawler-based

Go/Infoseek www.go.com Hybrid

Google www.google.com Crawler-based, modified by popularity

HotBot www.hotbot.com Hybrid, with results from Direct Hit
and Open Directory

LookSmart www.looksmart.com Directory

Lycos www.lycos.com Hybrid, using Open Directory

MSN Search search.msn.com Hybrid, using LookSmart

Netscape Search search.netscape.com Hybrid, using Open Directory

Northern Light www.northernlight.com Crawler-based

Open Directory dmoz.org Directory

Snap www.snap.com Directory

WebCrawler www.webcrawler.com Crawler-based

Yahoo! www.yahoo.com Directory

Table 7-1 The major search engines.

Online AdvertisingOnline AdvertisingOnline AdvertisingOnline AdvertisingOnline Advertising
In addition to submitting your Web site to search engines, a number of other meth-
ods are available for advertising on the Web. Some of these are fairly effective in increasing
the number of visitors to your Web site, and some are probably a waste of time and
money. In the following sections, we offer some recommendations on which methods
to consider and which to avoid.
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TIPTIPTIPTIPTIP A clever technique to use when advertising your Web site is to create special
pages for each ad and send prospective customers to these pages instead of
your standard home page. This allows you to include information relevant to
the ad’s message right on the first page that visitors will see. This also facili-
tates a way of gauging the success of the ads. Because these pages can be
reached only from your ads, monitoring the number of hits these unique
pages get tells you how successful the ads are.

Purchasing Banner AdsPurchasing Banner AdsPurchasing Banner AdsPurchasing Banner AdsPurchasing Banner Ads
The most obvious method of online advertising is the banner ad. Banner ads are the
ubiquitous (and often disregarded) rectangular ad boxes that adorn most Web sites.

In general, we recommend that you avoid paying for banner ads. They require too much
time and effort to create, cost money, and are limited in their ability to draw visitors
to your Web site.

However, if there are any prominent Web sites that draw your target audience (such
as sites that cover topics related to your company or organization), it may be advanta-
geous to purchase a banner ad. Consider hiring a graphics professional to design your
ad if you go this route.

Purchasing Ads on E-Mail NewslettersPurchasing Ads on E-Mail NewslettersPurchasing Ads on E-Mail NewslettersPurchasing Ads on E-Mail NewslettersPurchasing Ads on E-Mail Newsletters
If there are any e-mail newsletters that reach your target audience, consider purchas-
ing an ad to be included in the newsletter. Newsletters reach targeted, interested au-
diences, which are two things that can make your ad more effective. Since e-mail
newsletters usually contain minimal graphics, any ad you place in a newsletter will most
likely be text-only, which greatly reduces the cost of creating the ad. If advertising on
an e-mail newsletter sounds appealing to your company or organization, use www.list-
universe.com to search for an appropriate newsletter, and then subscribe to it and read
it to make sure that it’s suitable. If so, contact the newsletter’s operator to negotiate prices
for an ad. (Don’t just reply to the newsletter though, make sure to locate the correct
contact address.)

TIPTIPTIPTIPTIP While the most established newsletters, like high-caliber Web sites, won’t
negotiate much (if at all) on ad prices, smaller newsletters often will. Do some
research and see what similar newsletters are charging, and make the news-
letter an offer.
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Link Exchanges and WLink Exchanges and WLink Exchanges and WLink Exchanges and WLink Exchanges and Web Ringseb Ringseb Ringseb Ringseb Rings
One of the best methods of advertising online is to get other Web sites to link to your
site, creating what’s known as a link exchange. This method is cost-effective (free) and
can also increase your ranking in search engines that pay attention to the number of links
to a particular Web site.

There are three ways that you can establish links to your company or organization’s site.
First, use a Link Exchange service that allows you to exchange links with other random
Web sites; second, join a Web ring of sites that are similar to your own; and third,
contact Web sites personally and inquire about exchanging links.

Link Exchange services often don’t work well for most companies and organizations.
This is because the site that ends up linking to yours frequently doesn’t have anything
to do with your site’s purpose, so it is unlikely to generate visitors who are interested
in viewing your site.

Web rings devoted to a topic covered by your Web site are an effective means of attracting
traffic to your site. The way a Web ring works is that Web sites with a common topic
contact each other, decide to set up a Web ring, and then pay to place a banner ad for
the Web ring on their home pages, as shown in Figure 7-17. This banner ad is usually
configured with automatically updated links to other sites in the Web ring. By join-
ing the Web ring, your site becomes accessible through these links and is also listed in
the Web ring’s directory. The site www.webring.com is a good place to look if you are
interested in joining a Web ring.
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Figure 7-17 A Web site with a couple of Web ring ads.

Contacting Web sites personally by manually identifying sites that are complemen-
tary to your target audience’s interests is an effective way of advertising online. Once
you’ve identified Web sites that cover similar or related topics, contact the sites’
Webmasters about setting up a link exchange.

TIPTIPTIPTIPTIP One way to convince a Web site to exchange links is to place a link to their
site on your Web site, send them an e-mail informing them of this, and then
suggest that they link to your site as well.
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Using Newsgroups to Gain ExposureUsing Newsgroups to Gain ExposureUsing Newsgroups to Gain ExposureUsing Newsgroups to Gain ExposureUsing Newsgroups to Gain Exposure
Newsgroups in general aren’t the best place to publicize a Web site. Newsgroup par-
ticipants usually react negatively to ads placed on newsgroups, and the dynamic nature
of newsgroups ensures that anything your company or organization posts will stay up
for only a couple of weeks before getting deleted.

Having said this, you can effectively use newsgroups to publicize your Web site if you’re
careful about how you do it. Start by locating a newsgroup that deals with issues re-
lated to your company or organization’s line of business and then posting some legiti-
mate articles, such as tips or responses to questions other newsgroup members have.
Make sure to include your Web site’s URL and a brief description of your site in the
signature for all posts you make. Being an active and positive participant in a newsgroup
can reflect well on your company or organization and also bring additional visitors to
your site—just be careful to avoid posting ads.

TIPTIPTIPTIPTIP To find a suitable newsgroup, conduct a search on Deja.com at http://

www.deja.com/usenet.

Creating a Mailing ListCreating a Mailing ListCreating a Mailing ListCreating a Mailing ListCreating a Mailing List
Mailing lists are a voluntary form of bulk e-mailing that allows a company or organi-
zation to easily send out mail, such as a newsletter or update, to a large number of
people. Sending regular e-mails about your Web site or company to visitors who have
joined your mailing list is an effective way of reminding visitors about your company
and also featuring new or changed parts of your Web site. This increases the chances
that they will visit your site again.

NOTENOTENOTENOTENOTE Make sure that what you send via your mailing list is valuable content to
subscribers. Otherwise, your subscribers will delete the message or unsubscribe
from your list. This content can include tips, how-to sections, product spe-
cials, and new additions to your Web site. Always include instructions for
unsubscribing to the list with every message you send.

You can handle mailing lists using three different types of mailing programs: a stan-
dard mail program, a standalone bulk mail program, or a server-based mailing list
program.



Step 7Step 7Step 7Step 7Step 7    Deploy Your Web Site 195195195195195

TIPTIPTIPTIPTIP Whichever method you use to send your messages to mailing list members,
consider creating a form on your Web site that visitors can use to subscribe
to your mailing list. Many mailing list providers will give you code to use;
otherwise, consider hiring a consultant to set up forms on your site.

You can use a standard e-mail program, such as Microsoft Outlook or Outlook Express,
to send mail to everyone on your list, provided the number of subscribers is small. To
use Outlook or Outlook Express, create a separate folder in your Contacts folder or
Address Book for the mailing list subscribers, create a contact for each subscriber, and
then add each user to the BCC field of a new mail message. This method is inconve-
nient and slow, but it is relatively simple to set up and it can work well for a beginning
mailing list. Most companies and organizations will find themselves quickly outgrowing
it, however.

NOTENOTENOTENOTENOTE Some Internet service providers limit the number of people you can send an
e-mail message to at one time. If you have more than 100 people to e-mail,
consider using a standalone bulk mailer or a server-based system.

Another method is to use a standalone bulk mailer program, such as Aureate Group
Mail (http://www.group-mail.com). Bulk mail programs are specially designed for
sending out an e-mail message to a large number of mailing list subscribers. These
programs are generally inexpensive ($50 is a typical price) and are an appropriate option
for companies or organizations that don’t require the complexity of a server-based
mailing list solution (as described below).

The most sophisticated and complicated method of creating a mailing list is to use a
server-based mailing list program, such as L-Soft’s Listserv (www.lsoft.com) or Major-
domo. Both of these programs are typically provided to you by your Web hosting
company for an additional monthly fee—starting at roughly $15 per month for a small
number of subscribers. One advantage of using a server-based solution is the ability to
allow users to subscribe and unsubscribe from the mailing list themselves, although this
advantage is partially offset by the difficulty of configuring and maintaining the mailing
list. If your company or organization finds itself outgrowing bulk mail programs though,
a server-based mail program can be an excellent solution.
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TIPTIPTIPTIPTIP Many companies and organizations will find that Web-based mailing list
providers such as eGroups.com and Listbot (www.listbot.com) are a better
solution than the traditional Listserv and Majordomo programs. Additionally,
many of these Web-based list servers can be used for free, provided you don’t
mind having ads inserted in your messages.

Offline PublicizingOffline PublicizingOffline PublicizingOffline PublicizingOffline Publicizing
Your company or organization can get so caught up in publicizing your Web site online
that you forget about the more traditional channels of publicity, such as company
publications, phone books, and newspaper ads, and traditional marketing methods, such
as speaking engagements.

Any time that you draw attention to your business or organization, you’ll increase the
number of visitors to your Web site—provided that you make it clear to your audience
how to find your Web site. Many people consider the Web their preferred source of
information, so any time you want to provide people with a way of obtaining additional
information about your company or organization, list your URL. In general, we rec-
ommend that you include your Web site’s URL on every piece of advertising and lit-
erature your company creates—offline and online.

Here are some recommendations for offline channels that you may want to consider
for publicizing your Web site:

• Company letterhead. Include your URL in your letterhead design.

• Business cards, magnets, and stickers. Print the company URL on all employee busi-
ness cards, as well as magnets, stickers, and any other ephemera your company prints.

• Print newsletters or other documents. Include your Web site’s URL prominently in any
print newsletters or flyers your company or organization creates, and consider includ-
ing a small summary or highlights of the information contained on your site.

• Answering machine or voice mail. Tell callers about additional information that can
be obtained from your Web site, and provide the URL.

• Phone books and newspaper ads. Revise your Yellow Pages listing to include your URL,
and make sure to print your URL in any newspaper or other print ads you run.

• Speaking engagements and broadcast media. Mention your Web site address during a
media appearance, but keep the references short, professional, and low-key.
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Monitoring YMonitoring YMonitoring YMonitoring YMonitoring Your Wour Wour Wour Wour Web Siteeb Siteeb Siteeb Siteeb Site
After you publish and publicize your Web site, you may want to monitor it to deter-
mine the number of visitors who come to your site and the type of browsers they are
using. This can give you a better feel for whether or not your Web site is achieving its
desired results, demonstrate the effectiveness of your Web site publicity efforts, and
perhaps reveal whether or not you need to rethink the browser compatibility of your
site.

To obtain useful statistics on your Web site’s usage patterns, such as the number of
visitors coming to your site or what browsers they’re using, you need to use a third-party
monitoring solution. Typically, your Web hosting company will provide usage statis-
tics for your site as a part of your Web hosting package, as shown in Figure 7-18.
However, if this service isn’t included with your hosting plan, or if the statistics pro-
vided are inadequate, you can use a third party to collect statistics on your Web site
traffic. Some companies that offer Web site statistics collection include
www.counter.com, www.sitegauge.com, and www.fxweb.com/tracker.

Figure 7-18 The traffic statistics for a Web site.
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Here are some recommendations about what to look for when reading the statistics on
your Web site:

• Total number of visits and average hits per day. This number tells you how many
people are visiting your site, although it may include multiple visits by the same
person.

• How visitors are finding your site. Some usage statistics show which Web sites re-
ferred visitors to your site. This data can help you determine your most important
referral sources.

• What type of Web browsers visitors are using to view your site. Seeing the break-
down of which browsers and browser versions are being used to view your site helps
you better tailor your site to your visitors.

• What type of operating systems are being used to view your site. This information
can help identify the platforms on which you should be testing your Web site, as
well as show you how up-to-date your visitors are.

SummarySummarySummarySummarySummary
In this last step, we showed you how to test your site for errors or design problems, as
well as how to publish the site to your Web hosting company’s Internet Web server.
We also gave you some strategies and suggestions for publicizing your site, both online
and offline, as well as briefly discussing components to monitor on your Web site after
it has been published.
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Appendix A

INTERNET AND WEB BASICSINTERNET AND WEB BASICSINTERNET AND WEB BASICSINTERNET AND WEB BASICSINTERNET AND WEB BASICS

Featuring:Featuring:Featuring:Featuring:Featuring:

• What Is the Internet?

• How Do Web Pages Work?

I n this appendix we present background information on the Internet and its many
 methods of communication so that you’ll have the fundamental knowledge neces-

sary to start the process of building a Web site for your company or organization.

What Is the Internet?What Is the Internet?What Is the Internet?What Is the Internet?What Is the Internet?
The Internet is a worldwide collection of computers that are capable of “talking” to each
other over some form of network connection. As such, the Internet is very similar to
the telephone network; in fact, a large amount of Internet traffic is carried over the same
physical cables as our telephone systems.

To use the Internet, you must connect to it. Once connected, there are a number of ways
of communicating over it, such as by sending e-mail messages, browsing Web pages,
or by using newsgroups, chat, or Internet telephones.

Connecting to the InternetConnecting to the InternetConnecting to the InternetConnecting to the InternetConnecting to the Internet
There are several ways of connecting to the Internet. If you are a home or small busi-
ness user, you probably connect to the Internet using a modem. To connect, you dial
your Internet service provider (ISP) with your modem, which is connected to a nor-
mal telephone line. A server at the ISP answers the phone, and then connects you to
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the Internet. This method is available anywhere there are phone lines, and it is relatively
inexpensive (typically $10 to $20 per month). However, it is slow. A 56-kilobit mo-
dem can reach a maximum download speed of 53 kilobits per second (Kbps)—taking
about two and a half to three minutes to download a 1 megabyte (MB) file, which is
roughly the amount of text in this book and approximately two-thirds of the space on
a 1.44MB floppy disk.

NOTENOTENOTENOTENOTE Connection speeds are discussed in terms of kilobitsbitsbitsbitsbits per second (Kbps), while
the size of files is discussed in kilobytesbytesbytesbytesbytes (KB) or megabytesbytesbytesbytesbytes (MB). They mea-
sure the same thing, except that there are eight bits in a byte, or eight kilo-
bits in a kilobyte, making the numbers different by a factor of eight.

Digital Subscriber Line (DSL) service is a high-speed form of Internet access that is
becoming increasingly popular for both home users and small businesses. DSL also uses
a normal telephone line, but requires that the telephone company have special digital
equipment installed nearby in order to provide service. Thus, DSL isn’t available in all
areas.

When available, the service provides constant Internet connectivity. There’s no need to
dial the ISP with most DSL services because you’re always connected. This type of
service is much faster than a standard analog modem. DSL speeds range from 192Kbps
to around 1.5Mbps, with typical speeds starting at around 300 to 600Kbps (faster
speeds are usually available for more money). At 300Kbps, a 1MB file takes about 30
seconds to download. DSL typically costs about $50 per month for the lowest-speed
service up to around $200 per month for the highest-speed service available.

DSL requires a DSL router or a DSL bridge—usually (but incorrectly) referred to as
modems. (Technically, a modem is a device that turns digital information into sound
and vice versa, whereas DSL remains purely digital.) These devices may be included for
free when you sign up for service or may cost several hundred dollars. Many can be
plugged directly into the uplink port on your network hub to allow computers to easily
share the Internet connection.

Cable modems are another increasingly popular form of high-speed Internet access, but
they are generally not available for businesses. When available, they are always-on digital
connections that work over cable TV lines. Cable modems provide speeds that vary
between 300Kbps and 2Mbps. Cable modem service usually costs around $40 per
month.
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Integrated Services Digital Network (ISDN) is an older high-speed Internet connec-
tion that works over (mostly) normal telephone lines (a special ISDN digital connec-
tion needs to be set up by the telephone company). ISDN is popular with small
businesses because of its wider service coverage (you can often get ISDN where you can’t
get DSL) and its ability to provide high-speed access. ISDN speeds typically start at
128Kbps and can be increased in increments of 64Kbps up to a maximum of roughly
1Mbps. ISDN costs about $40 per month per 64Kbps of bandwidth (data transfer
speed). ISDN, like an analog modem, isn’t on all the time, but the connection time is
so fast that it appears almost instantaneous.

Medium-size companies that need to share an Internet connection with more than
about a couple dozen users will need to use a more sophisticated connection option, such
as Frame relay. Frame relay and other so-called leased lines generally guarantee a cer-
tain amount of bandwidth, provide a lot of it, and charge you amply for it. Frame relay
service typically is available with 128Kbps of throughput for around $200 per month,
or up to 1.5Mbps of throughput for $600 per month.

NOTENOTENOTENOTENOTE Wireless solutions are available, but until recently they have been used exclu-
sively for mobile users owing to their very low speeds (9.6Kbps–28.8Kbps) and
high per-minute costs. However, speeds are rising, with mobile wireless achiev-
ing 128Kbps and fixed wireless service (with roof-mounted antennas) reaching
up to 10Mbps. As competition heats up, wireless costs will fall, as will the costs
of other forms of Internet connections.

The different throughput speeds can be challenging to interpret. Table A-1 summa-
rizes the transmission times to move the photograph shown in Figure A-1. Note that
the photograph—one of medium quality such as you might use as a full-page image
in a Web page—is roughly 100 kilobytes in size.

CONNECTIONCONNECTIONCONNECTIONCONNECTIONCONNECTION THROUGHPUTTHROUGHPUTTHROUGHPUTTHROUGHPUTTHROUGHPUT TIME TO TRANSMITTIME TO TRANSMITTIME TO TRANSMITTIME TO TRANSMITTIME TO TRANSMIT

Modem 56.6Kbps 14 seconds

ISDN 128Kbps 6 seconds

Cable modem 300Kbps 2.5 seconds

DSL 600Kbps 1.2 seconds

Frame relay 1.5Mbps Half a second

Table A-1 Examples of transmission times for a simple photograph.
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Figure A-1 A photograph in an image editor such as you might use on a Web page.

Methods of Communication over the InternetMethods of Communication over the InternetMethods of Communication over the InternetMethods of Communication over the InternetMethods of Communication over the Internet
Computers that have an Internet connection can communicate with other computers
on the Internet in a number of ways. The most common ways to communicate are via
e-mail and the World Wide Web (WWW, or just “the Web” for short). Other meth-
ods that can be useful as a way of promoting your Web site or company include
newsgroups, chat rooms, and Internet telephone applications.

E-MailE-MailE-MailE-MailE-Mail
E-mail works like a virtual U.S. Postal Service. You write an e-mail message in an e-mail
program—just like you might write a letter using a word processor or a pad of paper
and a pen. Figure A-2 shows an example of the Microsoft Outlook Express e-mail
message window.



Appendix A      Appendix A      Appendix A      Appendix A      Appendix A      Internet and Web Basics 203203203203203

Figure A-2 An e-mail message.

To send the message, you connect to the Internet and click the Send/Receive button
in your mail software to deliver the message to your e-mail “post office” (mail server).
This is analogous to getting in your car and driving to the post office to drop off a letter.
At both the virtual and real post offices, the next step is to sort the message and de-
liver it to the post office nearest to the recipient. The recipient then has to connect to
the Internet and download his or her new message—like driving to a post office to pick
up mail at a post office box.

The WThe WThe WThe WThe Webebebebeb
The Web works quite a bit differently from e-mail. A Web site consists of a number
of specially formatted documents called Web pages that are linked to each other by
hyperlinks and that are sitting on a server connected to the Internet.

To view a Web site, you use your Web browser program to request a specific Web page
from the server storing the Web site. You do this by either clicking a hyperlink or
entering the address (known as a Uniform Resource Locator, or URL) of the specific
Web site. The Web server responds by sending the requested page across the Internet
to your Web browser, which then reads the document, formats it appropriately, and
displays it on the screen. Figure A-3 shows an example Web page.
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Figure A-3 A Web page.

The Web has quickly become the most popular part of the Internet for three reasons.
The first is the flexibility of the medium. Just about anything can be done in a Web
page with a little ingenuity—from online shopping to online gaming. The second is
how easy it is to use. Web browsers are fairly self-explanatory, and navigation consists
of pointing at links and clicking a mouse button. The third reason is that companies
and advertising are welcome on the Web—something that can’t really be said of other
parts of the Internet. (Although as described in “Step 7: Deploy Your Web Site,” there
are acceptable ways to use these other parts to draw visitors to your site.)

Newsgroups and Chat GroupsNewsgroups and Chat GroupsNewsgroups and Chat GroupsNewsgroups and Chat GroupsNewsgroups and Chat Groups
Newsgroups are very much like virtual bulletin boards. Anyone can post a message on
the newsgroup for anyone else to see. All messages are stored on the news server, and
you download only those messages you want to read. Figure A-4 shows an example of
a message in a newsgroup. Newsgroups are organized on different topics and subjects
of interest, providing a fairly dynamic medium for communication.
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Figure A-4 A message in a newsgroup.

Chat provides a way to have a real-time, text-based conversation with other users across
the Internet. You chat with other people in a so-called chat room, which is basically a
chat server that facilitates computer connections. You communicate by typing your
message, which then appears instantly on your chat partner’s screen.

Instant MessagingInstant MessagingInstant MessagingInstant MessagingInstant Messaging
A similar type of real-time, text-based Internet communication method is instant
messaging—as provided by applications such as AOL Instant Messenger, ICQ, and
MSN Messenger. These programs act as a sort of Internet-based text telephone. When
you go online, you can determine which of your friends are online and then contact them
via the software and conduct a one-to-one text-based chat. This is similar to normal
chat software, except that conversations are usually private and you can easily find your
friends or colleagues when they’re online. Figure A-5 shows an example of a conver-
sation using an instant messaging program.
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Figure A-5 A real-time conversation using MSN Messenger.

Internet TInternet TInternet TInternet TInternet Telephone Serviceselephone Serviceselephone Serviceselephone Serviceselephone Services
Internet telephone software packages take the chat concept a step further. These soft-
ware programs, such as CU-SeeMe, Net2Phone, or Microsoft NetMeeting, provide
real-time voice (and occasionally video) communication with other users who are con-
nected to the Internet and running the same software. Some programs even provide the
ability to call normal telephones through the Internet. The chief reasons to use Internet
telephone programs are to take advantage of enhanced communication features, such
as video teleconferencing (videophone), have the ability to view another user’s computer
screen while talking, or save on long-distance telephone costs.

How Do WHow Do WHow Do WHow Do WHow Do Web Pages Web Pages Web Pages Web Pages Web Pages Work?ork?ork?ork?ork?
A Web page is simply a text document with special codes in it that tell a Web browser
how to format and display the contents of the page. In addition to the special format-
ting, Web pages can also contain embedded images (that show up in the page onscreen
but are stored separately on the server) and links (hyperlinks) to other pages.
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In the old days, all Web pages were created manually in Hypertext Markup Language
(HTML), which is discussed in “Appendix B: An Introduction to HTML.” Although
some people still create Web pages this way, it is far easier and faster to use a program
such as Dreamweaver to create Web pages graphically—without having to write any
code. However, if you know a little bit about how HTML pages are created and can
recognize some common HTML tags, you’ll be able to use Dreamweaver’s highly
effective Tag selector tool to select quickly and accurately exactly which parts of a Web
page you want to edit.

New WNew WNew WNew WNew Web Page Teb Page Teb Page Teb Page Teb Page Technologiesechnologiesechnologiesechnologiesechnologies
In addition to HTML pages, a number of new technologies have been developed for
Web pages. Even if these technologies don’t apply to your Web site initially, it’s good
to know that if you need something more sophisticated than standard HTML, the
capability exists. The following list describes relevant Web page technologies and what
they do:

• Dynamic HTML (DHTML) introduces movement and the ability to react to a
user’s actions to Web pages. For example, text may highlight when a user moves the
mouse over it.

NOTENOTENOTENOTENOTE Dreamweaver implements DHTML using the Behaviors palette and layers. You
can animate the position of layers by selecting the layer and choosing com-
mands from the Modify menu’s Timeline submenu. Consult Dreamweaver’s
online help system for more information on timelines and behaviors.

• Cascading Style Sheets (CSS) are a supplement to HTML that allow much greater
control over text style and position. CSS also allows you to link all Web pages in a
site to a single external CSS file containing information on how text should be
formatted. You can then implement sitewide formatting changes by modifying one
CSS file.

• Macromedia Flash and Shockwave allow professional Web developers to create fancy
effects and interactivity on a Web page—like DHTML, except more powerful and
flexible. Web browsers that don’t natively support Flash or Shockwave can view these
files using a browser plug-in that must be downloaded before users can view the
effects.
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• JavaScript, Java, and ActiveX provide a way of performing complex tasks within a Web
page and can even function as full-featured programs. You can accomplish some
simple tasks in FrontPage if you have a bit of patience, but these technologies are
complicated—and using them is best left to professional Web developers.

• CGI scripts are used on some Web servers to provide server-based features such as
forms, visitor counters, and discussion groups. CGI scripts are tricky to set up; you
should get outside help if you need to use them to handle forms on your Web site.

• XML stands for Extended Markup Language. XML provides a way of giving de-
tailed content information about a Web page, allowing for more meaningful searching
and information gathering.
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Appendix B

AN INTRODUCTION TO HTMLAN INTRODUCTION TO HTMLAN INTRODUCTION TO HTMLAN INTRODUCTION TO HTMLAN INTRODUCTION TO HTML

It’s highly probable that you’ll never want to write a Web page from scratch in HTML,
but it is useful to know what HTML looks like, especially if you want to use

Dreamweaver’s Tag selector tool. You’ll also have a better idea about what someone you
hire to perform HTML editing and coding is actually doing.

To begin, let’s look at a simple sentence in HTML code. For example, every
programmer’s first assignment is to create code that displays the phrase “hello world,”
so let’s do that in HTML.

  <html>
  <p>hello world</p>

  </html>

This is a complete Web page. It’s made up of two tags, which are the basic building
blocks of an HMTL document. The first tag, <html>, states that the document is an
HTML document and marks the beginning of the Web page. The second half of this
tag, </html>, comes at the end of the document and signifies the end of the page. The
next tag, <p>, signifies a new paragraph. The actual paragraph in this case is simply “hello
world,” and the paragraph ends with the second half of the paragraph tag, </p>.

TIPTIPTIPTIPTIP All HTML tags begin with a left angle bracket (<) and end with a right angle
bracket (>). They usually begin and end similarly to the <html> and <p> tags—
with the end of the tag the same as the beginning, except for the addition
of a slash (/). For example, </p> closes the <p> tag, ending it.
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Now let’s try to decipher something a little more complex. The next page includes an
image and a hyperlink. Figure B-1 shows what this page looks like in a Web browser.
Here’s the code for it:

 <html>

 <p><img src=”images/un.gif”></p>
 <p>hello <a href=”http://www.un.org”>world</a></p>

 </html>

Figure B-1 A simple Web page displayed in a Web browser.

Notice that the code includes an additional paragraph, which contains the <img> tag.
This is the inline image tag (which means it is an image displayed in a Web page instead
of an image that you can download). The tag starts with <img to indicate that it’s an
inline image, and then it contains one or more attributes. The only attribute used here
is the src attribute, which contains the URL (address) of the image to be displayed. In
this case, the image is the images/un.gif image. The tag ends with a right angle bracket
(>).

NOTENOTENOTENOTENOTE Uniform Resource Locators, or URLs, essentially identify files by name and give
their precise location.
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Notice also that in the middle of the “hello world” paragraph there is now a hyperlink.
The hyperlink tag starts with <a> and ends with </a>, and in between are the attributes
of the hyperlink and the text to which the hyperlink is attached. In this case, the only
attribute is the href attribute (which is the URL of the hyperlink). You can use the href
attribute by typing href= and then entering the URL to use, enclosed in quotes. The
tag is partially closed by the right angle bracket (>) following the href attribute, but don’t
let this fool you. This is so that the text to which the hyperlink is actually attached, world,
isn’t thought of as another attribute. The hyperlink tag actually ends after this text with
the </a> tag.

One final comment concerning HTML: If you create this same simple page using
Dreamweaver, you will see some additional HTML codes, or tags. Dreamweaver sets
up a more complex page, including header information that isn’t displayed (using the
<head> tag) and the title of the Web page (using the <title> tag). Dreamweaver also
delineates the body of the page (using the <body> tag) and provides some additional
information about the page’s contents using meta tags (<meta>). Meta tags, among other
things, can provide information to search engines using the <meta name=“keywords”>
tag so that search engines can more easily and accurately index the contents of a Web
site.

Table B-1 provides a listing of some common HTML tags, their names, and brief
descriptions.

TAGTAGTAGTAGTAG COMMON NAMECOMMON NAMECOMMON NAMECOMMON NAMECOMMON NAME DESCRIPTIONDESCRIPTIONDESCRIPTIONDESCRIPTIONDESCRIPTION

<a> Anchor A hyperlink of any sort.

<b> Bold text Text formatted as bold.

<body> Document body The main, visible, section of a Web
page.

<br> Line break A forced new line in a single paragraph.

<button> Button A button in a form.

<col> Table column A column of a table.

<dd> Definition description The description of a definition term.

<div> Layer A CSS layer.

<dl> Definition list A list consisting of definition terms and
descriptions.

(continued)
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TAGTAGTAGTAGTAG COMMON NAMECOMMON NAMECOMMON NAMECOMMON NAMECOMMON NAME DESCRIPTIONDESCRIPTIONDESCRIPTIONDESCRIPTIONDESCRIPTION

<dt> Definition term A term that will be defined.

<font> Font change Text with a font specified.

<form> Interactive form A form for visitor input.

<frame> Frame A frame or Web page displayed within
another page.

<frameset> Frameset The container for multiple frames.

<h1> Level-one heading The highest-level heading on a page.

<head> Document head The hidden place where Web page
information is kept.

<hr> Horizontal rule A horizontal line on a page.

<i> Italic text Text formatted as italics.

<img> Inline image An image displayed on a Web page.

<label> Form field label The label for a form field.

<li> List item A bulleted item in an unordered
(bulleted) list.

<meta> Meta data Hidden information about a Web
page’s content.

<ol> Ordered list A numbered list.

<p> Paragraph A paragraph of text.

<table> Table A table.

<td> Table cell A cell, or box, in a table.

<tr> Table row A row in a table.

<ul> Unordered list A bulleted list.

Table B-1 Some common HTML tags.

TIPTIPTIPTIPTIP Dreamweaver 4 includes a comprehensive online HTML tag reference source—
the Reference palette. You can use this palette to access information on any
HTML tag as well as information on CSS classes and JavaScript. To access the
Reference palette, choose the Window menu’s Reference command.
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Appendix C

HYPERLINKS IN DREAMWEAHYPERLINKS IN DREAMWEAHYPERLINKS IN DREAMWEAHYPERLINKS IN DREAMWEAHYPERLINKS IN DREAMWEAVERVERVERVERVER

Featuring:Featuring:Featuring:Featuring:Featuring:

• Absolute Addresses

• Document Relative Addresses

• Site-Root Relative Addresses

There are three types of hyperlink addresses you might want to use when creating
your Web pages: absolute addresses, document relative addresses, and site-root rela-

tive addresses. In general, Dreamweaver deals with these addressing schemes for you,
but it’s useful to understand the difference so that you’re not caught off guard with bro-
ken hyperlinks.

To use a different addressing scheme when creating a hyperlink in Dreamweaver, ei-
ther enter the absolute address in the Link box or choose the relative addressing method
you want to use from the Addressing Method drop-down list box, as shown in
Figure C-1. For more information on creating hyperlinks, see “Step 4: Create Your Site”
and “Step 5: Create Your Pages.”
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Figure C-1 Selecting the addressing method for a hyperlink.

Absolute AddressesAbsolute AddressesAbsolute AddressesAbsolute AddressesAbsolute Addresses
You’re probably used to seeing Web page addresses that are in the following form:
http://www.somecompany.com/index.htm. These kinds of addresses are called absolute
addresses because they point to an absolute and unchanging location. No matter where
you or the referring Web page are, on (or off ) the Web, the address points to the same
location.

Document Relative AddressesDocument Relative AddressesDocument Relative AddressesDocument Relative AddressesDocument Relative Addresses
Document relative addresses describe an address relative to the Web page containing
the link. For example, to link to a Web page in the same directory as the referring Web
page, simply enter the name of the page you want to link to, for example, products.htm.
To refer to a page in a subdirectory, enter only the subdirectory and filename, not the
complete path. For example, the images/logo.gif address points to a logo.gif file in the
images subdirectory.

Document relative addresses are the most commonly used addresses when creating Web
pages because the links continue to work even if you move your entire site to a differ-
ent location—perhaps from your local hard drive to a Web server or to a new domain
name. As long as the internal structure of the Web site doesn’t change, all links work
fine because the relative address of each file hasn’t changed.

For the most part, Dreamweaver uses document relative addresses automatically, and
we feel that this is the most appropriate method for most users. You don’t need to
perform any special actions to use document relative addressing.
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TIPTIPTIPTIPTIP If you move Web pages around in your Web site using Dreamweaver’s Site
window, Dreamweaver can automatically update your hyperlinks. This makes
document relative addressing more desirable than it would be otherwise,
making it a better choice than site-root relative addressing in most instances.

Site-Root Relative AddressesSite-Root Relative AddressesSite-Root Relative AddressesSite-Root Relative AddressesSite-Root Relative Addresses
Site-root relative addresses describe an address relative to the root directory of the Web
site. For example, to link to the logo.gif file in the images subdirectory, you’d enter the
path to this directory relative to the root of your Web site, as shown in Table C-1.

ADDRESSING METHODADDRESSING METHODADDRESSING METHODADDRESSING METHODADDRESSING METHOD PAPAPAPAPATHTHTHTHTH

Absolute http://www.mycompany.com/manuals/images/logo.gif

Document relative images/logo.gif

Site-root relative /manuals/images/logo.gif

Table C-1 An absolute address and relative addresses from a Web page located in the
manuals directory.

Site-root relative addressing works well if you often need to move files from one direc-
tory to another within the Web site. If you want to use site-root relative addressing,
select Site-Root from the Addressing Method drop-down list box when creating a
hyperlink (see Figure C-1).

NOTENOTENOTENOTENOTE You can only use hyperlinks that use site-root relative addressing when they
are published to your Web server or when previewed using Dreamweaver’s
Preview In Web Browser feature. If you open the Web page containing the
link directly in your Web browser while still on your local hard drive, the link
won’t work.
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Appendix D

CREACREACREACREACREATING WEB STORESTING WEB STORESTING WEB STORESTING WEB STORESTING WEB STORES

Featuring:Featuring:Featuring:Featuring:Featuring:

• Creating a Non-Interactive Catalog

• Using a Secure Form to Collect Orders

• Using a Shopping Cart System

Web-based storefronts are very enticing to many companies and organizations.
Unfortunately, Dreamweaver 4 doesn’t provide an easy way for you to collect

information from visitors; and to operate a Web store, you’ve got to be able to take in
orders from customers.

Of course, there are other ways in which small or medium-size businesses or organi-
zations can set up Web stores, and the following sections describe three options: the
non-interactive method, which is the same as a print catalog; the basic online order-
form method; and the full-fledged shopping cart method, with or without credit card
processing.

NOTENOTENOTENOTENOTE Your company or organization may not require interactivity on its Web site.
We recommend that you postpone adding such advanced features until after
you have a simple Web site up and running.
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Creating a Non-Interactive CatalogCreating a Non-Interactive CatalogCreating a Non-Interactive CatalogCreating a Non-Interactive CatalogCreating a Non-Interactive Catalog
The easiest way to allow visitors to order products from your company is to create an
online version of your print catalog and include your phone number or an order form
that visitors can print out and then mail or fax to your company. This is very simple
to do.

You can use Dreamweaver to create your online product catalog just as you would any
other page, making sure to include each product’s price as well as your company’s tele-
phone number. To allow visitors to mail or fax orders to your company, you can take
an existing order form and convert it into a Web page (or create it from scratch) or,
optionally, an Adobe Acrobat file. You can then place this order form on your Web site
for visitors to print out and return to you via mail or fax.

Using a Secure Form to Collect OrdersUsing a Secure Form to Collect OrdersUsing a Secure Form to Collect OrdersUsing a Secure Form to Collect OrdersUsing a Secure Form to Collect Orders
A more sophisticated approach to online stores is to create an order form hosted on a
secure Web site to collect customer orders. In this way, you can safely accept orders with
credit card information. Unfortunately, this approach quickly presents challenges for
the average user because you need to know how to set up CGI scripts on your Web server
in order to allow Dreamweaver to collect form data from visitors.

TIPTIPTIPTIPTIP If your ISP supports FrontPage Server Extensions, you’ll have better luck us-
ing Microsoft FrontPage rather than Dreamweaver for this scenario. You could
create a FrontPage web that consists of a single form page for placing orders
and then link your Dreamweaver-created Web site to this FrontPage web.

Credit card information is collected using the order form you create; orders are pro-
cessed by manually downloading them from your Web site and then using a standard
credit card reader to process the transaction. For small businesses, this method is much
more cost-effective than dealing with online credit card processing, which universally
costs more than processing credit card transactions offline using a standard credit card
reader.

NOTENOTENOTENOTENOTE Some Web hosting companies will include a free shopping cart system with
Web hosting plans that provide secure connections. If this is the case with your
Web hosting company, you’ll probably want to use it instead of the method
described below.
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To create a secure online order form, follow these steps:

1. Create your online catalog.

Create a catalog of products or services in Dreamweaver as you would any other Web
site or series of pages, making sure to include pricing information.

2. Create an order form.

Create an order form using Dreamweaver, or, optionally, using FrontPage.

3. Configure the form properties.

Select the form, and in the Property inspector’s Action box, specify the proper string
for posting form data to your secure Web server. (You’ll need help from your ISP
or a consultant to get this set up.)

If you’re using FrontPage 2000, right-click inside a form in FrontPage that you’ve
created and choose Form Properties from the shortcut menu to modify the proper-
ties of the order form. Make sure that the form results are stored in the _private/
directory, as shown in Figure D-1, so that only you can view orders that have been
placed.

Figure D-1 Changing the location in which form results are stored, using FrontPage
2000.

WWWWWARNINGARNINGARNINGARNINGARNING Do not send form results to an e-mail address if your form is collecting
credit card information. Non-encrypted e-mail is not a secure medium
and should never be used for sending credit card information.
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4. Link your catalog to your order form.

Create a hyperlink in your catalog to your new order form using the secure Web site
alias provided by your Web hosting company. Usually this will be in the form of
https://www.myhostingcompany.com/mycompany/order_form.htm.

NOTENOTENOTENOTENOTE Web hosting companies usually create a secure alias to your Web site, for
example, https://www.myhostingcompany.com/mycompany/anypage.htm.
Note the “s” for “secure” in the https:// protocol. The alias allows you to
securely access any page on your site. For specifics, contact your Web host-
ing company.

5. Retrieve orders.

If you’re using FrontPage 2000 to create your forms, open your FrontPage order-
ing web directly by using the secure alias. To do this, in FrontPage 2000, choose the
File menu’s Open Web command and then enter the secure URL provided by your
Web hosting company for example, https://www.myhostingcompany.com/mycompany.
After your Web site is open in FrontPage, go to the _private/ directory and open your
form results page to retrieve the list of orders placed since you last emptied the form
results file.

NOTENOTENOTENOTENOTE Because it’s unwise to send form results containing credit card information
over e-mail, you’ll need to check your form results regularly to see whether
orders have been placed.

6. Process the orders.

Use your credit card reader to process any credit card orders, and fill your orders.

TIPTIPTIPTIPTIP One way of processing the orders that are contained in your form results page
is to save the page onto your hard drive and take the order information from
this file instead of from the form results page on your Web site. You can then
safely delete the contents of the form results page on your Web site to re-
duce the risk of processing an order twice (since the orders will exist only in
the file on your hard drive).

Using a Shopping Cart SystemUsing a Shopping Cart SystemUsing a Shopping Cart SystemUsing a Shopping Cart SystemUsing a Shopping Cart System
The most elegant and sophisticated way of setting up an online Web store is to use a
shopping cart, ideally with online credit card processing. Dreamweaver has no built-in
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support for creating online shopping carts, so if this is a service you need, you’ll have to
look elsewhere.

In general, to set up a shopping cart system, you can take one of three routes.

The first route is to use one of the e-commerce companies that provide a full e-com-
merce solution, including all Web hosting, a shopping cart system, and credit card
processing. This is definitely the easiest way to set up an online Web store, since the
entire Web site is created using templates provided for you. Figure D-2 shows an
example of a Web site created by using one of these companies. This method is also not
too expensive. Web sites are often provided for free, and credit card processing starts
at about $25 per month, with a charge of 2.35 percent plus 20 cents per transaction.
The biggest downside is the inability to create or edit your Web pages with
Dreamweaver, or any other Web page editor for that matter. This can make it difficult
to implement the features and layouts you want for your site, and it can also result in
your site appearing less than unique. BigStep.com, FreeMerchant.com,
Store.Yahoo.com, and JumboStore.com are four companies that provide these services.

Figure D-2 An e-commerce site created on www.bigstep.com.
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TIPTIPTIPTIPTIP Many e-commerce companies offer free hosting provided that you don’t
require online credit card processing. If this route is appropriate for your
company, consider signing up with one of the services and experimenting with
their software and hosting to see whether the service is adequate for you.

The second route that many companies take when creating an online Web store is to
sign up with a Web hosting plan that includes an online shopping cart in the monthly
fee. Prices vary widely, but Commerce hosting plans (or similarly named plans that
provide a secure shopping cart for your Web site) can be had for as little as $30 per
month. Plans often include many more features than free hosting sites, such as including
support for Dreamweaver, more server space, and additional e-mail accounts. A Web
site created using this approach is shown in Figure D-3.

Figure D-3 An e-commerce site that makes use of a Web hosting company’s shopping
cart.
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This approach can be ideal for many businesses because it allows you to set up an online
Web store—complete with online ordering for a low initial cost—and you still have the
flexibility to create the site using Dreamweaver. If you want to add online credit card
processing at a later time, your Web hosting company will often provide credit card
processing for free, but with a large transaction fee (5 percent is typical); or you can get
your own Internet Merchant account. However, most businesses will find it more
economical to use the shopping cart to collect orders, securely connect to the Web site
to view the orders that have been placed (see the previous section), and then process the
orders offline using a traditional credit card reader. Forgoing online credit card process-
ing and instead processing credit card orders using a traditional card reader usually results
in lower transaction fees as well as lower monthly costs. If your online business grows
enough to justify getting an Internet Merchant account, you can do so at a later time.

NOTENOTENOTENOTENOTE Internet Merchant accounts vary in cost, but 2.39 percent plus 30 cents per
transaction, with a $10-per-month bank statement fee and a $25-per-month
monthly minimum, is an example of what to expect.

The third route is to hire a contractor to set up your e-commerce site from scratch. This
method usually yields the best results, but it is also typically very expensive. It can cost
$10,000 or more depending on what features your company requires. In general, we
recommend trying a more cost-effective strategy. If your needs become more sophis-
ticated, you can always hire a contractor later, but it can be ruinous to a small company’s
financial state to make this kind of an expenditure on a Web site that turns out to be
not as profitable as projected.
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GLOSSARYGLOSSARYGLOSSARYGLOSSARYGLOSSARY

Active Server PagesActive Server PagesActive Server PagesActive Server PagesActive Server Pages
Abbreviated ASP. Dynamically created pages from a Microsoft Access or SQL database.

ActiveXActiveXActiveXActiveXActiveX
A Microsoft technology that is typically used to create small programs that run inside
a Web page. ActiveX components work in Internet Explorer 4, or later, but do not work
in Netscape Navigator without an additional plug-in.

banner adbanner adbanner adbanner adbanner ad
A rectangular-shaped advertisement on a Web page.

bookmarkbookmarkbookmarkbookmarkbookmark
A placeholder within a Web page that allows hyperlinks to refer to this location within
the Web page. Also known as a named anchor.

cable modemcable modemcable modemcable modemcable modem
A device that allows computers to access the Internet using a cable TV connection. The
local cable TV company must enable cable modem access to a home or business in order
for a cable modem to work.
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Cascading Style SheetsCascading Style SheetsCascading Style SheetsCascading Style SheetsCascading Style Sheets
Abbreviated CSS. A standard for applying formatting and positioning information to
a Web page. CSS information can be used within a Web page or placed in an external
style sheet file. Web pages that are linked to external style sheets obtain text-formatting
information from the style sheet.

chatchatchatchatchat
A form of real-time communication that typically involves two or more users typing
messages to each other.

CGI ScriptsCGI ScriptsCGI ScriptsCGI ScriptsCGI Scripts
A standard for running small programs on a Web server. Typically used on Unix Web
servers.

content foldercontent foldercontent foldercontent foldercontent folder
A separate folder in which to store content before it is added to a Web site.

crawler-based search enginecrawler-based search enginecrawler-based search enginecrawler-based search enginecrawler-based search engine
A search engine that automatically “crawls” the Web searching for Web sites to ex-
amine and include in the search engine’s database of Web sites.

discussion groupdiscussion groupdiscussion groupdiscussion groupdiscussion group
A part of a Web site that emulates newsgroups, allowing visitors to post messages and
read and reply to other visitors’ messages.

domaindomaindomaindomaindomain
A group of computers on a network that all use a central server to handle users and
security policies. The server must run either Windows NT Server or Windows 2000
Server.
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domain namedomain namedomain namedomain namedomain name
The main part of a Web address. Domain names usually represent companies, organi-
zations, or individuals and must be registered with an accredited domain name registrar.

DNSDNSDNSDNSDNS
An abbreviation for Domain Name Service. Translates numerical IP addresses into user-
friendly domain names, and vice versa.

DSLDSLDSLDSLDSL
An abbreviation for Digital Subscriber Line. A persistent (always on) high-speed form
of Internet access that works over standard telephone lines that qualify for DSL service.

e-maile-maile-maile-maile-mail
A form of communication that involves sending mail-like messages across a network
(typically the Internet).

e-mail accounte-mail accounte-mail accounte-mail accounte-mail account
An e-mail address that has its own mailbox, that is, mail isn’t forwarded to another
account as is the case with e-mail aliases.

e-mail aliase-mail aliase-mail aliase-mail aliase-mail alias
An e-mail alias works like a sort of virtual e-mail address that forwards received mail
to another address.

encryptionencryptionencryptionencryptionencryption
The process of scrambling data to prevent unauthorized users from viewing the data.

firewallfirewallfirewallfirewallfirewall
A server or device on a network that acts as a barrier between the Internet and the local
network, protecting the local network from hacking attempts.
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floating palettefloating palettefloating palettefloating palettefloating palette
A small, repositionable window in Dreamweaver containing frequently used tools or
settings.

form handlerform handlerform handlerform handlerform handler
The software that gathers data from a form. Form handlers are either a part of FrontPage
Server Extensions, CGI scripts, or Active Server Pages.

framesframesframesframesframes
An HTML feature that permits splitting a Web page into multiple areas (frames)
within which separate Web pages are displayed. Not supported by all Web browsers.

FrontPage Server ExtensionsFrontPage Server ExtensionsFrontPage Server ExtensionsFrontPage Server ExtensionsFrontPage Server Extensions
A set of extensions to Web servers that enables Microsoft FrontPage to easily accom-
plish advanced server-based tasks, such as handling submitted form data.

GIFGIFGIFGIFGIF
An abbreviation for Graphics Interchange Format. A file format used most commonly
for small graphics on Web pages. A GIF contains a maximum of 256 colors and can
be made partially transparent or into a short animation.

home pagehome pagehome pagehome pagehome page
Also called a front page. The first page that is displayed on a Web site, typically named
index.html, index.htm, or Default.htm.

host namehost namehost namehost namehost name
The name of an individual computer on the Internet or an intranet. It is the leftmost
part of a Web address. For example, for the address wks1.microsoft.com, the host name
is wks1.

hotspothotspothotspothotspothotspot
A single region within an image map that contains a hyperlink.
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HTMLHTMLHTMLHTMLHTML
An abbreviation for Hypertext Markup Language. The coding language used to cre-
ate Web pages.

hyperlinkhyperlinkhyperlinkhyperlinkhyperlink
A piece of text or image that when clicked with the mouse pointer takes the visitor to
another page, image, or file.

IISIISIISIISIIS
An abbreviation for Internet Information Server. A Microsoft Web server program that
comes with Windows NT and Windows 2000.

image mapimage mapimage mapimage mapimage map
An image that contains multiple hyperlinks—each corresponding to a different region
or hotspot of the image.

Instant MessagingInstant MessagingInstant MessagingInstant MessagingInstant Messaging
A form of communication that is roughly a cross between chat and telephone. Users
run an Instant Messaging program that notifies them when people they know are online.
Users can then conduct a text-based “conversation.”

InternetInternetInternetInternetInternet
A worldwide computer network running the TCP/IP protocol suite and consisting of
hundreds of millions of computers.

intranetintranetintranetintranetintranet
A private network that uses Internet technology—the TCP/IP protocol suite and Web
servers.

Internet Merchant accountInternet Merchant accountInternet Merchant accountInternet Merchant accountInternet Merchant account
An account with a bank or financial institution for the purpose of processing online
credit card transactions.
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Internet service providerInternet service providerInternet service providerInternet service providerInternet service provider
Abbreviated ISP. A company that provides access to the Internet via dial-up connec-
tions, DSL, leased lines, or other connection methods.

IP addressIP addressIP addressIP addressIP address
The unique address for a single network card on a network using TCP/IP. All com-
puters (hosts) on the Internet or an intranet must have an IP address to communicate.

ISDNISDNISDNISDNISDN
An abbreviation for Integrated Services Digital Network. A form of moderately high-
speed Internet connection, ISDN uses one or two telephone lines that are configured
for ISDN service and provides a typical maximum of 128Kbps when both lines are
used.

JPEGJPEGJPEGJPEGJPEG
An abbreviation for Joint Photographic Experts Group. A file format used for photos
and other high-quality images on Web pages that uses image compression to reduce
file size.

keywordkeywordkeywordkeywordkeyword
A word placed in a Web page using a meta tag to allow search engines to recognize
that the Web page contains content related to the keyword.

local area networklocal area networklocal area networklocal area networklocal area network
Abbreviated LAN. A group of computers that are all located within the same local area
(typically one building) and that can communicate with each other.

mailing listmailing listmailing listmailing listmailing list
A list to which users can subscribe that allows them to receive e-mail messages on a
particular topic sent by a company or organization.
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meta tagsmeta tagsmeta tagsmeta tagsmeta tags
Also known as meta variables. Meta tags store information about a Web site, such as
a description and keywords. Crawler-based search engines often use these tags to
determine when to display a site in a list of search results, as well as what description
to display.

modemmodemmodemmodemmodem
An analog device that allows a computer to communicate with other computers over
standard telephone lines. Capable of a maximum of 53Kbps download rate.

multiprocessingmultiprocessingmultiprocessingmultiprocessingmultiprocessing
Using more than one processor in a single computer. Each processor can work indepen-
dently, making multiprocessing-aware applications faster.

named anchornamed anchornamed anchornamed anchornamed anchor
A tag that you can place in a specific location within a Web page that serves as the
destination for in-page hyperlinks. Creating a hyperlink to a named anchor allows a
user to quickly scroll a long page to a particular location.

navigation barsnavigation barsnavigation barsnavigation barsnavigation bars
A series of buttons or hyperlinks that help visitors quickly access the most important
pages on a Web site.

newsgroupsnewsgroupsnewsgroupsnewsgroupsnewsgroups
Electronic bulletin boards on the Internet where people can post messages, read other
users’ posts, and reply to them.

page bannerpage bannerpage bannerpage bannerpage banner
An automatically created heading that displays the title of the Web page.
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permissionspermissionspermissionspermissionspermissions
The level of access given to a user or group for a particular file or folder.

pixelpixelpixelpixelpixel
A single dot on a computer screen. Everything displayed on a computer monitor is made
up of pixels. Common screen resolutions are 640x480 or 800x600—800 pixels wide
and 600 pixels high.

plug-inplug-inplug-inplug-inplug-in
A program that plugs into another program to provide it with enhanced functional-
ity. Adobe Acrobat Reader, Macromedia Flash, and Shockwave are examples of Web
browser plug-ins.

PNGPNGPNGPNGPNG
An abbreviation for Portable Network Graphic. A newer file format designed for high-
quality images with optional transparency. Not supported by all Web browsers.

pop-up menupop-up menupop-up menupop-up menupop-up menu
A menu that opens (or pops) when you click on something, usually a toolbar button.
Similar to a shortcut menu.

Property inspectorProperty inspectorProperty inspectorProperty inspectorProperty inspector
A Dreamweaver floating palette that displays the properties for the selected object.

proxy serverproxy serverproxy serverproxy serverproxy server
A network server that sits in between the local network and the Internet, protecting
the local network from attacks as well as caching Web pages to improve Web-brows-
ing performance for local clients. A type of firewall.
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RAIDRAIDRAIDRAIDRAID
An abbreviation for Redundant Array of Independent Disks. A collection of hard drives
that is treated as one drive by the operating system and usually provides extra speed and
reliability.

registrarregistrarregistrarregistrarregistrar
A company that is permitted to sell Internet domain names.

search enginesearch enginesearch enginesearch enginesearch engine
A program contained on a Web site that allows visitors to search for Web pages on the
Internet.

shortcut menushortcut menushortcut menushortcut menushortcut menu
The menu that is displayed when you right-click an item on the screen. Also called a
context-sensitive menu.

sizing handlessizing handlessizing handlessizing handlessizing handles
Small squares that appear on the outline of an object. Click on a resizing handle to resize
the object.

SSLSSLSSLSSLSSL
An abbreviation for Secure Sockets Layer. A way of encrypting data that is transferred
to and from a Web site and is typically used for Web stores that process credit card
transactions.

status barstatus barstatus barstatus barstatus bar
The bar that runs across the bottom of a window displaying the status of the current
selection. In Dreamweaver, the status bar also contains useful tools such as the Tag
selector.
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subdomainsubdomainsubdomainsubdomainsubdomain
A domain that is a child of another domain. For example, support.microsoft.com is a
subdomain of microsoft.com.

tabletabletabletabletable
A formatting tool that enables text and images to be placed in a grid. Tables are ex-
tremely useful for creating advanced layouts on Web pages.

tagtagtagtagtag
The building block of an HTML document. It begins with a right angle bracket (<)
and ends with a left angle bracket (>).

TTTTTag selectorag selectorag selectorag selectorag selector
The leftmost part of Dreamweaver’s status bar. Clicking a tag in the Tag selector se-
lects the portion of the Web page within that particular tag.

templatetemplatetemplatetemplatetemplate
A Web page that acts as a starting point for new Web pages. Any content or format-
ting information on a template is automatically applied to new pages created with the
template, streamlining the process of making pages.

thumbnail imagethumbnail imagethumbnail imagethumbnail imagethumbnail image
A small version of an image that is hyperlinked to the full-size version.

top-level domaintop-level domaintop-level domaintop-level domaintop-level domain
The highest level (rightmost) part of a domain name, for example, .com, .net, or .org.

underscoreunderscoreunderscoreunderscoreunderscore
The “_” character. It is often used to represent a space in filenames on the Internet
because it is compatible with both the Windows naming scheme and the Unix nam-
ing scheme.
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UPSUPSUPSUPSUPS
An abbreviation for Uninterruptible Power Supply. A battery backup for a computer,
or occasionally, a backup generator that ensures that a computer can continue operat-
ing, or at least shut down properly, in the event of a power failure.

URLURLURLURLURL
An abbreviation for Uniform Resource Locator. An address for a file, usually on the
Internet.

vector-based graphicsvector-based graphicsvector-based graphicsvector-based graphicsvector-based graphics
Computer-based line drawings. Vector-based (line) graphics are usually much smaller
than an equivalent raster-based (bitmap) graphic, such as a GIF or JPEG file, and the
lines can also be edited at a later time.

virtual domainsvirtual domainsvirtual domainsvirtual domainsvirtual domains
The ability to make a single computer host multiple domain names. When discuss-
ing Web hosting plans, virtual domain support means that you can use your own domain
name.

WWWWWeb browsereb browsereb browsereb browsereb browser
A program used to display Web pages.

WWWWWeb hostingeb hostingeb hostingeb hostingeb hosting
To store a Web site and make it available for others to view on the Internet.

WWWWWeb pageeb pageeb pageeb pageeb page
A document using the HTML file format. A Web page can be stored on the Web, a
company intranet, or locally on your computer’s hard drive or floppy disk.
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WWWWWeb ringeb ringeb ringeb ringeb ring
A collection of Web sites that all cover the same topic and that post a Web ring ban-
ner ad on their sites, allowing visitors to easily view other sites in the Web ring.

WWWWWeb servereb servereb servereb servereb server
A computer that is running a Web server program, enabling it to serve Web pages to
other hosts on the Internet or a local area network.

WWWWWeb siteeb siteeb siteeb siteeb site
A collection of interlinked Web pages, usually pertaining to the same general topic or
created by the same company, organization, individual, or group.

WWWWWeb storeeb storeeb storeeb storeeb store
A Web site that visitors can browse and then purchase products or services.

XMLXMLXMLXMLXML
An abbreviation for eXtensible Markup Language. XML provides the ability to store
additional data such as content information along with a Web page, making it easier
for some applications to manipulate the content.
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IndexIndexIndexIndexIndex

A
absolute hyperlink addresses, 214
Active Server Pages, 30, 235
ActiveX, 208, 235
Add Browser dialog box, 182
addresses, hyperlink, 176, 213–15
Adobe Photoshop, 50
advertising

affiliated, 9, 10
banner-type, 191
carrying for others, 9–10
by companies and organizations, 2–3
generating revenue from, 9–10
offline, 196
online, 190–93
purchasing e-mail newsletter space, 192
as reason to have Web site, 2–3
to sell products and services, 2–3
using link exchanges, 192–93
the Web site itself, 190–93
what content to include, 2

aesthetics of Web sites, 128
affiliated advertising, 9, 10
aliases, 30, 237
aligning

tables, 149
text adjacent to images, 119–20
text in paragraphs, 106

Alta Vista, 190
alternative home pages, 164–68
Amazon.com Web site, 4

angle brackets (<>), in HTML code, 209, 210
AOL Instant Messenger, 205
AOL Search, 190
appliances, information, 177
ArtToday Web site, 7
Ask Jeeves, 187
ASP. See Active Server Pages
Assets palette, 116–17
<a> tag, 210–11
.au files, 48
Aureate Group Mail, 195
.avi files, 48

B
background

for tables, 150
for Web pages, 107

banner ads, 191, 235
Barnes and Noble Web site, 22
Behaviors palette, 207
Better-Whois.com, 23
BigStep.com, 221
.biz top-level domain, 25
.bmp files, 78
<body> tag, 211
boldface text, 106
bookmarks, 112, 235. See also named anchors
borders

adding to Web page images, 121
specifying thickness in tables, 145, 150

bridges, 200
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broken hyperlinks, 172–74
browsers. See Web browsers
<br> tag, 211
<b> tag, 211
bulk mail programs, 195
bulleted lists, 106
bulletin board analogy, 16, 204
buttons. See navigation bars
<button> tag, 211

C
cable modems, 200, 201, 235
cameras, digital, 53–54
Cascading Style Sheets (CSS), 107, 158–61, 207,
236. See also layers

catalogs, online, 218, 219
CDs, pictures on, 56–58
cells, table

adjusting height, 148
adjusting width, 148
creating, 146–47
inserting content, 147
resizing, 147
specifying properties, 150–51
splitting, 148, 151

central content folder, 44, 45, 101
CGI scripts, 29, 208, 235
Change Link Sitewide dialog box, 175
chat, 205, 236
chat-based customer support, 12
Check Browser dialog box, 166–67
checking. See testing
checking files in and out, 67, 76, 84–86
checking spelling, 107
Check Target Browsers dialog box, 162–63
Clean Up Word HTML dialog box, 101–2
code. See HTML code
Code View button, 92
colors, Web page, changing, 107
<col> tag, 211

columns, table
adding, 149
adjusting width, 148
drawing, 146–47
resizing, 147
specifying, 144

Commands menu, 91
comments. See Design Notes
company logos, 128
compatibility, Web browser, 161–68
.com top-level domain, 22
content, Web site. See also digital content; images;
text

advertising-related, 2
charging visitors for access, 5–7
choosing home page content, 126–27
collecting what exists, 47–51
converting to other file formats, 48–51
creating new documents, 61
creating site plan for, 63–64
creating staging area location for files, 43–46
curriculum-related information, 13–15
digital, 47–61
for disseminating information, 2, 7–9
frequently asked question (FAQ) lists, 10

importing, 48–51, 99–105
offering subscriptions to, 6
online catalogs, 218, 219
online discussion groups, 11
organizing, 62–63
planning, 63–64
printed documents, 60–61
product support information, 10–13
school-related information, 13–15
selling content online, 5–7
showcasing products and services, 4, 10–13

content folder, 44, 45, 101–2, 236
converting

existing content to Web file formats, 48–51
tables to layers, 137–38

copying files between folders, 80
crawler-based search engines, 187, 188, 236



Index 249249249249249

credit cards, 218, 219, 220, 221, 222
.css files, 160. See also Cascading Style Sheets
(CSS)

CSS Styles palette, 159–61
.csv files, 49, 104
CU-SeeMe, 206

D
databases, 30
data transfer, 32
<dd> tag, 211
deleting

frames, 230
Web pages, 81–82

Design Notes, 82, 83–84
Design View button, 92
digital cameras, 53–54
digital content

charging for, 5–7
collecting, 47–51
converting to other file formats, 48–51
creating, 52–61
types of, 47–48

digital images
creating, 52–60
dots per inch, 52–53
overview, 52
printing, 52–53
resolution issues, 52–53

Digital Subscriber Line (DSL) service, 200, 201,
237

Direct Hit, 190
discussion groups, online. See also mailing lists

chat-based, 12, 205
glossary definition, 236
for product support, 11

disseminating information. See also content, Web
site

charging for content, 5–7
reasons to share, 2, 7–9

<div> tag, 140, 141, 142, 211
<dl> tag, 211

DN Resources Web site, 36
DNS (Domain Name Service), 18–19, 237
.doc files, 47
document-relative hyperlink addresses, 176,
214–15

documents, print, 60–61. See also content, Web site
Document window

floating palettes feature, 95–96
overview, 89–90
resizing, 94
status bar, 93–95
Tag selector, 93
toolbar, 92

domain hosting. See Web hosting services
domain names

aftermarket, 23
background information, 18–20
checking for availability, 23
disputes over, 26
glossary definition, 237
hierarchy of, 19–20
importance of having, 20–21
international, 24
multiple, 22
overview, 18
purchasing, 26–28
registering, 26–28
rules for, 25
selecting, 21–25
transferring, 40–41
and Web hosting services, 38–39

Domain Name Service (DNS), 18–19, 237
domains. See also domain names

glossary definition, 236
top-level, 22–25

downloading Web pages, 94–95
drawing. See also images

layers, 139
tables, 145–47

Draw Layer objects, 140
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Dreamweaver
checking files in and out, 67, 76, 84–86
closing Web pages, 96, 97
configuring to work with firewalls, 68–70
creating image maps, 123–24
creating initial Web site structure, 72–83
creating new Web pages, 97, 155–56
defining new local sites, 65–70
Document window overview, 89–90
entering local site information, 66
importing web content, 48–51, 99–105
interface overview, 89–96
menus, 91
opening browser from, 176
opening local sites, 70–71
opening Web pages, 96–97
previewing Web pages, 99, 176–82
saving Web pages, 98
Site window overview, 71–73
specifying Web server type, 67
starting, 66
status bars, 72, 93–95
Tag selector, 93
using digital content in, 47–61

DSL. See Digital Subscriber Line (DSL) service
<dt> tag, 211
Dynamic HTML (DHTML), 207

E
e-commerce. See Web stores
editable template regions, 154–55
Edit menu, 91
eGroups, 196
e-mail

alias availability, 30
creating hyperlinks to addresses, 111
and credit cards, 219, 220
glossary definition, 237
overview, 202–3
setting up accounts, 39, 42
using messages as content, 48

ways to set up accounts, 30–31
Web hosting service accounts, 30–31

encryption, 33, 237
entering text, 106. See also importing
Excel. See spreadsheets, importing content
Excite, 190

F
Federal Express Web site, 8
file formats, converting, 48–51
File menu, 91
files. See also content, Web site; Web pages

adding Design Notes, 83–84
checking in and out, 67, 76, 84–86
copying between folders, 80
deleting from Web sites, 81–82
managing in Site window, 80–82
moving between folders, 80
opening using Site window, 73
rules for naming, 46–47, 98
sorting in Site window, 72
viewing list in Site window, 72, 73

firewalls, 68–70, 237
Fireworks program, 50
fixing broken hyperlinks, 172–74
Flash program, 129, 207
floating palettes

Assets palette, 116–17
closing, 96
displaying, 95
glossary definition, 238
History palette, 108
moving, 95
Objects palette, 144, 145, 226
overview, 95–96
Reference palette, 212
resizing, 96

folders
copying files between, 80
creating, 45–46
deleting from Web sites, 81–82
for storing content, 43–46
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fonts, changing, 107
<font> tag, 211
formatting text, 106–8
form handlers, 238
forms

creating, 219
linking to online catalogs, 220
for online stores, 218–20

<form> tag, 211
.fpx files, 48
<fragment> tag, 212
Frame relay, 201
frames

creating, 226–29
creating NoFrames alternative, 232-33
deleting, 230
glossary definition, 238
and hyperlinks, 230–31
overview, 225–26
saving, 229
splitting, 230
when to use, 225

<frame> tag, 212
FreeMerchant.com, 221
frequently asked question (FAQ) lists, offering
online, 10

FrontPage 2000, 218, 219, 220
FrontPage Server Extensions, 29, 35, 218, 238
FTP (File Transfer Protocol), 67, 69

G
.gif files, 50, 128, 238
goal-setting, for Web site development, 1–16
Go/Infoseek, 190, 229
Google, 190
graphic images. See images

H
<head> tag, 211, 212
Help menu, 91
History palette, 108

home pages
alternative, 164–68
choosing content, 126–27
glossary definition, 238
preparing for search engines, 130–32
role of, 125–28
specifying, 68
for visitors with older browsers, 164–68
visual appeal, 128

horizontal lines, 115, 212
hosting. See Web hosting services
host names, 19–20, 238. See also domain names
HotBot, 190
Hotmail, 31
hotspots, 123–24, 238
<hr> tag, 212
HTML code

glossary definition, 239
importing documents from Word, 49
importing HTML files, 48–49
list of tags, 211–12
meta tags, 188, 211, 212
newer technologies, 207
overview, 209–12

<html> tag, 209
hyperlinks

absolute addresses, 214
adding to Web pages, 75
broken, 172–74
changing in Site Map, 76–77
changing using Site menu, 174–76
checking, 172–74
creating, 75, 110–11
creating for image maps, 124
creating within Web pages, 112–13
document-relative addresses, 176, 214–15
to e-mail addresses, 111
and frames, 230–31
glossary definition, 239
hiding/showing in Site Map, 77, 78
how URLs work, 210–11
opening links in different window, 113–14
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removing in Site Map, 76
site-root relative addresses, 176, 215
types of addresses, 176, 214–15

Hypertext Markup Language (HTML). See
HTML code

I
ICQ, 205
IIS. See Internet Information Server (IIS)
image buttons, creating, 132–36
image editors, 50–51, 202
image maps, 123–24, 239
images. See also photos

adding borders to, 121
adding to Web pages, 115
adjusting layout, 119–21
adjusting spacing, 120–21
aligning adjacent text, 119–20
avoiding large sizes, 51
digital, 52–60
importing, 50–51
printing, 52–53
representing with text, 121–22
resizing, 117–19
resolution issues, 52–53
scanning, 55–56
text-based descriptions, 124
transmission times, 201–2
transparent, 128
when to use thumbnails, 51

IMAP, 31
<img> tag, 210, 212
importing

HTML files, 48–49, 99–102
images, 50–51
plain text, 102–4
PowerPoint presentations, 48–49
spreadsheets, 48, 49, 104–5
tables, 104–5
Web content, 48–51, 99–105
Word documents, 101–2

index.htm, as home page name, 68, 75
information, disseminating. See also content, Web
site

charging for content, 5–7
reasons to share, 2, 7–9

information appliances, 177
.info top-level domain, 25
Insert Flash Button dialog box, 129
Insert menu, 91
Insert Table dialog box, 144–45
instant messaging, 205–6, 239
Integrated Services Digital Network (ISDN), 201
Internal Revenue Service Web site, 8
international domain names, 24
Internet

connecting from Site window, 72
defined, 199, 239
methods of communication, 202–6
telephone software packages, 206
ways to connect to, 199–202

Internet Explorer. See also Web browsers
opening from Dreamweaver, 176, 177

Internet Information Server (IIS), 239
Internet Merchant accounts, 223, 239
Internet service providers (ISPs), 28, 199, 239
intranets, 67, 239
IP addresses, 18, 239
IRS Web site, 8
ISDN. See Integrated Services Digital Network
(ISDN)

ISPs (Internet service providers), 28, 199, 239
<i> tag, 212
italic text, 106

J
Java, 208
Javascript, 208
.jpeg files, 50, 240
.jpg files, 48, 50
JumboStore.com, 221

hyperlinks continued
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K
KB (kilobytes), 200
Kbps (kilobits), 200
keywords, 211, 240
knowledge bases, creating, 10, 11
Kodak Picture CD, 56–58

L
<label> tag, 212
layers

absolutely positioned, 140
adjusting visibility, 142–43
converting tables to, 137–38
creating from scratch, 138–39
creating from tables, 137–38
drawing, 139
hiding, 142
how to position, 140, 141–42
moving, 142
overlapping, 140, 142
overview, 136–37
positioning, 140, 141–42
relatively positioned, 140
resizing, 141–42

Layers palette, 141
Layout view, 145
Library, 156–58
line breaks, 211
lines. See borders
Link Checker dialog box, 173–74
link exchanges, 192–93
Link External Style Sheet dialog box, 160
links. See hyperlinks
Link To New File dialog box, 75
Listbot, 196
lists, bulleted or numbered, 106
list servers, 32, 195
<li> tag, 212

local area networks, 240
local root folder, 43, 65. See also content folder
local sites

creating, 65–70
defined, 65
opening, 70–71
switching between, 70–71

Locate A Web Presence Provider Web site, 36–37
logos, 128
LookSmart, 190
Lycos, 190

M
Macintosh, 177
Macromedia Dreamweaver. See Dreamweaver
Macromedia Fireworks, 50
Macromedia Flash, 129, 207
Macromedia Shockwave, 207
mailing lists

creating, 194–96
as form of advertising, 194–96
glossary definition, 240
placing ads on newsletters, 191
Web host support for, 32

majordomos, 32, 195
manuals, 13
mapping. See Site Map
MB (megabytes), 200
menu bar, Site window, 71–72
menus, Dreamweaver, 91
metasearch engines, 187
meta tags, 188, 211, 212
Microsoft Excel. See spreadsheets, importing
content

Microsoft FrontPage 2000, 218, 219, 220
Microsoft FrontPage Server Extensions, 29, 35,
218, 238

Microsoft Knowledge Base, 11
Microsoft Locate A Web Presence Provider Web
site, 36–37

Microsoft NetMeeting, 206
Microsoft Outlook, 195
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Microsoft PhotoDraw, 50
Microsoft PowerPoint, exporting presentations to
Web pages, 48–49

Microsoft Product Support Services Web site, 11,
13

Microsoft Word files, importing into Dreamweaver,
101–2

modems, 199–200, 201, 241
Modify menu, 91
.mov files, 48
moving

files between folders, 80
floating palettes, 95

.mp3 files, 48

.mpg files, 48
MSN Messenger, 205–6
MSN Search, 190
multiprocessing, 241

N
named anchors, 112–13
naming files, 46–47, 98
navigation bars

creating, 132–36
defined, 241
inserting objects, 133–34
modifying, 136
rollover buttons for, 132–36

nested tables, 147
Net2Phone, 206
NetMeeting, 206
Netscape Navigator, 176, 177, 178, 179. See also
Web browsers

Netscape Search, 190
.net top-level domain, 22
Network Solutions, 26–27, 39
new folders, creating, 45–46
newsgroups, 194, 204–5, 241
New Style dialog box, 160
new Web pages, creating, 97, 155–56
NoFrames pages, 232

Northern Light, 190
notes. See Design Notes
NTFS file system, 44
numbered lists, 106

O
objects, adding to Library, 157
Objects palette, 144, 145, 226
OCR programs, 61
offline advertising, 196
older Web browsers

alternative home pages for, 164–68
layers vs. tables, 137
testing Web sites in, 162–64

<ol> tag, 212
online advertising, 190–93
online catalogs, 218, 219
online discussion groups. See discussion groups,
online; mailing lists

online photo services, 58–60
online shopping. See Web stores
Open Directory, 190
opening Web pages in Dreamweaver, 96–97
Opera (Web browser), 176, 177, 180
order forms, 218–20
ordering information, 218–20
.org top-level domain, 22, 23
Outlook Express, 195, 202–3

P
<p> tag, 209
.p65 files, 48
page banners, 241
pages. See Web pages
palettes. See floating palettes
passwords, 39
permissions, 242
phones, communicating via Internet, 206
PhotoDraw, 50
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photos. See also images
from digital cameras, 53–54
and online photo services, 58–60
and picture CDs, 56–58
scanning, 55–56
transmission times, 201–2

Photoshop, 50
PhotoWorks.com Web site, 59
picture CDs, 56–58
pictures. See images; photos
pixels, 52, 242
plain text, importing, 102–4
plug-ins, 242
.png files, 48, 50, 78, 242
POP servers, 31
pop-up menus, 242
PowerPoint, exporting presentations to Web pages,
48–49

.ppt files, 48
Preferences dialog box, 69, 180–81
presentations, PowerPoint, exporting to Web pages,
48–49

Preview in Browser list, 180–82
previewing

screen resolution, 169
Web pages, 99

print documents, 60–61
product manuals, 13
products and services. See also Web stores

advertising on Web sites, 2
digital content as, 5–7
offering support online, 10–13
showcasing online, 4

Property inspector, 149, 151, 158, 228, 229, 242
proxy servers, 68, 69, 242
<p> tag, 212
.pub files, 48
publicizing Web sites, 186–96
publishing Web sites to Web hosting services,
183–86

R
RAID (Redundant Array of Independent Disks),
34, 243

redoing actions, 108
Reference palette, 212
registrars, domain name, 21, 24, 26–28, 243
removing. See deleting
renaming Web pages, 81
resizing

Document window, 94
floating palettes, 96
images, 117–19
layers, 141–42
Site Map display, 79
table cells, 147

resolution-independent Web pages, 168–70. See
also screen resolution

rollover buttons, creating, 132–36
root, viewing in Site Map, 79
root folder, 43, 65. See also content folder
routers, 200
rows, table

adding, 149
drawing, 146–47
resizing, 147
specifying, 144, 150

rules, for naming files, 46–47

S
saving

frames, 229
Site Map views, 78, 79
Web pages in Dreamweaver, 98

scanning
images, 55–56
print documents, 61

screen resolution
and Document window size, 94
and dots per inch, 52–53
making Web pages resolution-independent, 168–70
previewing, 169
tips for effective Web pages, 169–70



256256256256256 New Webmaster’s Guide to Dreamweaver 4 - Electronic Edition

search engines
crawler-based, 187, 188
directory-style, 187, 188
glossary definition, 243
list of sites, 190
overview, 187
preparing home pages for, 130–32
submitting Web sites, 186–90
types of, 187

Secure Sockets Layer (SSL) security, 33, 243
security issues

firewalls, 68–70
NTFS file system, 44
and online orders, 218–20
passwords, 39

Select File dialog box, 183
Select HTML File dialog box, 76–77
Select Image Source dialog box, 115
Select Template dialog box, 97, 155
servers. See Web hosting services; Web servers
services. See products and services
Shockwave, 207
shopping carts, online, 220–23. See also Web stores
shortcut menus, 243
Site Definition dialog box, 66–68, 70, 87–88
Site Map

changing display, 79
changing existing links, 76–77
creating new links, 74–75
creating new pages linked to existing pages, 74–

75
hiding links, 77, 78
overview, 71–73
resizing display, 79
saving as graphic, 78, 79
uses for, 72–73
viewing root Web page, 79
viewing together with site files list, 79
viewing Web page titles, 80

Site menu, 91

site-root relative hyperlink addresses, 176, 215
Site window

copying files, 80
deleting files, 81–82
hiding left pane, 72
moving files, 80
overview, 71–73
publishing Web sites, 183–86
renaming files, 81
switching sites in, 70–71
switching views in, 73
uses for, 72

sizing. See resizing
sizing handles, 147, 243
Snap, 190
sorting files in Site window, 72
Space Imaging Web site, 5
spell checking Web pages, 107
splitting

frames, 230
table cells, 148, 151

spreadsheets, importing content, 48, 49, 104–5
SSL security, 33, 243
statistics, monitoring, 197–98
status bars

Document window, 93–95
glossary definition, 243
Site window, 72

stores. See Web stores
Store.Yahoo.com, 221
Style Definition dialog box, 160–61
styles. See also CSS Styles palette

creating, 160–61
linking Web pages to, 161
modifying, 160–61

subdomains, 19–20, 32, 244
support, product, 10–13
synchronizing files, 184–86
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T
T1 connections, 34
tables

adding color or image to background, 150
adding rows and columns, 149
adding to Web pages using Objects palette,

145–48
aligning, 149
cell padding and spacing, 149
converting to layers, 137–38
creating using Insert Table object, 144–45
creating using Layout view, 145–48
drawing, 145–47
glossary definition, 244
importing, 104–5
nested, 147
overview, 144
specifying border thickness, 145, 150
specifying properties, 149–51
specifying rows and columns, 144
specifying width and height, 145

<table> tag, 212
tags, HTML

glossary definition, 244
list of, 211–12
overview, 209–12

Tag selector, 93, 244
<td> tag, 212
technical support, 10–13, 33
telephones, communicating via Internet, 206
templates

creating, 152–55
creating Web pages from, 97, 155–56
editable regions, 154–55
glossary definition, 244
modifying, 156
overview, 152

testing Web sites
checking hyperlinks, 172–74
in different browsers, 176–80

in older browsers, 162–64
overview, 172
for usability, 182–83

text
aligning, 106–7
boldface, 106
entering, 106
formatting, 106–8
importing HTML files, 48–49
importing Word documents, 49
italic, 106
plain, importing, 102–4
tips for writing, 108–10

text files, importing, 99–105
Text menu, 91
thumbnail images, 51, 244
<title> tag, 211
toolbar, Document window, 92
top-level domains, 22–25, 244
traffic statistics, 197
transferring files, 40–41
transparent images, 128
<tr> tag, 212
.tv top-level domain, 24
.txt files, 47

U
<ul> tag, 212
underscore character, 244
undoing actions, 108
Update Files dialog box, 175
UPS (Uninterruptible Power Supply), 35, 245
UPS (United Parcel Service) Web site, 8
URLs (Uniform Resource Locators), 210–11, 245
U.S. Internal Revenue Service Web site, 8
usability testing, 182–83
USB interface, 54



258258258258258 New Webmaster’s Guide to Dreamweaver 4 - Electronic Edition

V
vector-based graphics, 245
View menu, 91
virtual domains, 29, 245

W
.wav files, 48
Web browsers

adding to Preview In Browser list, 180–82
compatibility of Web pages, 161–68
deleting from Preview In Browser list, 182
glossary definition, 245
older, 164–68
opening from Dreamweaver, 176
testing Web sites, 176–80

WebCrawler, 190
WebDAV, 29, 35
Web hosting services

Active Server Pages support, 30
assessing Web server reliability, 34–35
assessing Web server speed, 33–34
choosing, 28–37
comparing features, 29–35
database support, 30
data transfer limitations, 32
disk space allotment, 30
domain hosting support, 29
and domain names, 38–39
e-mail accounts, 30–31
glossary definition, 245
vs. ISPs, 28
local vs. national, 35
mailing list support, 32
and online stores, 218, 221–23
publishing Web sites to, 183–86
signing up for service, 37–42
and SSL security, 33
subdomain support, 32
support for FrontPage 2000 Server Extensions,

29, 35, 218
technical support, 33

virtual domain support, 29
WebDAV support, 29
where to find, 35–37

Web pages. See also content, Web site; home pages;
Web sites

adding Design Notes to, 83–84
adding hyperlinks to, 75, 110–11
adding images to, 115
adding text to, 99–110
adding to Web sites, 74–75
and browser compatibility, 161–68
changing colors and backgrounds, 107
checking in and out, 67, 76, 84–86
closing in Dreamweaver, 96, 97
copying, 80
creating image maps for, 123–24
creating in Dreamweaver using New command,

97
creating in Dreamweaver using New From Tem-

plate command, 97, 155–56
creating site plan for, 63–64
creating templates for, 152–55
deleting, 81–82
different versions for older browsers, 164–68
ensuring proper display, 161–70
glossary definition, 245
how they work, 206–7
moving, 80
opening in Dreamweaver, 73, 96–97
previewing from Dreamweaver, 99
renaming, 81
role of home pages, 125–28
saving as templates, 153–55
saving in Dreamweaver, 98
and screen resolution, 168–70
time to download, 94–95
tips for writing text, 108–10

Web rings, 192, 246
Web servers. See also Web hosting services

assessing reliability, 34–35
assessing speed, 33–34
glossary definition, 246
role in Web stores, 218–20
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specifying type in Dreamweaver, 67
Web sites. See also content, Web site; Web pages

adding Web pages, 74–75
advertising of, 190–93
copying Web pages, 80
creating plans for, 63–64
creating structure in Dreamweaver, 73–82
creating templates for pages, 152–55
deleting Web pages, 81–82
determining goals, 1–16
glossary definition, 246
monitoring, 197–98
moving Web pages, 80
obtaining traffic statistics, 197
organizing content, 62–64
publicizing, 186–96
publishing, 183–86
reasons for having, 1–15
renaming Web pages, 81
role of aesthetic appeal, 128
submitting to search engines, 186–90
testing, 172–83

Web stores
glossary definition, 246
non-interactive catalogs, 218
overview, 217
role of Web servers, 218–20
shopping cart setup options, 220–23
types of setups, 217
using order forms to collect orders, 218–20

WebTV, 177
Window menu, 91
Windows 2000 Server, 35, 44
Windows Explorer, 45–46
Windows NT, 44
wireless Internet access, 201
World Book Web site, 6
World Wide Web, 203–4. See also Web sites
.wpf files, 47
writing Web page text, 108–10

X
.xls files, 48. See also spreadsheets, importing
content

XML (Extended Markup Language), 208, 246

Y
Yahoo!, 189, 190

Z
Z-Index, 140, 143
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Do you need to get
your project started
quickly?
Written specifically for busy executives and project
managers, Effective Executives—Guide to Project
2000 walks you through the eight steps of organizing,
managing and finishing your project using Microsoft®
Project 2000:

Step 1: Learn the Language. Start here with a
refresher on the language of project
management and Project 2000.

Step 2: Describe the Project. Describe your
project in general terms, including start date,
end date, and calendar of workdays.

Step 3: Schedule Project Tasks. Break your project down into component
tasks, specifying task order and relationships.

Step 4: Identify and Assign Project Resources. Identify and then allocate
project resources, such as people and equipment.

Step 5: Review Project Organization. Review your project for structural
soundness and reasonableness.

Step 6: Present Project to Stakeholders. Present your plan to project team
members and management.

Step 7: Manage Project Progress. Monitor progress and costs, assuring your
project stays on course.

Step 8: Communicate Project Status. As the project progresses, keep project
team members and other stakeholders apprised of the project’s status and
communicate important project information and changes.

About the Authors:
With more than 3,000,000 books sold in English, Stephen L. Nelson is arguably the best-
selling author writing about using computers in business. Nelson’s project management
experience includes work in software development, commercial real estate development,
and book publishing.
Pat Coleman is a technical editor and author who writes about intranets, the Internet,
Windows, and Windows applications. The co-author of Mastering Intranets, Mastering
Internet Explorer 4, and Windows 2000 Professional: In Record Time (all published by
SYBEX), Coleman has worked as the editorial director of Microsoft Press, deputy editor at
World Almanac, and as a project analyst at Encyclopaedia Britannica.
Kaarin Dolliver is the managing editor of Redmond Technology Press and has been a
contributing editor to a series of bestselling books.

304 pages, paperback, $24.95 Available at bookstores everywhere and at all online bookstores
ISBN: 0-9672981-1-3



Are you an executive
user of the Internet
who needs to get
started quickly?

Written specifically for busy executives, managers, and
other professionals, Effective Executive’s Guide to the
Internet provides a fast-paced, executive summary of
the seven core skills you need to know to use the
Internet at work, on the road, or at home:

Skill 1: Understanding the Environment. This
skill gives you an overview of the Internet: what
it is, how it works, and how it came to be.

Skill 2: Making Internet Connections. This skill provides step-by-step
instructions for connecting your computer or network to the Internet.

Skill 3: Browsing the Web. This skill focuses on the Internet Explorer Web
browser included with all the latest versions of Windows. We explain how a Web
browser works and how to customize Internet Explorer.

Skill 4: Communicating with Electronic Mail. In this skill, we describe how to
use Outlook Express, the mail and news reader included with Windows.

Skill 5: Using Search Services. This skill describes in detail how search services
work and how you can best use them. A special topic at the end of this skill gives
you some ways to get started gathering business information.

Skill 6: Understanding Other Internet Services. In this skill, we look at FTP,
Telnet, mailing lists, and using your computer as a fax machine and telephone.

Skill 7: Publishing on the Web. Learn how Web pages work, how to develop a
Web strategy, how to set up your domain and your server, how to collect and
create digital content, and how to create your Web pages.

About the Authors:
Pat Coleman writes about intranets, the Internet, and Microsoft Windows 2000. Formerly
the editorial director of Microsoft Press, Coleman is also the co-author of the best-selling
Effective Executive’s Guide to Project 2000 and Effective Executive’s Guide to
Windows 2000, both published by Redmond Technology Press.
Stephen L. Nelson: With more than 3 million books sold in English, Nelson is arguably
the best-selling author writing about using computers in business. Formerly a senior
consultant with Arthur Andersen & Co., he is also the co-author of Effective Executive’s
Guide to Project 2000 and Effective Executive’s Guide to PowerPoint 2000.

288 pages, paperback, $24.95 Available at bookstores everywhere and at all online bookstores.
ISBN 0-9672981-7-2



Are you an executive
user of Windows 2000
Professional?

Written specifically for busy executives, managers, and
other professionals, Effective Executive’s Guide to
Windows 2000 provides a fast-paced, filtered executive
summary of the seven core skills you need to know to
use Microsoft Windows 2000 Professional at work, on the
road, or even at home:

Skill 1: Understanding the Desktop. This skill
explains logging on, using the Start menu, using
the Taskbar, working with the desktop icons, and
creating shortcuts.

Skill 2: Managing Files and Folders. This skill explains the Windows 2000
Professional file systems, including how to organize and protect your documents.

Skill 3: Printing. This skill shows you how to install and manage a local printer,
how to print documents, how to customize the printing process, and how to
install and use fonts.

Skill 4: Working on a Network. This skill gives you step-by-step instructions for
setting up a small network, installing a network printer, setting up users and
groups, and installing network applications.

Skill 5: Customizing Windows 2000 Professional. This skill suggests ways to
customize everything from the display to the hardware.

Skill 6: Using the Internet. This skill tells you how to connect to the Internet
and how to use Internet Explorer and Outlook Express.

Skill 7: Preventive Maintenance and Troubleshooting. This skill gives you
guidelines for protecting the health of your computer, maintaining the system,
and troubleshooting when a problem arises.

In addition, Effective Executive’s Guide to Windows 2000 also includes two appendixes
that review the Windows 2000 Professional Accessories (including Address Book,
NetMeeting, Notepad, WordPad, Fax Service, and Calculator) and explain how to use
Windows 2000 Professional on a portable computer.

About the Author:
Pat Coleman is a technical editor and author who writes about intranets, the Internet,
and Microsoft Windows 2000. Coleman is also the co-author of the best-selling Effective
Executive’s Guide to Project 2000 and Effective Executive’s Guide to the Internet,
both published by Redmond Technology Press.

304 pages, paperback, $24.95 Available at bookstores everywhere and at all online bookstores
ISBN: 0-9672981-8-0



Do you use the
Internet for business?

The MBA’s Guide to the Internet: The Essential Internet
Reference for Business Professionals is the only book that
specifically describes how you can more easily, more
productively, and more powerfully use the Internet as a
business tool:

The first part of the book provides QuickPrimersTM that
move you to professional proficiency in all Internet
skill categories, including how to connect to the
Internet and how to use popular tools like the Web,
e-mail, newsgroups, mailing lists, and even other more
esoteric Internet tools like FTP, chat, streaming video
and audio, and Telnet.

The second part of the book—and a distinguishing feature—provides deep, rich coverage
of those Internet services that are essential tools for business users: Internet search
engines, fee-based services (such as Lexis-Nexis and Dun & Bradstreet), directories of
business and government Internet resources, and wireless Web and e-mail services.

The last part of the book provides thorough, step-by-step plans for accomplishing common
Internet business projects, including setting up a Web site, setting up a Web store, publishing
an e-mail newsletter, using the Internet for publicity and promotion, publishing PowerPoint
presentations to the Web, using the Internet for recruiting and employment, setting up and
using an personal or small business online banking system, and setting up and managing
an online investment portfolio.

Because the main chapters of the book describe how to use the Windows versions of
Microsoft’s Internet Explorer and Outlook Express programs, appendixes explain how to
use Netscape Navigator and Messenger and the Macintosh versions of Internet Explorer and
Outlook Express.

Written for business people who want to use the Internet, the MBA’s Guide to the Internet
works for business users with graduate degrees and undergraduate degrees in business or
a related field—and for anyone else who’s serious about turning the Internet into a tool
for making better business decisions.

About the Authors:
With more than 3 million books sold in English, Stephen L. Nelson is arguably the best-selling
author writing about using computers in business. Nelson is also the author of the MBA’s Guide
to Microsoft Excel 2000 (Redmond Technology Press), the best-selling Excel book for business users.

Pat Coleman is a technical editor and author who writes about intranets, the Internet, Windows,
and Windows applications. Coleman is the co-author of the best-selling Effective Executive’s Guide
to Project 2000 and the author of the Effective Executive’s Guide to Windows 2000 (both from
Redmond Technology Press).

720  pages, paperback, $39.95 Available at bookstores everywhere and at all online bookstores
ISBN: 0-9672981-6-4
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